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Search the table of all articles in this guide, listed in alphabetical order, to find the article you need.
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•
•
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Get started

•

• Administrator

This guide describes how you can use the SpeechMiner user interface to perform search and
playback for voice and screen recordings, traditional quality management tasks such as evaluation
of interactions through form-based scoring, or advanced speech analytics such as topic analysis or
trending and exploration analysis of transcripts.

Related documentation:
•

Contents

• 1 Recording
• 2 Quality Management (QM)
• 3 Speech Analytics
• 4 Before you start
• 5 Access the application

• 5.1 Multilingual support
• 5.2 Before you log in to SpeechMiner UI consider the following:

• 6 Walk through the application
• 6.1 Dashboard
• 6.2 Explore
• 6.3 Reports
• 6.4 Quality Management
• 6.5 Tools
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SpeechMiner is the name of the user interface (UI) within Genesys Multicloud CX (PEC) that provides
a single UI for all Recording, Quality Management and Speech Analytics functionality.

Recording
Recording, also referred to as Genesys Interaction Recording (GIR), provides cradle to grave dual
channel voice recording for customer-ivr and customer-agent conversations as they occur within the
Genesys Multicloud CX Contact Center. GIR is able to automatically stitch together call segments and
capture all relevant call metadata to provide the information you need to fulfill important use cases
within your business including Compliance, Dispute Resolution and Workforce Training. In addition,
when enabled, GIR provides screen recording of the entire agent desktop for a subset or all voice
interactions handled by your agents.

Quality Management (QM)
Quality Management (QM) enables you to monitor quality and evaluate agent
performance on a periodic and consistent basis while minimizing effort through
automated interaction selection to improve customer experience and engage
with your staff. QM includes a robust and feature rich form designer along with a
number of evaluation schedule types to meet the SLAs required by your business
in providing core use cases around QM as well as input to Training through form
based scoring of interactions.

Important
The processing of digital interactions is available only in Azure.

Speech Analytics
Speech Analytics, also referred to as Genesys Interaction Analytics (GIA), provides automated speech
analytics capabilities on all recorded customer-agent interactions to provide deep insight into these
conversations. GIA provides automated transcription and employs Topic tagging along with non-
linguistic analysis of recordings to create meaning from otherwise unstructured data. Organizations
can use this data to fulfill key use cases around Agent Performance Improvement (for example,
decrease AHT, increase FCR, Sales Conversion, and so on.), Compliance and Customer Satisfaction
(for example, NPS). Additionally, GIA employs advanced unsupervised machine learning algorithms to
surface salient or unexpected terms to enable use cases around Uncovering Emerging Trends or
Discovery of New Phrases and Intents. All analysis and discovery functionality is provided through the
SpeechMiner UI.

Before you start

SpeechMiner UI provides a single user interface (UI) across different products within the Genesys
Workforce Optimization suite in Genesys Multicloud CX, including Recording, Quality Management
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and Speech Analytics. Each product is sold separately. Recording is a prerequisite. Quality
Management and Speech Analytics can be added based on the specific needs of your business.

Screen recording is available only for voice interactions. SpeechMiner supports export of voice
transcripts.

The Genesys Multicloud CX Recording, QM and Speech Analytics solution does not include:

• Screen recording of digital interactions
• Access to SMART for Topics/Category creation
• Export of digital transcripts or analytics data
• Distinct retention periods for Transcripts, Analytics and QM data; the retention period for all data is tied

to the retention period of the underlying call recording

Get started
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Access the application

Once your Genesys Multicloud CX environment is up and running and you've checked that you meet
the necessary requirements, log in to your Genesys Portal to access Recording. Click the Recording
icon and enter your username and password.

When you log in to the system, SpeechMiner UI automatically verifies the roles and groups assigned
to your account.

The roles assigned to your account signify what SpeechMiner UI features you are allowed to access.

Only the features you have permissions to view are displayed in the interface when you log in to the

Get started
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system.

Multilingual support

SpeechMiner web application supports multiple languages. When you log in to SpeechMiner, the web
UI is displayed in a language that you selected in the browser. If you select an unsupported language
in the browser, the SpeechMiner Web UI defaults to en-US.
For more information about the supported languages, refer to SpeechMiner language support.

Before you log in to SpeechMiner UI consider the following:
The SpeechMiner UI address will be given to you by your system administrator. Alternatively, when
your account was created you may have received an automated email notification with the same
information.

You can log in to SpeechMiner UI from any of the currently supported browsers. A list of supported
browsers can be found in the latest SpeechMiner UI PureConnect Release Notes.

Important
If you are having problems viewing SpeechMiner UI, refer to Configure the browser.

Walk through the application

The SpeechMiner UI contains the following menus.

Dashboard
Enables you to create one or more dashboards. Each dashboard can contain a selection of one or
more widgets. The widgets show the various reporting data related to Recording, Quality
Management or Speech Analytics. With Speech Analytics, this data provides insights into the content
and nature of agent-customer interactions.

Explore
Enables you to drill down and examine information about your contact center and agents by
searching for specific groups of interactions. The filters available are dependent on whether Speech
Analytics is enabled. With Recording and Quality Management, the following filters are available:

• Date Range
• Agents & Workgroups
• Metadata
• Duration
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With Speech Analytics, the following additional filters are available:

• Terms & Topics

From the Media Player and Interaction Transcript (with Speech Analytics), you can drill further down
to investigate the potential root causes of the business trends that appear in the resulting interaction
list.

Reports
Enables you to analyze statistical data about agent-customer interactions according to a specific
report (for example, Agent Comparison, Team Comparison, and so on). By analyzing a reports, details
and status, you can gain intelligence about your organization.

Quality Management
Enables you to monitor agent-customer interactions, to improve agent productivity and customer
satisfaction. The key features such as Forms Manager and Evaluations Manager can be used for
evaluating agent productivity and targeted agent training. Quality Management offers insight that
has the potential to increase employee productivity, resolve future customer disputes and
subsequently enhance customer service.

Tools
Provides access to an administrative level SpeechMiner UI functions. You can use Tools to view
detailed information about Topics and Phrases in the system.

Get started
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New in this release

Contents

• 1 8.5.512
• 2 8.5.510
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Review this page to discover the new features that were released for the latest SpeechMiner UI.

Related documentation:
•
•

8.5.512

Support for Digital Interactions:

• SMS Support: SpeechMiner now supports processing of SMS interactions. You can now filter, evaluate,
and create a report for SMS interactions.

• Email Support: SpeechMiner now supports processing of email interactions. You can now filter,
evaluate, and create a report for email interactions.

• Private Facebook and Twitter Support: SpeechMiner now supports processing of private Facebook
and Twitter interactions. You can now filter, evaluate, and create a report for these interactions.

• HTML Support for Digital Interactions: SpeechMiner now supports HTML formatted content for
digital media interactions:
• Transcript text recognized as a topic now displays in bold only if it’s not formatted in HTML. If the

transcript text for the topic is formatted in HTML, then the text displays in HTML format.
• If the content of table formatted data for digital interactions has text recognized as a topic, the topic

pointers display below the table.
• Enabling digit filtering now replaces all numbers in the text with an asterisk (*). This may have an

impact on the HTML format of the transcript.

• Chat Support: SpeechMiner now supports processing of chat interactions. You can now filter, evaluate,
and create a report for the chat interactions.

Browser Support:

• Edge Chromium Support: SpeechMiner now supports the Microsoft Edge Chromium browser.

8.5.510

Interaction Search, Export and Add Improvements:

New in this release
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• Sort by Agent: Within the Interactions grid it is now possible to sort by the Agent column. Interactions
with multiple agents will appear after (descending order) or before (ascending order) the alphabetized
list of interactions with one agent. Subsequently, Interactions with multiple agents are sorted by the
number of agents and then relevance.

• Search by List of Interaction IDs: It is now possible to search for a specific set of Interactions based
on a semicolon delimited list of Interaction IDs. A list of up to 50 Interaction IDs is supported. This can
be useful when working with a specific set of interactions.

• Export All Interaction Meta Data: You can now easily export all the metadata associated with
Interactions from an interaction search, up to the maximum number of listed interactions, without
having to scroll through all interactions in the search results.

• Add All Interactions to a List: You can now easily add all Interactions from an interaction search to
an Interaction List without having to scroll through all interactions in the search results.

Quality Management Improvements:

• In-Line Rubric / Standards Definition: Forms and Questions within Forms now have an expanded
Description field that can be used to store the standard definition or rubric used by your Quality
Managers to ensure consistency when performing evaluations of Agents.

• Form and Evaluation Manager Improvement: The Forms Manager grid and the Evaluations
Manager grid now includes a Description column; if a description is long, the full content is shown in a
tooltip. In addition, when you hover over a Form or Evaluation name, a tooltip with the description of
the specific Form/Evaluation is shown.

Trending Rank for Top Terms: The Top Terms table in the Trending report results now includes a
Rank column for each period. The Rank column displays the relative importance and prominence of
the specific term/phrase in the selected Period.

Reporting Improvements:

• Agent Comparison by Segment report: It is now possible to report on agents performance based on
the Segments within an Interaction instead of just at the Interaction level only. Interactions can have
multiple Segments, each involving a different Agent. Reporting by Segment provides more precise
Agent Comparison information for multi-segment interactions.

• Agent Trend by Segment report: It is now possible to report on agent performance trends based on
the Segments within an Interaction instead of just at the Interaction level only. Reporting by Segment
provides more precise Agent Trend information for multi-segment interactions.

• Team Comparison by Segment report: It is now possible to report on teams performance based on
the Segments within an Interaction instead of just at the Interaction level only. Interactions can have
multiple Segments, each involving a different Agent from different Teams. Reporting by Segment
provides more precise Team Comparison information for multi-segment interactions as only Segments
where that Team was involved are included in the comparison report.

SpeechMiner UI - Windows 10 64-bit Support: SpeechMiner UI is now supported for all existing
supported browsers (for example, Chrome and Internet Explorer) on systems running Windows 10
64-bit.

New in this release
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What is an interaction

Contents

• 1 Interaction information
• 1.1 Meta Data
• 1.2 Event
• 1.3 Segment
• 1.4 Comment
• 1.5 Transcript

• 2 Interactions with Screen Recordings
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An interaction is communication between an agent and a customer.

Related documentation:
•
•

SpeechMiner can analyze the following interaction types:

• Audio: An agent-customer interaction from an audio-based communication channel (phone call).
• Text: An agent-customer interaction from a text-based communication channel (chats, emails,

Facebook, SMS, or Twitter) .

Interaction information

An interaction can include the following information:

• Meta Data
• Event
• Segment
• Comment
• Transcription

Important
Speech Analytics can analyze acoustic aspects of a call such as periods of silence,
time when the agent and customer are talking at the same time (talk-over time), who
is talking (agent/customer) and so on.

Meta Data
Meta data refers to the data that is attached and associated with an interaction while the call is
routed through the contact center. This information is available in the SpeechMiner UI and can be
used in categorizing interactions. Meta data is stored at the interaction level, not the segment level.

What is an interaction
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Event
An event occurs when Speech Analytics identifies a topic in an interaction. A topic is a collection of
phrases that Speech Analytics recognizes in the audio when analyzing interactions.

For example, if the "can offer you a loan" phrase associated with the Loan Offer topic is identified, the
start of the event is "can" and the end of the event is "loan".

Speech Analytics can also identify non-linguistic events. Non-linguistic events are sounds other than
speech (for example, a dial tone, silence, music or noise, key press and so on).

An event is indicated by a numbered icon in the Media Player and within the interaction's transcript.
You can view details about each event by placing your mouse over the event icon. In addition, each
event has a start time, end time, a name and a type. For additional information, see Interaction
Events.

Segment
A segment is created when a customer is transferred during an agent-customer audio interaction. If
an interaction includes 4 segments, the customer was transferred 4 times.

For more information about segments, see: Working with the Search Results Grid.

Comment
Comments are added to interactions to express a thought about the interaction. A comment can be
general or associated with a specific time during the interaction.

User comments are indicated by icons above the audio graph in the Media Player and within the
interaction transcript.

There are three types of comments:

• Good : Indicates a positive comment.

• Bad : Indicates a negative comment.

• Neutral : Indicates an unbiased comment.

For more information about how to add a comment to an interaction, see: Interaction Comments.

Transcript
An interaction transcript is a textual representation of the agent-customer interaction or IVR-
customer interaction.

For more information about how to work with an interaction transcript, see: Interaction Transcript.

What is an interaction
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Interactions with Screen Recordings

A Screen Recording is a video of the agent's screen during the agent-customer interaction.

Not all interactions include a Screen Recording. Availability of screen recordings is based on the
percentage of voice interactions where screen recording is enabled.

When you play back an interaction with a screen recording, the voice and screen are synchronized.

What is an interaction
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Topics, Categories, and Programs

•
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Topics, Categories, and Programs are SMART features that are used when creating a set of
instructions designed to help gather and deliver valuable intelligence that business users readily
understand and use.

Related documentation:
•
•

SMART, the SpeechMiner UI Administration Tool, is a component of SpeechMiner UI, Genesys's award-
winning product for Customer Intelligence and it is used to help reveal the information about cause/
effect relationships that affect performance and business outcomes.

SMART defines the set of instructions that is used by SpeechMiner UI to perform recognition and
analysis of customer data.

The set of instructions managed by SMART are made up of:

• Topics: Boosts the recognition of a specific business issue by telling SpeechMiner UI what phrases to
look for.

• Categories: Group interactions with similar characteristics so that SpeechMiner UI users can find calls
associated with a specific business issue.

• Programs: A set of instructions that tell SpeechMiner UI what to recognize in recorded conversations
between contact center agents and customers, in relation to a specific business issue.

Before creating a topic or category, gather information about the business issue you want to
investigate and track interactions that are generated by the specific issue:

1. What is your business goal?
2. Determine the type of interactions generated by the business issue by listening to existing interactions

about the subject or similar subjects, reading e-mails that relate to them, and consulting agents who
interact with customers. For example, for a customer service topic, the set of relevant interactions may
only include incoming interactions about help and assistance.

3. Gather examples of employee scripts and typical phrases used in these interactions.

Topics, Categories, and Programs
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For optimal performance, Genesys researches the customer's business and subsequently defines the
initial SMART instructions.

Typically, SpeechMiner UI implementations at customer sites include development and underlying
SMART system by our Client Solutions team, but Advanced SpeechMiner UI users with SpeechMiner UI
Administrator privileges can modify the SMART system themselves to further fine-tune interaction
recognition and analysis for their company. The customer may want to make slight modifications to
topics based on the accuracy of the results they are achieving, or the customer may want to define
new programs for new interaction campaigns or procedures based on existing ones.

Advanced SpeechMiner UI users at the customers site can perform the following SMART tasks:

• Open and modify existing categories and topics.
• Create new categories and/or topics.
• Test changes to categories and/or topics.
• Apply SMART changes to SpeechMiner UI.
• Reprocess selected interactions through the SpeechMiner UI interface.
• Rollback to an earlier set of SMART instructions.
• Import SMART instructions.
• Export SMART instructions.

For additional information about SMART, refer to the SMART User Manual.

Important
SMART is not available in our Cloud offering. If you want to configure SMART, contact
Customer Care.

Topics, Categories, and Programs
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Topics

•

• Administrator

A topic enables you to boost the recognition of a specific business issue by telling SpeechMiner UI
what phrases to look for. For example, if you want to identify interactions in which the customer
wishes to cancel an account, you could create a topic named Cancellation with the following
phrases: "Close out my account" and "I need to cancel".

Related documentation:
•
•

Topics can also be used to improve the overall speech recognition of the system in two main ways:

• Directly: For example, the word “cinnamon” may appear frequently in calls when “cinema” was
actually said. You could enter a number of phrases in the topic related to “cinema” in order to improve
the transcription results. This assumes that you do not need to report on calls related to “cinema”. That
is, because the topic is a collection of mostly unrelated phrases, it is not very useful for reporting. In
order to run reports on “cinema”, it is recommended to place the phrases in a topic that has a common
business meaning.

• Indirectly: Consider the scenario in which “account number” is a phrase that is important to capture,
but its accuracy is low due to a number of false positives being generated because “phone number” is
recognized as “account number”. Adding the phrase “phone number” to the topic could potentially
draw those false positives away from “account number”. Placing “phone number” in a topic implies
that it is not important to run reports on “phone number”. For the incorrectly-recognized and undesired
“cinnamon” appearing in transcripts, it is recommended to try to remove it (and therefore correctly
recognize “cinema”) by adding “cinnamon” into the topic with strictness set at 100. Various phrases
with additional context (for example, “late night cinnamon”) may work better than using the single-
word phrase “cinnamon”.

More specifically, topics are a collection of phrases defined globally for the SpeechMiner UI system,
and included in one or more programs as required. When a topic is included in a program,
SpeechMiner UI searches for all of the phrases included in the topic's definition, in all the interactions
associated with the program. When one of the phrases is found, SpeechMiner UI identifies it as a
linguistic event and registers the topic as found at a specific time during the interaction.

Each linguistic event identified by SpeechMiner UI in an interaction has a start time, an end time, a
name, and a type. For example, if a topic called "Loan Offer" is identified by the phrase "can offer you
a loan," the start time is when the agent began saying "can," the end time is when the agent finished

Topics
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saying "loan," the name is "Loan Offer," and the type of event is "Topic."

Although a topic can contain one phrase, the more phrases you add the more useful the topic.

Once a topic is created, you can always make modifications based on the accuracy of the results that
the topic is achieving.

Topics
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Categories

•

• Administrator

SpeechMiner UI extracts interaction content to categorize interactions, so you can better understand
why customers are calling. That is, categorization provides quantitative information (such as an
increase in customer complaints or repeat interactions), as well as qualitative information (such as
customers stating that they want to switch vendors because of better prices) and subsequently, the
intelligence you need to build more effective business strategies.

Related documentation:
•
•

Each category is created with a specific business issue in mind. For example, a category can be
created to look for interactions in which the customer displayed signs of agitation and the contact
center supervisor was called in to deal with the customer. The combination of customer agitation and
supervisor involvement may be used to characterize a category about service complaints.

A category is defined globally for the entire SpeechMiner UI implementation, and interactions are
automatically assigned to it during processing. When changes are made to a category's definition,
the entire database of interactions is re-categorized to ensure that the category assignment of each
interaction matches the new definitions.

Categories also enable SpeechMiner UI to:

• Find interactions with particular characteristics so that you can analyze and compare them. For
example, you may wish to compare how different agents handled customer agitation during a
particular sales campaign.

• Perform statistical analysis on interactions. For example, SpeechMiner UI can check the percentage of
interactions in September in which customers exhibited agitation.

Once a category is created, all interactions in the database are scanned, and any interaction that
meets the category definition is automatically assigned to it. An interaction can be assigned to one,
several, or no categories.

With information derived from categorization, you can enhance self-service operations, leverage new
revenue opportunities, increase process efficiency, enhance customer loyalty, and improve first
contact resolution. Categories help identify how employees and customers express themselves in
specific interactions.

Categories
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Four types of categories exist in SpeechMiner UI:

• Regular Categories: Categories that have conditions defined in the form of a logical expression. When
SpeechMiner UI processes an interaction, the interaction is automatically assigned to this type of
category if it matches the requirements that are defined in the condition. These categories can be
independent (on the top level of the category hierarchy) or they can be sub-categories of other, parent
categories.

• Parent Categories: Categories that contain other categories. These categories have a name and
description, but do not include a logical expression. Interactions are assigned to them when they are
assigned to any of their sub-categories. Any category can be converted into a parent category by
adding sub-categories to it. When a regular category is converted into a parent category, the logical
expression that defined the category is deleted.

• Subcategories: A category can contain one or more subcategories in a multi-tiered category structure.
The parent-category is defined as a container of its subcategory. When SpeechMiner UI identifies an
interaction as belonging to a subcategory, it automatically identifies it as belonging to the parent-
category as well. For example, a 5-60 seconds Interaction Duration category contains three
subcategories 10 seconds category, 20 seconds category, and 50 seconds category. Any interaction
associated with the 10 Minute category is also associated with the Hour Interaction Duration category.
In this case, you receive data about all the interactions that were between 5 to 60 seconds and specific
data about interactions that were specifically 10, 20 and 50 seconds long.

• Manual Categories: Categories that include a collection of interactions that do not fit into a
predefined category. This type of category is referred to as a Manual category. A Manual category has
no criteria. Instead, it is a category to which you can manually add any (and as many) interactions as
you like without preconditions. For example, a Manual category could be used as placeholder for
interactions the SpeechMiner UI user would like to review during routine weekly staff meetings.

Categories
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Contents
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A program is a set of instructions that tell SpeechMiner UI what to recognize in recorded
conversations between contact center agents and customers, in relation to a specific business issue.

Related documentation:
•
•

More specifically, a program's instructions are made up of topic and non-linguistic recognition tasks
that contain guidelines about what SpeechMiner UI should look for, when to look for it, and where to
look for it in the interaction.

Topics must be defined before you can add them to a program. However, you can change their
contents after you add them to a program. The topic contents that are defined when the program is
applied are the contents that will be sought by SpeechMiner UI in interactions associated with the
program. For information about creating and modifying topics, see Topics

When SpeechMiner UI identifies a recognition task, it registers an event. For more information about
events, refer to the SpeechMiner UI User Manual.

Important
Every interaction that enters the system is automatically assigned to a program.

A program consists of the following:

• Content Processing Methods
• Non-Linguistic Identification
• Structured Diagram
• Priority Level

Content Processing Methods

Each program instructs SpeechMiner UI to extract useful information from a recorded conversation
using the following content processing methods:

• Speech Recognition: Identifies each word in its lexicon and transcribes it. Transcription enables users
to search for phrases and facilitates certain types of reports that analyze the speech that is recognized

Programs
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for trends. In addition, a transcription enables you to see a variety of characteristics associated with
the interaction and highlights phrases that can identify specific issues. For example, who said what,
unsatisfied customers, and so on.

• Topic Recognition: Identifies specific phrases associated with a defined topic. A topic represents a
specific intent (for example, cancellation) and each program is associated with one or more topics. That
is, topic recognition enables users to search for interactions containing a particular business issue, and
facilitates reports that analyze the topic data. If Speech Recognition is not performed, topic recognition
cannot be performed. That is, the topics included in the program define the linguistic data that
SpeechMiner UI should look for in interactions that belong to the program.

Non-Linguistic Identification

Non-Linguistic Identification identifies the non-verbal parts of an interaction. For example, silence,
busy signal, key presses, and caller agitation (tone).

Every program instructs SpeechMiner UI to automatically identify the following non-linguistic events:

• Music: Indicates when music is being played during the interaction. Music generally indicates that the
interaction was on hold.

• Cross Talk: Indicates when two or more people are talking at the same time.

• Silence: Indicates when there is nothing being said or played. SpeechMiner UI will automatically skip
over these silences when the interaction is played back.

• DTMF: Key press on a touch-tone phone. 12 different keys can be identified using DTMF (Dual Tone
Multi Frequency).

• Busy Tone: A busy signal.

• Dial Tone: A dial tone.

• Ringback: A signal used in PSTN (Public Switched Telephone Networks - standard "land lines") to
indicate that the line is being called or an incoming interaction is present.

• After call work: Indicates the section of the recording that takes place after the interaction has ended.

Important
Identification standards for Dial Tone, Ringback, Busy Tone and DTMF are based on
USA standards. To learn how to use different identification standards, refer to the
Configuring SpeechMiner UI > Additional Configurations > Tone Frequency
Configuration tab in the Genesys Interaction Analytics, Genesys Interaction Recording
UI and Quality Management Administration Guide.

In addition, when you configure a program, you can choose whether

Programs
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SpeechMiner UI should also identify agitation (that is, non-verbal expressions of
frustration and anger, such as deep sighs, grunts, or rapid changes in pitch).
Each non-linguistic event that is identified by SpeechMiner UI has a start time, an end time, and a
type. For example, if SpeechMiner UI identifies silence in an interaction, this is a non-linguistic event
whose start time is the beginning of the silent period, whose end time is the end of the silent period,
and whose type is "Silence."

Structured Diagram

Each program is organized as a structured diagram that links topics in a consecutive string to mimic
the expected flow of the conversations associated with the specific topic. The diagram is used to tell
SpeechMiner UI where in an interaction the content must be found in order to match the
requirements. For example, a structured diagram could show a "Loan Offer" topic at the beginning of
an interaction, followed by a "Disclaimer" topic, and, finally, a "Contact Information" topic.

You can fine-tune the structure to increase the efficiency and accuracy of the recognition process
using the following features:

• Modify the Program Structure: Specify the order in which the topics must appear in the interaction,
and indicate where branches may occur and which topics are optional, by adding and removing arrows
in the structure diagram.

• Create a Program Trigger: Set conditions for the links defined in the program's structure, including
conditions that the topic must meet and metadata conditions that the interaction must meet (for
example, the agent must be from a particular work group, or the interaction must have taken place
after a certain date).

• Create a Program Recognition Task: Specify that the topic must have taken place at a specific time
during the interaction.

Priority Level

Interactions are sent to SpeechMiner UI from the external recording system. When they are received,
they are put into SpeechMiner UI's processing queue to await their turn for analysis by SpeechMiner
UI. Because the processing of some interactions may be more important than the processing of
others, SpeechMiner UI does not automatically process interactions in the order in which they were
placed into the queue.

When you create a program, you assign it a priority level. SpeechMiner UI selects which interaction to
process first based on the priority level of the program it is associated to. SpeechMiner UI processes
the highest priority interactions in the queue first, and then proceeds to interactions with lower
priorities, regardless of how long the interactions have been in the queue.

Programs
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Dashboard

Contents

• 1 Dashboard menu reference
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•

• Administrator

Use the SpeechMiner UI Dashboard to generate a summary view of interaction details relevant to a
particular interaction set. A dashboard with one or more widgets allows you to quickly and easily
understand the business issue you are investigating.

Related documentation:
•
•

The SpeechMiner UI Dashboard displays dashboards that show summary information about a specific
set of interactions through the use of dashboards and widgets.

You can customize each dashboard to display interaction details relevant to a particular interaction
set. The Dashboard can have one or more widgets and each widget can contain information about a
different set of interactions.

By providing a summary view of the information, the Dashboard allows you to quickly and easily
understand the nature of all interactions within a specific interaction list. That is, Dashboard provides
you with the tools that enable you obtain an overall and complete impression of the business issue
you are investigating. For example, you can create a dashboard with a Report widget (to give you a
snapshot of metrics and key performance indicators).

A dashboard can contain the following widget:

• Report - Displays any existing report.

A dashboard can include one or more of the following views:

• Preset View - A view created by a manager or system administrator and published to your account. A
Preset view is only available in an Analytics Only environment.

• Personal View - A view created in your Dashboard that only you can view. By default, every view is a
Personal View.

Important
You can only create a Personal view if you have the permissions to do so.

Dashboard
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Dashboard menu reference

The Dashboard provides the following menu items:

• New Dashboard
Enables you to create a new dashboard for specific reports.

Once you create a new dashboard, the new dashboard will be added to the list of dashboards in
the Dashboard menu.

• Displays an existing customized Dashboard. This dashboard can only be edited by a user with the
relevant permissions to do so.

Dashboard
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Create a new dashboard

Contents

• 1 Create a new personal dashboard

Create a new dashboard
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•

• Administrator

Use the New Dashboard option to create a dashboard that displays summary information about a
specific set of interactions. With this information you can quickly and easily obtain an overall and
complete impression of the business issue you are investigating.

Related documentation:
•
•

Create a new personal dashboard

You can add as many new dashboards as you like and each dashboard can contain a different set of
widgets.

For example, if you manage two work groups, you can create two dashboards (one for each group), to
help keep track of each group separately.

1. Select Dashboard > New Dashboard. The Dashboard is opened with all of its existing dashboards.

2. Click the Add New Dashboard icon . A new empty dashboard opens. The new dashboard appears as
a Dashboard tab and the default name is New Dashboard.

3. Click Add Widgets. The list of available widgets appears at the top of the dashboard.
4. Click the link(s) associated with the widget you want to add to the dashboard. The widget automatically

appears in the dashboard.
5. Click Hide Widgets to remove the widget links at the top of the dashboard.
6. Click Change Settings.
7. In the Title field enter the name of the new dashboard and click Save.
8. Under Change Columns select the layout for the dashboard widgets. The widgets in the dashboard are

arranged to fit the column layout you select. The width of each widget is determined by the width of
the column in which it appears. You can change the width of a column by manually dragging the border
line that appears between the widgets. You can also change the column layout by simply dragging the
widget to a different location in the dashboard.

9. Click Hide Settings to remove the Change Settings options from the dashboard. The new dashboard is
created and you can edit it at any time.

Create a new dashboard
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Working with dashboards

Contents

• 1 Rename a dashboard
• 2 Change the column layout
• 3 Change the order of the tabs
• 4 Delete a dashboard
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•

• Administrator

Use Dashboards to organize summary information about interactions. A Dashboard provides you
with the tools that enable you obtain an overall and complete impression of the business issue you
are investigating. For example, you can create a dashboard with a Report widget (to give you a
snapshot of metrics and key performance indicators).

Related documentation:
•
•

The following procedures enable you to modify an existing dashboard:

• Rename a dashboard
• Change the column layout
• Change the order of the dashboard tabs
• Delete a dashboard

Rename a dashboard

1. Select Dashboard and the name of the dashboard you want to change.
2. Click Change Settings.
3. In the Title field change the name of the dashboard.
4. Click Save.
5. Click Hide Settings.

Change the column layout

1. Select Dashboard and the name of the dashboard you want to change.
2. Click Change Settings.
3. Under Change Columns click the desired layout. The layout is applied to the dashboard.

Working with dashboards
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Change the order of the tabs

1. Select Dashboard and any dashboard to open the dashboard tabs.
2. Place your mouse over the top corner of the tab you want to move. The mouse pointer changes to a

plus.
3. Drag the tab to its new location and release the mouse button. The tab is moved to its new location.

Delete a dashboard

1. Select Dashboard and any dashboard name to open the dashboard tabs.
2. Select the dashboard you want to delete.
3. Click Change Settings.
4. Click Delete dashboard. A confirmation message appears.
5. Click Yes. The dashboard is deleted.

Working with dashboards

Genesys Recording, Quality Management, and Speech Analytics User's Guide 35



Managing widgets

Contents

• 1 Add a widget
• 2 Edit a widget
• 3 Move a widget
• 4 Minimize/maximize a widget
• 5 Manually refresh a widget's data
• 6 Delete a widget
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•

• Administrator

Use Widgets to display summary information about a specific set of interactions. With Widgets you
can better understand the nature of all interactions within a specific interaction list.

Related documentation:
•
•

Widgets are small applications you can include in a view in the Dashboard page.

Each widget is displayed in the page as a small rectangle.

Depending on your user permissions, you may be able to add, move, modify, minimize, and remove
widgets.

A Dashboard can contain the following widget:

• Report widget

Add a widget

1. Select Dashboard.
2. Select the dashboard to which you want to add a widget.
3. Click Add Widgets. The available widgets are displayed at the top of the screen (Report widget).
4. Click the link associated with the widget you want to add to the dashboard. The widget is added to the

dashboard.

Edit a widget

1. Select Dashboard.
2. Select the Dashboard whose widget's you want to change.
3. To change the widget name click the name to make it an editable field. Type the new name and click

OK.
4. Click Edit and perform any of the following:

• Change the widget height: Enter the new height in the field provided.

Managing widgets
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• Change the widget refresh rate: Enter the new refresh rate in the field provided.
• Change the report description: Enter the new description in the field provided.

Tip
You can format the widget description using HTML tags.

5. Click Save to save your changes.
6. Click Close to close the fields.

Move a widget

1. Select Dashboard.
2. Select the Dashboard whose widget you want to move.
3. Place your mouse on the widget title bar and click and drag the widget to its new location.

Minimize/maximize a widget

1. Select Dashboard.
2. Select the Dashboard whose widget you want to minimize / maximize.

3. Click the minus sign to minimize the widget.

4. Click the plus sign to maximize the widget.

Manually refresh a widget's data

1. Select Dashboard.
2. Select the Dashboard whose widget you want to refresh.

3. Click the Refresh icon to update the data in the widget.

Delete a widget

1. Select Dashboard.

Managing widgets

Genesys Recording, Quality Management, and Speech Analytics User's Guide 38



2. Select the Dashboard whose widget you want to delete.

3. Click the Delete icon to remove the widget from the Dashboard.

Managing widgets
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Report widget

Contents

• 1 Run a report in the Report widget
• 2 Drill down a Report widget
• 3 Configure a Report widget
• 4 Edit a Report widget

Report widget
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•

• Administrator

Use the Report widget to display the data for any report saved in your system. The Report widget
can be configured to display information about a variety of topics. Adding more than one Report
widget to a single dashboard enables you to display different types information.

Related documentation:
•
•

Use the Report widget to display any report saved in your system. You can configure it to display
information about a variety of topics.

You can use this configurability to broaden the scope of information in a single dashboard by
including more than one Report widget, where each Report widget displays different data.

From the Report widget you can:

• Run a report
• Drill down
• Configure a Report widget
• Edit a Report widget

Run a report in the Report widget

1. Select Dashboard.
2. Select the dashboard in which you want to run the report.
3. Click Edit.
4. From the Select list, chose the report you want to view.
5. Click Save. The report appears in the Report widget.
6. If the report is too large for the widget change the report version:

1. Click the report link in the bottom left corner of the widget. The report is opened in the Reports >
Edit Report tab.

2. From the Version list select Mini.
3. Click Run report.
4. Click Save.

Report widget
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5. Select Dashboard and the name of the dashboard that contains the report you are changing. The
report is re-sized to match the size of the Report widget.

Drill down a Report widget

1. Click within the Report widget on the information for which you want to receive additional data.

The data may be in the form of additional reports or an interaction list (opened in a separate
window). If a different report was accessed, click the Back icon to return to the original report
results.

Configure a Report widget

When configuring a Report widget you can change its height, how often it is updated and what
report(s) it includes.

1. In the upper right corner of the Report widget click Edit. The widget's configurable settings are
displayed.

2. Change the following settings as required:
• Height: The widget height in pixels.
• Refresh Rate: The rate (in minutes) at which the data in the report is refreshed.
• Report Description: An explanation about the report.
• Select: Select the report to display in the widget.

3. Click Save. The widget settings are saved and a link to the specific report is added to the bottom left
corner of the widget.

4. Click Close in the top right corner of the widget to hide the setting options.

Edit a Report widget

1. Select Dashboard.
2. Select the dashboard that includes the report whose settings you want to change.
3. In the upper right corner of the Report widget, click Edit. The widget's configurable settings are

displayed.
4. Do one of the following:

• Click the Edit Report icon . The report is opened in the Reports > Edit Report tab in a new and
separate

• Click the name of the report in the bottom left corner of the specific widget. The Reports > Edit

Report widget
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Report tab is opened for the specific report in the same window.

5. Modify the report settings as necessary.

Important
You can format the widget description using HTML tags.

6. Click Save Report Settings or Save report settings as.

Important
If the saved report was not in your account, you are prompted to create a copy of the report by giving it
a new name. The new report is saved in your account.

7. If you selected to edit the report in a new and separate window, click X to close the window.

Report widget
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Explore

Contents

• 1 Explore menu reference
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•

• Administrator

Use the Explore options to filter massive quantities of interaction data to find interactions that are
most related to the business issue you are investigating. The search query that you create can be of
varying complexity, ranging from a specific agent to sophisticated criteria that define not only the
agent to search for, but also their retrieval conditions (for example, date range, interaction type,
metadata, and so on).

Related documentation:
•
•

You can use several search options to filter massive quantities of interaction data to find interactions
that are most related to the business issue you are investigating.

With Speech Analytics you can search for interactions using terms and phrases that you believe were
used in the interaction between the agent and the customer.

The search query that you create can be of varying complexity, ranging from a specific agent to
sophisticated criteria that define not only the agent to search for, but also their retrieval conditions
(for example, date range, metadata, tags and so on).

Once SpeechMiner UI generates an interaction list based on your search criteria, you can analyze the
list using various SpeechMiner UI tools and options. The variety of options enables you to obtain in-
depth information about your specific business issue.

Explore enables you to filter and search for interaction data by:

• Searching: Enables you to create a set of search criteria. You can save search criteria so that it can be
run in the future. For example, you could search for interactions handled by Work group A, processed
with either Group B or Group C and are assigned to Agent X.

• Interaction lists: Enables you to create a collection of one or more interactions about a specific issue.
• Content Browser: Enables you to create search criteria based on a tree structure with specific

interaction characteristics. This method provides a visual overview of the interaction database. With
Content Browser you can browse through the database by expanding nodes to see more detailed
interactions, limiting the display of specific interaction types and by viewing interaction details. For
example, you can browse through the interaction database by dividing it into groups based on the work
group you believe handled the interactions.

• Trending: Enables you to understand possible correlations between terms to create a meaningful search.
That is, the Trending view enables you to quickly see how terms are related to each other and the
contexts in which they appear. Trending is only available with Speech Analytics.

Explore
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Explore menu reference

The following list provides a brief description of each Explore menu item:

• Search
Enables you to search for interactions about a specific business issue by providing the tools to filter
through a massive interaction database.

• Saved searches
Enables you to run the same search numerous times on different dates and times.

• Interaction lists
Enables you to manually create an interaction list by selecting an interaction(s) from the
Interactions Grid.

• Content Browser
Enables you to find interactions based on a Category, Agent or Program.

• Trending
Enables you to monitor term trends to surface changes in term trends and subsequently spot
unexpected trends. For instance, Trending enables you to learn about emerging business
phenomena, pinpoint important events that may require attention, reveal critical information that
you may not be aware about and identify issues before they escalate. This capability is only
available with Speech Analytics.

• Saved Trending filters
Enables you to run the same Trending filter numerous times on different dates and times.

Explore
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Search Results grid

Contents

• 1 Search Results grid columns
• 2 Working with the Search Results grid

• 2.1 Configure the grid columns
• 2.2 Generate an interactions list in the Interactions grid
• 2.3 Change the type of search results grid
• 2.4 Play an interaction from the Search Results grid
• 2.5 Open a segmented interaction
• 2.6 View search criteria

• 3 Batch actions
• 3.1 Export an interaction
• 3.2 Add interactions to an interaction list
• 3.3 Delete an interaction
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•

• Administrator

Use the Search Results Grid to find interactions that best match your business analysis. You can filter
the results displayed in the Search Results Grid using the options in the Search Filter.

Related documentation:
•
•

The Search Results grid contains detailed information about each interaction.

The availability of each Search Results grid column depends on the type of search results you
selected to view. Additional columns are available based on the metadata associated with the set of
interactions. For example, if your system stores an interaction metadata called Location, a Location
column can be added whenever interactions are listed in an Search Results grid. Since columns are
added for all selected fields, some columns may be blank for some interactions.

Interactions in the Search Results grid can be:

• Played back so you can listen to specific parts of the interaction.
• Saved so you can run the search at a later time.

Search Results grid columns

In the left corner of the screen (under the Media Player), select the type of interactions you want to
view from the menu provided.

The following image is an example of this menu. In this example, the user selects to view a list of all
the interactions found for the specific search. This menu indicates the number of interactions
returned out of the number that match the specific search criteria in the server.

Important
The default maximum number of interactions that can be returned is 1000. Not all of
the columns are available in each Search Results grid.

The Search Results grid can contain one or more of the following columns.

Search Results grid
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• Agent - The name of the agent who handled the interaction (available in: Interactions and Events).
• Auditor - The name of the auditor (available in: Events).
• Category - The category or categories that were assigned to the interaction. If only one category is

assigned, the name of the category appears. If multiple categories are assigned, the number of
categories appears. Place your mouse on the value to see a list of the categories. Category is only
available with Speech Analytics (available in: Interactions).

• Confidence - A value that indicates the reliability of an event identification. The higher the number, the
greater the degree of certainty (available in: Events).

Important
The Confidence number is not a percentage. The number is a range from 1 to 100.

• Date/Time - The interaction start date and time (in hours -minutes) (available in: Interactions and
Events).

• Duration - The duration of the interaction (in hours -minutes -seconds) (available in: Interactions and
Events).

• End Time - The event end time, offset from the start of the interaction (in hours -minutes -seconds)
(available in: Events).

• External ID - The event end time, offset from the start of the interaction (in hours -minutes -seconds)
(available in: Interactions and Events).

• Interaction ID - A unique number assigned to the interaction in the SpeechMiner UI database
(available in: Interactions and Events).

• Media - The type of interaction found (available in: Interactions).
• Number of Segments - The number of segments in an interaction (available in: Interactions).
• Open - A Play icon . Clicking the Play icon activates the Media Player (available in: Interactions and

Events).
• Program - The program that was used by SpeechMiner UI to analyze the interaction. Program is only

available with Speech Analytics (available in: Interactions and Events).
• Segment ID - The segment of the audio interaction associated with the event. Segment ID is only

available in a Recording UI environment and a Recording + Analytics environment (available in:
Events).

• Start Time - The end time of the event within the interaction or segment (in hours -minutes -seconds).
The start time of the screen recording (in date:hours:minutes:seconds) (available in: Events).

• Stop Time - The end time of the event within the interaction or segment in hours -minutes -seconds.
The stop time of the screen recording (in date:hours:minutes:seconds) (available in: Events).

• Tags - A list of tags associated with this interaction. For more information, refer to Search Filter > Tags
(available in: Interactions).

• Term ID - The ID number of the term that was identified in the topic (available in: Events).
• Text (available in: Interactions and Events) -

• Interaction grid - An excerpt from the interaction text containing a term that was included in a
search. The term must be specified in the SpeechMiner UI filter group. The term is highlighted in the

Search Results grid
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excerpt
• Event grid - Represents the phrase that SpeechMiner UI recognized.

Important
This column is only visible in grids that contain search results from searches that included terms.

• Topic (available in: Interactions and Events) -
• Interaction grid - The topic or topics SpeechMiner UI identified in the interaction. If only one topic

is identified, the name of the topic appears. If multiple topics were identified, the number of topics
appears. Place your mouse on the value to see a list of topics.

• Event grid - Represents the phrase that SpeechMiner UI recognized.

• TP / FP - If the event has been audited, one of the following values is selected and the entire cell is
color coded.
• TP - True Positive, color coded green.
• FP - False Positive, color coded red.
• SFP - Sense False Positive: color coded pink.

If you have Event Auditor permissions you can select a value in this column. To select a value, click
the value. To clear the selection, click Clear.

Important
If you selected Exclude events that have been audited before you initiated your search, previously
audited events will not appear in the grid.

• Workgroup - The work group associated with the agent who handled the interaction (available in:
Interactions).

Working with the Search Results grid

You can modify the Search Results grid to display a list of interactions with details specific to your
inquiry.

From the Search Results grid you can:

• Configure grid columns
• Generate the interactions list
• Change the type of search results grid
• Play an interaction

Search Results grid
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• Open a segmented interaction
• View search criteria

Configure the grid columns

1. At the top right corner of the Search Results grid, click the Select Columns icon .

2. Select the columns you want to display and clear those you do not want to display.
3. Click the Select Columns icon to close the list. The list closes and the selected columns are displayed.

Important
To return the grid columns to their default state, click the Select Columns icon and the Reset to
defaults link at the bottom of the list. You can also change the order of the columns by dragging a
column to a new location among the columns you selected to view.

Generate an interactions list in the Interactions grid
Perform one of the following:

• Explore > Search
• Explore > Saved Searches > Click the Run icon

• Explore > Content Browser

Important
When you first access Explore > Search, the list that appears includes all the
interactions in the system.

Change the type of search results grid

1. Access the Interaction grid.
2. Select one of the following from the menu above the Interactions grid (on the left):

• Interactions - A list of all the interactions the meet the search criteria.
• Events - A list of all the events that meet the search criteria.
• Screen Recordings - A list of all the Screen Recording interactions that meet the search criteria.

The following image represents the menu you should open at the top of the list:

Search Results grid
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Play an interaction from the Search Results grid

1. To play an interaction from the Search Results grid click Play on the row associated with the

interaction you want to play back.
• If you are trying to play back an audio interaction, the interaction is activated in the Media Player.
• If the interaction is not an audio interaction, the interaction transcript is opened.

Open a segmented interaction
Interactions imported from the Genesys Interaction Recording system may be divided into segments.
When this happens a plus sign appears instead of a Play icon .

1. In the Search Results grid click the plus icon associated with the interaction you want to open.
When the interaction row is expanded a list of the interaction's segments is displayed. Each
segment is identified with a Play icon .

Important
The first segment is automatically played in the Media Player. Playback stops when the end of the
segment is reached.

2. To play another segment from the same interaction click its Play icon .

View search criteria
If the Search Results grid was generated in response to a specific search, the upper left corner of
the grid contains a summary of the search criteria and settings that were employed during the
search.

1. Hover over the summary to see details about the search criteria.
If the grid was generated in response to a search for terms, a Related Search list will appear below the
search criteria.
If the system determines that one or more of the search terms was misspelled, it will correct the error
and indicate the correction in a note below the search criteria.

For additional information, see Create a new search.
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Batch actions

From the Search Results grid, you can perform the following batch actions for selected interactions:

• Export interactions
• Add interactions to a global interaction list
• Delete an interaction

Export an interaction
Exporting an interaction(s) creates a zip file containing the following files:

• A .csv file containing a list of audio interactions that were exported. The file also contains the search
results grid data associated with each interaction.

• An mp3 file for each audio interaction included in the list (optional).

Important
Some of the exported interactions may not be associated with an audio file.

To export interactions:

1. Select Explore > Search.
2. Run a search for the interaction(s) you want to export. See: Create a New Search.
3. In the title of the check box column, click the Batch Actions icon and select Export.

4. Select Export the selected interactions or Export all the interactions.

Important
If you select Export all the interactions all the interactions in all the search result pages will be
exported.

5. Select the Include audio and text interaction files checkbox if you want to include these files in the
.zip file and click Export. A zip file is created with the exported interactions.

Important
When you select Export and your system is configured to encrypt exported interactions, an Export
Interactions window appears. In this window, you will be instructed to create a password required when
you attempt to unzip the exported interactions.
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1. Enter a password of your choice in the Create Password field, or click Generate Password to
enable the system to generate a password for you in the Create Password field.

2. Click Export to export the selected interactions.
3. Copy and save the password and click Done. When you try to unzip the file, you will be prompted

for this password.

Important
Windows default zip program does not support encrypted zip files. To unzip the file, you must use a
different zip program.

Add interactions to an interaction list
An interaction list is a list of audio interactions that is saved for later use.

1. Select Explore > Search.
2. Run a search for the interaction(s) you want to add to an Interaction list. For more information, see:

Create a New Search.
3. Select the interactions you want to add to the Interaction list.
4. In the title of the check box column click the Batch Actions icon and select Add To.

5. Select Interaction List.
6. Select the list to which you want to add the selected interactions.
7. Select Export the selected interactions or Export all the interactions.
8. Click Add. The selected interactions are added to the selected interaction list.

Delete an interaction

1. Select Explore > Search.
2. Run a search for the interaction(s) you want to delete. See: Create a New Search.
3. In the title of the check box column click the Batch Actions icon and select Delete.

4. Click Yes when asked if you are sure you want to delete the interactions. The selected interactions are
deleted.
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Specifying search criteria

Contents

• 1 Create a new search
• 2 Search filter

• 2.1 Date Range
• 2.2 Terms & Topics
• 2.3 Categories & Programs
• 2.4 Agents & Work Groups
• 2.5 Metadata
• 2.6 Comments
• 2.7 User Actions
• 2.8 Segment
• 2.9 Tags
• 2.10 Interaction Properties

• 3 Saved Searches
• 3.1 Open a Saved Searches list
• 3.2 Compare Saved Searches
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•

• Administrator

Use the Explore > Search menu to define searches to explore interaction or event data. The Search
Filter allows you to specify the types of interactions you want to view.

Related documentation:
•
•

When creating a search you can use filters to specify the types of interactions or events you want to
view. When you run the search, SpeechMiner combs the database for interactions that match your
filter selections. The search results are displayed in the Search Results grid.

When performing a search SpeechMiner continues searching for interactions that match your search
criteria until one of the following occurs:

• All the interactions in the database are checked for matches with your search criteria.
• The processing limit (defined in the system's database configuration settings) is reached. For example,

if the processing limit is 1000 the first 1000 interactions that match the search criteria are retrieved
and the search ends.

Important
• A search generated from the Trending chart tooltip produces results based on a given

time period. The search process from the Trending chart searches for interactions that
are relevant to the search request. The process does not search for an exact match.

• A search generated from Explore > Search produces results based on the Search filter.
This search process searches for interactions that are an exact match to the search
request.

Once your search for specific interactions is complete, you can export interactions from the list or
add interactions to an existing interactions list. See Batch actions.

Create a new search

1. Select Explore > Search. A list of interactions associated with the previous search appears.
2. In the left corner of the screen (under the Media Player), select the type of interactions you want to
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search for.

Important
To view Screen Recording in Internet Explorer 10 and 11, you must enable the Miscellaneous > Access
data sources across domains in the Security Settings - Trusted Sizes Zone window.

3. Click the Search Filters icon . For additional information, see Search filter.

4. Configure the filter options.
5. Click one of the following:

• Search: Update the current search results according to the new filter configuration.
• Save As: Save the filter configuration as a Saved Search. You can run the saved search at a later

time.
• Clear Filters: Clear the current filter configuration.

The search is run according to your selection.

Search filter

You can refine you search criteria with the options available in the Filter panel.

Click the Filter icon in the Search Results grid to access the Filter panel.

When configuring the Filter panel consider the following:

• Only interaction that meet the conditions you set will be retrieved.
• The current search criteria is displayed at the top of the Search Results grid. When you make changes to

the filter the display is automatically updated.
• The Add and Remove icons enable you to add and remove additional filter selections and/or

values.
• Once you save your filter configurations, the configuration is saved as a Saved Search and can be run

in the future. See Working with saved searches.
• The Include / Exclude option enables you to define a negative condition. For example, when you select

Exclude, the condition is met when none of the selections or values for the specific filter are found in
the interaction(s).

• The View selected only option, enables you to display only the selected items associated with the
specific filter.
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The Filter panel is divided into the following groups:

• Date Range
• Terms & Topics
• Categories & Programs
• Agents & Workgroups
• Metadata
• Comments
• User Actions
• Segment
• Tags
• Interaction Properties

Date Range
Enables you to filter for the Search Results grid according to a specific date range:

• All - The default value that includes all interactions in the database.
• Yesterday - Filter interactions recorded on the previous day from 00 -00 until 23 -59.
• Today - Filter interactions recorded on the same day from 00 -00 until the exact time the search is

performed.
• Last Work Day - Filter interactions from the last work day prior to today (at 00:00) until the exact time

and date the search is performed.
• Last 2 Days - Filter interactions from two days prior to today (at 00:00) until the exact time and date

the search is performed.
• Last 3 Days - Filter interactions from three days prior to today (at 00:00) until the exact time and date

the search is performed.
• Week to Date - Filter interactions recorded from the beginning of the current week (the last Sunday at

00 -00) until the exact time and date the search is performed.
• Last 7 Days - Filter interactions from seven days prior to today (at 00 -00) until the exact time and date

the search is performed.
• Last Week - Filter interactions from the beginning through the end of the previous week.
• Month to Date - Filter interactions from the first day of the current month at 00 -00 until the exact

time and date the search is performed.
• Last 30 Days - Filter interactions from thirty days prior to today (at 00 -00) until the exact time and

date the search is performed.
• Last Month - Filter interactions from 00 -00 on the first day until 23 -59 on the last day of the previous

month.
• Quarter to Date - Filter interactions from 00 -00 on the first day of the current quarter until the exact

time and date the search is performed.
• Last 90 Days - Filter interactions from 90 days prior to today (at 00 -00) until the exact time and date
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the search is performed.
• Last Quarter - Filter interactions from 00 -00 on the first day until 23 -59 on the last day of the

previous quarter.
• Custom - Filter interactions from any date range selected from the two drop-down windows displayed.

You can specify the exact day, month and year of both the beginning and end dates.

Terms & Topics
Enables you to filter for interactions according to a one or more terms or phrases that must be part of
the interaction, topic and/or speaker:

• Text field - Enter the term(s) or phrase(s) to search for.
• Topics - Select one or more topics from the list to search for.
• Limit to - Select one or more Speaker Types from the list.

Only interactions found in one of the following situations are included in the search results:

• Interactions with only one audio channel (the system cannot identify who is speaking), where at
least one of the selected Speaker Types were involved in the interaction.

For example, the topic Payments was found at least once in the interaction and one of the
participants in the interaction was a speaker of type Agent.

• Interactions with more than one audio channel (the system identifies who is speaking at every
moment in the interaction), where at least one of the selected Speaker Types mentioned the
required topics and/or terms at least once in the interaction.For example, the Agent in the
interaction talked about the topic Payments.

Categories & Programs
Enables you to filter the Search Results grid according to categories and/or programs. Only
interactions in which at least one category/program is identified are included in the search results.

• Categories - Select one or more categories that should be associated with the interaction(s) you are
searching for.

• Programs - Select one or more programs that should be associated with the interaction(s) you are
searching for.

Agents & Work Groups
From the lists provided select any combination of agents and work groups to include in your search.

You can also choose to search for the "current user" rather than a specific agent or work group. In this
case, the condition changes depending on which user runs the report.

If you select a work group, all the agents in the work group are included in the search condition.

Metadata
Metadata is collected by the recording system and relayed by it to SpeechMiner. The types of
available metadata vary from system to system.
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The Metadata filter enables you to filter the search results for selected metadata and metadata
values.

The search results will only include interactions for which the selected types of metadata have
defined values and when you specify values that match the specified conditions.

Three types of metadata values can be used in the conditions you define:

• String of text (for example, "Detroit")
• Decimal number (for example, "10" or "32.5")
• Date

Dates must be entered manually in the same format used in your SpeechMiner web interface. For
example, if your system represents dates in format - mm/dd/yyyy hh -mm, you would enter Oct 24,
2013 at 10 AM as 10/24/2013 10 -00;.

The format used in your system is specified in the webserviceparams table, in the globalDateFormat
parameter.

For additional information, please consult your system administrator.

Define a metadata filter

1. Select to Include/Exclude the metadata.
2. Select the type of metadata from the list provided.
3. Click Values to configure the metadata.
4. In the first field, select:

• Equals - to specify a specific value for the metadata type.
• Between - to define a range of values. When you select Between an additional field is added to the

box.

5. To add an additional OR condition, click the Add icon to add a line in the box and fill it in as explained
above.

6. Click outside the box to close the box.

Comments
Enables you to filter the Search Results grid for interactions that contain comments made by selected
users.

• Blank text field - The text that must appear in one of the interaction comments. Only interactions that
contain comments in which this text is found are included in the search results.

• User - searches for the user(s) who added a comment to the interaction when playing the interaction.
Only interactions that contain comments from the selected users are included in the search results.

• Good - searches for the user(s) who selected Good when adding a comment to the interaction
during playback.
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• Neutral - searches for the user(s) who selected Neutral when adding a comment to the interaction
during playback.

• Bad - searches for the user(s) who selected Bad when adding a comment to the interaction during
playback.

User Actions
Enables you to filter the Search Results grid with interactions that were reviewed (played back or
opened) by the selected user(s).

Segment
Enables you to filter the Search Results grid according to segment ID's. See What is an Interaction >
Segment.

Under Segment select the number of segments to include in the search results. In the first field,
select either Less Than, Between, or More Than.

In the second text field or fields, fill in the amount of segments within an interaction that you want to
search for.

• Less Than - Search results include only interactions with a number of segments that is smaller than the
value you specified.

• Between - Search results include interactions that include a number of segments that is more than the
first value and less than the second value.

• More Than - Search results include only interactions that contain a number of segments that is more
than the value you specified.

Tags
Tags enable you to label an interaction as a result of a specific action or a user defined category. That
is, a tag is like a keyword that helps you identify an interaction, and enables you to generate better
search results.

Tags can also help you indicate which interactions cannot be deleted and which interactions have
been evaluated as part of a Quality Management Evaluation Session.

• Protect from Deletion / Unprotect from Deletion tag: The Protect / Unprotect from Deletion tag
enables you to search for interactions that cannot be deleted (see, Playback Controls row #13) .

• Evaluated tag: The Evaluated tag enables you to search for interactions that have already been part
of an evaluation session and subsequently prevents evaluated interactions from being reused (see,
Perform an Evaluation Session step #8).

• Screen Recording tag: The Screen Recording tag enables you to search for interactions that include a
screen recording.
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Important
The Tags filter is not available for Event searches.

Interaction Properties
Enables you to filter the Search Results grid list according to:

• Types - Select the type of interaction you are searching for (Calls, Chats, Emails, Facebook, SMS, or
Twitter).

• Languages - Set the language of the interactions you are searching for.
• Duration - Select the duration range of the interaction to include in the data set. In the first field, select

either Less Than, Between, or More Than.
In the second text field or fields, fill in the number of seconds.

• Interaction ID - Search results include only interactions with the value(s) you entered for the ID. In this
field, you can enter up to 50 Interaction ID's.

• External ID - Search results include only interactions with the value you entered for the ID. External ID
is a unique number assigned to the interaction by the external recording storage system.

Saved Searches

A Saved Search represents a group of interactions selected from a list of interactions that resulted
from a set of specific filter criteria (created in the Explore > Filter panel). Creating a Saved Search
enables you to combine a collection of interactions associated with the same topic. You can run this
unique Saved Search whenever the information the query generates is required.

Open a Saved Searches list
Select Explore > Saved Searches. The Saved Search tab is opened with the following options:

• Drop down list: Find and select the user(s) whose saved searches you want to see.
• Text field: Type a letter or sequence of letters that appears in the name of the saved search you want

to find.
• Delete : Select one or more searches from the list and click Delete to remove them from the

system.
• Compare saved searches : Select two searches to create a report the compares the two search

results.
• Table: See column descriptions below.
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Columns

• Checkbox : Select the check boxes to delete or compare.

• Run: Click the Run icon to run the search and display the results in the Search Results grid. If the
specific search was a search for screen recordings, the Search Results grid will show a list of
interactions with screen recordings.

• Delete: Click the Delete icon to delete the specific saved search.

• Name: The name of the saved search.
• Creator: The name of the user who created the saved search.
• Status: The status of the saved search.
• Sharing: The names of the user groups and users with whom the search is shared. Click

the Sharing icon to share the saved search with others.

• Created on: The date on which the search was created.
• Permalink: Click Copy to create a Permalink to the specific saved search. You can copy this link to your

clipboard and then paste it elsewhere as necessary. See the Permalink for additional information.

Compare Saved Searches
SpeechMiner UI enables you to compare two saved searches. The result is a report that shows how
the two data sets differ.

For example, you can compare two customer-service agent teams to learn which team has more
interactions with dissatisfied customers.

You can also compare two search results to see whether there are any noticeable differences with
regard to the most common terms in the interaction flows.

1. Select Explore > Search.

2. Click to open the Filter panel.
3. Define the search criteria for the data set you want to compare. See Create a New Search for additional

information.
4. In the Filter panel, click Save As to save the new search.
5. Repeat the steps above to define the second data set for the comparison.
6. Select Explore > Saved Searches.
7. Select the check boxes associated with the two Saved Searches you want to compare.
8. Click Compare in the top right corner of the screen.
9. In the Report Name field, enter a name for the comparison report.

10. From the Categories and Topic lists, select the categories and topics you want to compare in relation
to the two Saved Searches you selected.
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11. Click Run. The report will appear in the Saved Reports list and you will receive an email with a direct
link to report.
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Interaction lists

Contents

• 1 Create an Interaction list from the Search Results grid
• 2 Create an Interaction list from the Interaction Lists tab
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•

• Administrator

Use the Interaction Lists options to create collections of one or more interactions for targeted
analysis about a specific business issue.

Related documentation:
•
•

An Interaction list enables you to create a collection of one or more interactions about a specific
issue.

The list is made up of interactions that you manually select from the Search Results grid and add to
the list.

You can add an interaction to an existing Interaction list or you can create a new Interaction list.

An Interaction list can be created from:

• Search Results list
• Interaction Lists tab

Create an Interaction list from the Search Results grid

1. Select Explore > Search.
2. Run a search for the interaction(s) you want to add to the interaction list. See: Create a new search.
3. Select the interactions you want to add to the new Interaction list.

4. In the title of the check box column click the Batch Actions icon and select Add To.
5. Select Interaction List.
6. Click New Interaction List to create a new list with the selected interactions.
7. Click OK. The selected interactions are added to the selected interaction list.

Create an Interaction list from the Interaction Lists tab

1. Select Explore > Interaction Lists. The Interaction Lists tab is opened with the following options:
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• Drop down list: Find and select the user(s) whose interaction lists you want to see.
• Text field: Type a letter or sequence of letters that appears in the name of the interaction list you

want to find.

• Delete : Select one or more lists from the interaction list and click Delete to remove them from
the system.

• Rename an Interaction list : Select the interaction list whose name you want to change. Click
the Rename icon and give the list a new name.

• Table: See column descriptions below:

• Checkbox : Select the check boxes to delete or rename.

• Run: Click the Run icon to run the interaction list and display the results in the Search
Results grid. If the specific search was a search for screen recordings, the Search Results grid
will show a list of interactions with screen recordings.

• Delete: Click the Delete icon to delete the specific interaction.
• Name: The name of the interaction.
• Creator: The name of the user who created the interaction.
• Sharing: The names of the user groups and users with whom the search is shared. Click the

Sharing icon to share the interaction with others.
• Created on: The date on which the search was created.
• Permalink: Click Copy to create a Permalink to the specific interaction. You can copy this link to

your clipboard and then paste it elsewhere as necessary.
See Permalink for additional information.

2. Click the Create a new Interaction list icon .
3. Enter a name for the new list.
4. Click OK.
5. Add interactions to the new list.

1. Select Explore > Search.
2. Select interactions from the Search Results grid.

3. Click the Batch Actions icon and select Add To.
4. Select Interaction List.
5. Select the list you created at the beginning of this procedure.
6. Click Add.

6. Verify the interactions were added to the new Interaction list.
1. Select Explore > Interaction Lists.

2. Click the run icon to run the new list.
3. Review the Search Results grid and verify that the interactions you selected were added to the list.
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Content Browser

•

• Administrator

Content Browser enables you to view the interactions associated with specific categories, agents,
and programs. For example, selecting the category option will produce a list of all the categories and
their sub-categories associated with one or more interactions.

Related documentation:
•
•

With Content Browser, you can filter your selection further by selecting an additional search criterion.
For example, you can select to search for interactions associated with categories and a specific
program. If you selected a category and a program called "debt", the result will be a list of all the
categories associated with interactions that are also associated with the program "debt".

To search for interactions associated with a specific category, agent, or program:

1. Select Explore > Content Browser.
2. From the Explore list, select the type of interaction distribution you are interested in seeing.
3. From the Filter By list, select an additional criterion type for the interaction distribution.
4. From the Any list, select the specific criterion.

For example, if you select Work group in the Filter By list, you must select the specific work group
name. If you select Any list, then all work groups associated with a category in the list will be part of
the search results.

The Content Browser list is automatically refreshed and updated with every selection you make and
is displayed in a table with the following columns:

• Classified Interactions: The list of categories, programs, or agents that are associated with an
interaction.

• Language: The language the program is associated with.
• Last Call: The date and time of the last interaction the specific agent took part in.
• Last updated: The last date on which the specific program was updated.
• Number of Agents: The number of agents the agent manages.
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• Number of Interactions: The number of interactions associated with the category, agent or program.
• Percentage:

• Category percentage: The percentage of interactions associated with the category compared with
all the categories in the list.

• Sub-category percentage: The percentage of interactions associated with the sub-category
compared with all the sub-categories within the specific category.

• Priority: The priority level given to the program.

Content Browser

Genesys Recording, Quality Management, and Speech Analytics User's Guide 69



Trending

Contents

• 1 Bubble Chart Example
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•

• Administrator

Use this page to monitor and analyze terms and phrases within conversations according to a variety
of search criteria to better understand familiar and unexpected trends.

Related documentation:
•
•

The Trending page is designed to help you monitor and analyze terms and phrases within
conversations and identify and explore familiar and unexpected trends. By analyzing term trends
within a specific interaction set over specific time periods and/or according to a variety of search
criteria (for example, agent and/or customer side, metadata, duration, categories, topics,
agents, work groups, language and so on), Trending enables you to better understand emerging
business issues, pinpoint events that may require close attention, identify process or service issues
before they escalate and recognize strengths and weaknesses of the organization’s employees,
products, and processes.

The data in the Trending page is based on an automated analysis of interaction transcripts together
with the identification of changes in the frequency with which a term/phrase appears in interactions.
Term/phrase frequency is the number of interactions within which the term/phrase is found divided by
the entire set of interactions during a given time period, expressed as a percentage. For example, if
during a specific time period a phrase was used in 350 out of 1000 interactions; the phrase frequency
for that given time period is (350/1000)*100% = 35%.

Terms/phrases appear in the Trending chart according to a salience measurement (for example,
relative importance measurement). Terms and phrases with a high salience measurement will be
included in the Trending chart. The purpose of the salience measurement is to filter out common
terms/phrases (for example, thank you), to make room for significant terms and phrases.

Trending requires no input from users about what terms and phrases should be found within the
interactions, and for this reason the information in the Trending page can help you identify issues and
trends that are unforeseen or unexpected.

From the Trending page you can create and save Trending charts that show the distribution of terms
and phrases within a selected interaction set. The relative frequency of terms and phrases is
visualized using a bubble chart. The bubble chart (see image below) provides at-a-glance insight on
four dimensions:

• Size: The size of the bubble is proportionate to the number of times the term or phrase appears in the
interaction set. The larger the bubble’s radius, the more the term or phrase is used within the
interaction set.

• Color: The bubbles are shaded red or green and represent the change in frequency. The deeper the
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shading the larger the frequency change. Red represents a negative (reduction) in frequency and green
represents a positive (increase) in frequency for that particular term.

• Comparison: Bubbles that contain a dotted line circle indicate a term or phrase that appears in the
selected interaction set in both Period 1 and Period 2. For example, if you are viewing the Period 1 tab,
the dotted line represents the term/phrase frequency in Period 2 and vice versa.

• Cluster: Bubbles connected with lines represent a collection of terms and phrases within the
interaction set that have a strong semantic similarity.

Bubble Chart Example

This visual representation enables you to quickly identify the terms and phrases with the highest and
lowest frequency, and any deviation from regular term frequencies. This enables users to surface and
analyze trends that might otherwise go undetected. After recognizing the terms and phrases that
have the strongest or weakest correlation, you can refine your search results accordingly, to search
for the interactions most related to the business issue you are investigating.

For detailed information about how to configure and interpret the Trending page, refer to the
following:

• Create a Trending filter
• Trending filter toolbar description
• Trending filter tooltip description
• Trending filter chart data description
• Manage the Blacklist
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• Working with saved Trending filters
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Create a Trending filter

Contents

• 1 Create a new Trending filter

Create a Trending filter
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•

• Administrator

Use the Trending filter to create filters that enable you to monitor and analyze terms and phrases
within conversations and to identify and explore familiar and unexpected trends. By analyzing term
trends within a specific interaction set over specific time periods and/or according to a variety of
search criteria (for example, agent and/or customer side, metadata, duration, categories, topics,
agents, work groups, language and so on), Trending enables you to better understand emerging
business issues, pinpoint events that may require close attention, identify process or service issues
before they escalate and recognize strengths and weaknesses of the organization’s employees,
products, and processes.

Related documentation:
•
•

Create a new Trending filter

1. Select Explore > Trending.
2. From the Trending Filter list, select one of the following time frames:

• Top terms intra-day: Displays the most frequently used terms and phrases included in all of the
interactions in the system 3 hours prior to the current time.

• Top terms today compared to yesterday: Displays the most frequently used terms and phrases
included in all of the interactions in the system 24 hours prior to the current time.

• Top terms today compared to the past week: Displays the most frequently used terms and
phrases included in all of the interactions in the system 7 days prior to the current day.

• Top terms today compared to the same day a week ago: Displays the most frequently used
terms and phrases included in all of the interactions in the system exactly one week from today. For
example, if you are creating the Trending filter on Monday, September 26th, 2016, the filter will
search for terms and phrases on Monday, September 19th, 2016.

• Custom: Displays the most frequently used terms and phrases included in all of the interactions in
the system according to the selected Basic and/or Advanced filter options.

3. Configure one or more of the Basic and/or Advanced filters. For more information, refer to the Trending
Filter toolbar description.
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Important
If you select one of the top terms filters and then change Relative to Fixed, Monitor and/or Compare,
the Trending filter list will change to Custom.

4. Click Run. The bubble chart and corresponding chart data appear on the screen. Refer to the following
pages for explanations about how to interpret the Trending chart:
• Trending Filter toolbar description
• Trending Filter tool tip description
• Trending Filter chart data description

5. Click Save to save the Trending filter. The Save Trending Filter window appears.
6. In the Trending Filter Name enter a name for the filter and in the Description (optional) field enter a

description.
7. Click Confirm to save the Trending filter.
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Trending Filter toolbar description

Contents

• 1 Trending filter
• 2 Chart tools
• 3 Basic filter
• 4 Advanced filter

Trending Filter toolbar description
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•

• Administrator

Use the Trending filter options to refine the data in the Trending page.

Related documentation:
•
•

You can refine your Trending filter with the options available in the Explore > Trending page.

Once you select the type of Trending filter you want to create, you can refine your Trending filter
using the options in the following areas:

• Chart tools
• Basic filter
• Advanced filter

Trending filter

• Top terms intra-day: Displays the most frequently used terms and phrases included in all of the
interactions in the system 3 hours prior to the current time.

• Top terms today compared to yesterday: Displays the most frequently used terms and phrases
included in all of the interactions in the system 24 hours prior to the current time.

• Top terms today compared to the past week: Displays the most frequently used terms and phrases
included in all of the interactions in the system 7 days prior to the current day.

• Top terms today compared to the same day a week ago: Displays the most frequently used terms
and phrases included in all of the interactions in the system exactly one week from today. For example,
if you are creating the Trending filter on Monday, September 26th, 2016, the filter will search for terms
and phrases on Monday, September 20th, 2016.

• Custom: Displays the most frequently used terms and phrases included in all of the interactions in the
system according to the selected Basic and/or Advanced filter options.

Chart tools

• : Opens the Saved Trending Filters page. This option enables you to abort a session at any time. A
prompt enables you to confirm or cancel your decision.

Trending Filter toolbar description
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• : Manually refreshes the chart view. This fetches the latest data generated by the system in the
back end, and influences the time stamp of the visualization currently being viewed.

• : Opens the Blacklist. The blacklist is used to manage a permanent set of excluded terms/phrases in
the Trending data. Users with permissions are able to add and delete items from the list as necessary.
For additional information, refer to Manage the Blacklist.

• Run: Applies the configured filter to the data set to produce the Trending chart.
• Chart tabs: Displays three views of the data that visualize trending information for the selected time

period.
• Comparison: Shows the entire data set for both Period 1 and Period 2.
• Period 1: Shows the data set for the dates selected for Period 1.
• Period 2: Shows the data set for the dates selected for Period 2.

• Ignore Blacklist: Allows the terms and phrases in the Blacklist to be included in the Trending chart. For
additional information, refer to Manage the Blacklist. When this option is turned on, the phrases appear
in the Trending view with a dark border

• Layout: Allows you to control how data is viewed in the Trending view. You can select one of three
layouts:
• Combination: Shows both the chart and the chart tables. When the Combination layout is selected,

the user can use the resize bar to change the size of each area.
• Chart: Only shows the Trending chart.
• Table: Only shows the Top# Terms and Top Movers tables.

Important
The Layout chart tool is only available in a Azure environment.

• Trending Report last referenced on: Displays chart details that tell you when the specific report was
created and last changed.

• Show chart data: Shows/hides a panel underneath the Trending chart. The panel shows in-depth
information about the visualization at hand, and changes accordingly based on the user’s selections
and activities. For additional information, refer to Trending Filter chart data description.

• Save: Enables you to save (or save and rename) the current Trending filter. For additional information,
see Working with saved Trending filters.

• Search Term: Enables you to search for a specific term and/or phrase within the Trending chart results.

Basic filter

• Time Period - Relative:
• Monitor: Select an amount and time period (for example, 3 days) for which you want to analyze

terms and phrases. Monitor results appear in the Period 1 tab.
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• Compare: Select one of the following options. Results of your selection will be compared to the
Monitor selection you made and will appear in the Period 2 tab.
• Same period as before: Analyze all the terms and phrases in the period before the monitor

period. For example, if you selected 3 minutes in the Monitor option at 22:00, the Compare
period will be 21:57-22:00.

• Same period as yesterday: Analyze all the terms and phrases 24 hours before the monitor
period. For example, if you selected 3 hours in the Monitor option at 22:00 on Thursday 29,
2016, the Compare period will be from 19:00-22:00 on Thursday 28, 2016.

• Same period last week: Analyze all the terms and phrases during the same day exactly a
week before the monitor period. For example, if you selected 3 hours in the Monitor option at 10
pm on Thursday 29, 2016, the Compare period will be from 7 pm–10 pm on Thursday 22, 2016.

• Previous week including yesterday: Analyze all the terms and phrases for 7 days prior to the
monitor period. For example, if you select 1 day in the Monitor option on Thursday 29, 2016, the
Compare period will be the entire data set during the last week, plus one day.

• Specific date range: Analyze all the terms and phrases in a specific time period. For example,
if you select 7 hours in the Monitor option on Thursday 29, 2016, the system will compare the
terms and phrases in those 7 hours to all the terms and phrases that appear during the entire
specific date range.

• Time Period - Fixed: In the fields provided select the date ranges for which you want to compare
terms and phrases. Results for Period 1 and Period 2, will appear in their respective tabs at the top of
the chart.

Important
The Comparison tab includes all the terms and phrases from both periods.

• Speakers:
• Agent: Show terms and phrases spoken only by the agent.
• Customer: Show Terms and phrases spoken only by the customer.
• All Speakers: Show terms and phrases spoken by the agent and/or the customer.

• Interaction Properties:
• Types: Select the type of interaction whose terms and phrases you want to analyze (Calls, Chats,

Emails, Facebook, SMS, or Twitter).
• Languages: Select the language of the interactions whose terms and phrases you want to analyze.
• Duration: Select the duration range of the interactions to include in the data set. In the first field

select either Less Than, Between, or More Than. In the second text field or fields, fill in the number
of seconds.

• Max terms per period: The maximum number of terms/phrases visible (that is, the number of chart
bubbles) in each Period 1 and Period 2 tabs. The Comparison tab contains the terms/phrases that
appear in Period 1 and Period 2 tab.
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Advanced filter

• Metatdata: Enables you to filter the results for selected metadata and metadata values. The results
will only include terms and phrases associated with interactions for which the selected types of
metadata have defined values and when you specify values that match the specified conditions.

• Terms & Topics: Enables you to filter for interactions according to one or more terms or phrases that
must either be part of the interaction and topic, or excluded from both.
• Text field: Enter the term(s) or phrase(s) to search for.
• Topics: Select one or more topics from the list to search for.
• Include: Select if the term and phrase must be included or excluded from the interaction set.

• Categories & Programs: Enables you to filter the interaction set according to categories and/or
programs. Only interactions in which at least one category/program term and/or phrase is identified are
included in the results.
• Categories: Select one or more categories that should be associated with the term and/or phrase

you are searching for.
• Programs: Select one or more programs that should be associated with the term and/or phrase you

are searching for.

• Agents & Workgroups: From the lists provided select any combination of agents and workgroups
whose terms and phrases you want to include/exclude in your results. If you select a workgroup, all the
agents in the workgroup are included in the search condition.
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Trending Filter tooltip description

•

• Administrator

The bubble chart that appears after you run the Trending Filter includes a variety of information that
enables you to better understand the changes and distribution of terms and phrases within a
selected interaction set.

Related documentation:
•
•

Significant information about a specific term/phrase and additional options are available in the term/
phrase tool tip. From the tool tip you can:

• View the chart data numerically.
• Hide the term/phrase from the chart data.
• Add the term/phrase to the Blacklist.
• Create an interaction search.
• Discover the terms/phrases that are related to the selected term/phrase.
• The following image is an example of the Trending chart tooltip. For details about the tool tip refer to the

list below.
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• Name: The term/phrase for which the specific tooltip appears.
• Trend: Shows the frequency change for the selected term/phrase. The red arrow indicates that the

specific term/phrase appears less frequently and the green arrow indicates that it appears more
frequently.

• Total Interactions:
• Period 1: Indicates the number of interactions in which the term/phrase appeared, out of the total

number of interactions for the specific Period 1 data set.
• Period 2: Indicates the number of interactions in which the term/phrase appeared, out of the total

number of interactions for the specific Period 2 data set.

• Search Interactions: Performs a search for all the interactions in which the specific term/phrase
appears. The search is performed for interactions that appear in the specified period's data range. For
more information about searching for interactions, refer to Create a new search.

• Hide: Hides the specific term/phrase from the Trending chart view.
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Important
The chart statistics include the hidden term/phrase. Also, refreshing the entire Trending page shows all
the hidden terms/phrases.

• Add to Blacklist: Adds the specific term/phrase to the global blacklist for all users, views and
languages. For additional information, refer to Manage the Blacklist.
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Trending chart data description

Contents

• 1 Top terms/phrases
• 2 Term/Phrase drilldown
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•

• Administrator

Use the Trending chart to further analyze the relevance of a term/phrase, by studying the
information panel that accompanies the Trending bubble chart.

Related documentation:
•
•

By default the information shown underneath the chart shows data about the current Trending filter,
and changes accordingly based on your selections and activities in the chart.

You can use the information panel to view statistical information about all interactions, or about a
specific subset of interactions from your search results.

For detailed information about each option refer to:

• Top terms/phrases
• Term/Phrase drilldown

Top terms/phrases

At the bottom of the bubble chart (as shown in the following image), there are two lists (Top #
Terms and Top Movers). The two lists enable you to view the most frequently used terms/phrases
during the selected time period and the terms/phrases with the highest change in frequency during
the same time. For details, see the table below:

• Top Movers: Lists the terms/phrases that had the highest frequency change in the between Period 1
and Period 2. The red arrow indicates that the specific term/phrase appears less frequently and the
green arrow indicates that it appears more frequently.
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Enables you to sort the term/phrase list to show all the terms/phrases, only
those with a decrease in frequency, only those with an increase in frequency or only the terms/
phrases that had no change.

Enables you to view the frequency change as a percentage or a number.

• Top # Terms: The terms/phrases that stand out among the entire data set for the selected time period.

• : Indicates the number of terms/phrases visible, hidden, and filtered (added
to the Blacklist) in the Top # Terms list.

• Statistics:
• United: Indicates the number of terms/phrases that appear both in Period 1 and Period 2.
• Unique to Period 1: Indicates the number of terms/phrases that only appear in Period 1.
• Unique to Period 2: Indicates the number of terms/phrases that only appear in Period 2.

• Total Interactions: Indicates the number of terms/phrases that appear in Period 1 and the number of
terms/phrases that appear in Period 2.

• Term List:
• Term: Indicates the term/phrase that appears in the interactions for the selected time periods.
• Highest: Indicates the highest frequency for the specific term/phrase among all of the interactions

for the selected time periods.
• Count (P1): Indicates the number of times the specific term/phrase appeared in Period 1.
• Count (P2): Indicates the number of times the specific term/phrase appeared in Period 2.
• Rank (P1): Reveals the importance and prominence of the specific term in Period 1. The higher the

number, the more prominent the term.
• Rank (P2): Reveals the importance and prominence of the specific term in Period 2. The higher the

number, the more prominent the term.
• Visible: Indicates whether or not the specific term/phrase is visible in the bubble chart and

information panel at the bottom of the chart.

• : Enables you to add/remove a column from the Term list table.

• : Enables you to view statistics about a term/phrase that is not shown in the bubble chart and list
because it was added to the Blacklist. For example, the following image indicates that the term notes
and its corresponding statistics will not appear in or be a part of the Trending chart because it was
added to the Blacklist.
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• : Enables you to hide or show all the terms/phrases from the chart. For example, if you
select the Period 1 tab and hide all the terms/phrases, in the Comparison tab you will be able to view
the terms/phrases that only appear in Period 2 and not in Period 1.

• : Enables you to search for a specific term/phrase within the Top # Terms list.

Term/Phrase drilldown

When you click one of the bubbles in the Trending chart, the information panel at the bottom of the
screen changes (as shown in the following image) and shows trend data specifically about the
selected term/phrase. For details, see the list below.

Important
Click outside the bubble chart to return to the previous view.

Important
The top left corner of the information panel contains the specific term/phrase selected
from the bubble chart.

For example, in the above image the term tickets was selected.

• Interaction Trend: The bar graph shows changes over time in relation to how often the specific term/
phrase was found. The graph shows the percentage of interactions that included the term/phrase in
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each period.
• Total Interactions: Indicates the number of interactions that contain the specific term/phrase out of all

the interactions in the specific period.
• Trend: Indicates the frequency change for the selected term/phrase during the specified time period.

The red arrow indicates that the specific term/phrase appears less frequently and the green arrow
indicates that it appears more frequently.

• Similar Words: A list of the terms/phrases with the strongest correlation to the selected term/phrase.
The list consists of terms/phrases spoken in the same context and therefore can be helpful in
identifying topics in which the terms have been used. For example, synonyms and antonyms such as:
answer, question, respond / calm, nervous, peaceful / costly, cheap, expensive and so on.
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Manage the Blacklist

Contents

• 1 Manage the Blacklist

Manage the Blacklist
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•

• Administrator

Use the Blacklist to manage a list of terms/phrases that should be ignored by the system when
analyzing Trending data. The Blacklist applies to all users, views and languages.

Related documentation:
•
•

The Blacklist list is a collection of terms/phrases permanently ignored by the system when analyzing
Trending data. The list affects all users, views and languages.

Manage the Blacklist

1. Click the Blacklist button . The following window opens.
2. Click Add Term to add a term/phrase to the list.
3. In the text field that appears type the term/phrase you want to add to the list and click Add.
4. To remove a term/phrase from the blacklist, click Delete next to the term/phrase you want to remove

from the list.
5. Click Confirm to save your changes.

Important
You can add a term/phrase to the blacklist from the Trending Filter tooltip and you can
configure the Trending page to ignore the blacklist using the Ignore Blacklist option,
allowing the terms/phrases in the Blacklist to be included in the Trending chart. When
this option is enabled, the phrases appear in the Trending view with a dark border.
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Working with saved Trending filters

Contents

• 1 Edit a saved Trending filter
• 2 Copy a saved Trending filter
• 3 Delete a saved Trending filter
• 4 Create a Trending filter
• 5 Run a Trending filter
• 6 Saved Trending filter columns
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•

• Administrator

Use Saved Trending filters to support historical analysis and/or to enable you to rerun the filter for
different time periods.

Related documentation:
•
•

Saving a Trending filter is useful when you want to analyze historical trends and/or run the same filter
during a different time period. This option prevents you from having to define the filter criteria
manually each time you want to run the same filter.

• Edit a saved Trending filter
• Copy a saved Trending filter
• Delete a saved Trending filter
• Create a new Trending filter
• Run a Trending filter
• Saved Trending filter columns

Edit a saved Trending filter

1. Select Explore > saved Trending filters.
2. In the Trending filter Name column, click the name of the filter you want to edit. The filter is opened.
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3. Change the filter and click Save.

Copy a saved Trending filter

1. Select Explore > saved Trending filters.

2. Click the checkbox next to the name of the filter you want to copy and click the Clone button . A
copy of the filter is added to the saved Trending filters list.

Delete a saved Trending filter

1. Select Explore > saved Trending filters.
2. Click the checkbox next to the name of the filter(s) you want to delete and click the Delete button . The

specific filter(s) are deleted from the saved Trending filters list.

Create a Trending filter

1. Select Explore > saved Trending filters.
2. Click the New Trending filter button. The Trending window is opened. For details, see Create a

Trending filter.

Run a Trending filter

1. Select Explore > saved Trending filters.
2. Click the Trending Filter you want to run. The Trending filter window is opened.
3. The bubble chart and corresponding chart data appear on the screen.

Saved Trending filter columns

• Trending filter Name: The name of the Trending filter.
• Description: The description given to the filter when it was saved.
• Creator: The name of the user who created the Trending filter.
• Created: The date and time when the Trending filter was created.
• Time Period: Relative or Fixed. For details, refer to Basic Filter table in the Trending filter toolbar

description page.
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Export Trending Data

Contents

• 1 Before you export Trending data, consider the following
• 2 Export Trending Data
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Exporting Trending data enables you to compare data across different Trending Filter results. The
Trending data is exported to a .csv file.

Related documentation:
•
•

Before you export Trending data, consider the following

• Only data from the last Trending Filter that was run will be exported to a .csv file.
• To view data specific to a Custom Trending Cluster Task, you must have the necessary Trending

permissions. If you do not have the correct permissions, N/A will appear.
• The exported Trending data will include hidden terms and phrases, but it will not contain terms and

phrases in the Blacklist.

Export Trending Data

1. Select Explore > Trending / Saved Trending Filters.
2. Click Run.
3. Click Save > Export. A message appears reminding you that only the data from the results of the last

time you clicked Run will be exported to the .csv file.
4. Click Export. The .csv file is created.
5. Save the .csv file in a location of your choice.
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Using the Media Player

Contents

• 1 Playback
• 1.1 Playback timeline
• 1.2 Playback controls
• 1.3 Hidden Confidential Information

• 2 Dual-channel audio
• 3 Other Media Player actions

• 3.1 Export an interaction
• 3.2 Add an interaction to a list
• 3.3 Delete an interaction from the current interaction list
• 3.4 Create a permalink to an interaction
• 3.5 Tag an interaction
• 3.6 Remove a tag from an interaction
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•

• Administrator

Use the Media Player to play back the audio of a recorded interaction and explore other aspects of
the interaction. With the Media Player you can listen to an interaction, access a transcript of the
interaction to view the words spoken, read comments to view other users ideas and thoughts about
the interaction, add your own comments, view events associated with the interaction, an so on.

Related documentation:
•
•

The Media Player provides a range of interaction playback features that can help you to:

• Quickly and easily find information associated with the specific interaction.
• View events associated with the interaction.
• View an interaction's transcript.
• Add comments and view comments made by other users.

To activate the Media Player, click the Play icon in the Search Results grid. The Media Player
is displayed as a timeline with various controls and a variety of information. If interactions are
recorded with two audio channels (for example, one for the agent and the other for the customer),
the audio channels are shown on both sides of the audio line (one speaker above and the other
below).

Events (both linguistic and non-linguistic) and comments are indicated by icons above the audio
graph.

To learn more about how to work with the Media Player refer to the following sections:

• Playback: Enables you to listen to a specific interaction.
• Media Player actions: Enables you to perform numerous tasks associated with the interaction you are

playing.
• Interaction transcript: Enables you to view the words spoken during the interaction.
• Interaction comments: Enables you to view other users' ideas and thoughts about the interaction and

provides you with the option of making comments yourself.
• Interaction attributes: Enables you to view specific characteristics about the interaction you are playing.
• Interaction events: Shows you when events are detected during the interaction.
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Important
Interactions are re-indexed when an interaction is played and when a comment is
added or changed.

Playback

The Media Player is activated above the Search Results grid when you select to play back an audio
interaction, event and/or screen recording.

Before you begin working with the Media Player consider the following:

• You can play back an interaction from any point in the recording.
• Supports voice recordings in both primary and secondary regions. You can use the SpeechMiner UI of

the primary region to play back the recordings from both regions.

Warning
SpeechMiner is deployed in the primary region. If the primary region goes down, the recordings for the calls in
the secondary region are not lost. Because of the switchover, there is a delay in SpeechMiner processing the
calls from the secondary region.

• Voice recordings metadata is now exported to Azure Blob for download. You can access and export the
call events associated with an interaction and also find other interactions.

• Playback always begins from the location of the marker in the audio graph.
• When you play back an interaction from the Search Results grid, the marker moves to the beginning of

the interaction.
• Playback begins automatically when the interaction is loaded.
• The Media Player includes various playback controls that enable you to better analyze the specific

interaction. For additional information, see Playback controls.

Playback timeline
The following non-linguistic icons may appear on the playback timeline. For details about each one of
these refer to Interaction Events.
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Playback controls
The following image and table represent all the available playback controls:

Important
The Quality Management media player contains fewer controls then the Media Player.
In addition, the Quality Management media player contains an icon that when
clicked opens the media player in a new separate window. The advantage is that you
can view the media player in one screen while looking at SpeechMiner data in a
second screen. For more information about Quality Management, see Quality
Management (QM).
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Number Description Available for
1 Play or pause the interaction in the current location. Audio Interactions, Events
2 Play the next event. Audio Interactions, Events
3 Play the previous event. Audio Interactions, Events

4 Rewind the playback 5 seconds from the current location of
the marker. Audio Interactions, Events

5 Play the next or previous interaction. Audio Interactions, Events

6
Control the speed at which the interaction is played. 1.0 is
the default normal speed and every number above is
faster. For example, 2.0 is twice as fast as the normal
speed.

Audio Interactions, Events

7 Turn on/off the volume. Audio Interactions, Events
8 Select a volume level. Audio Interactions, Events

9

Show / Hide Screen Recording.
Note: If the screen recording is longer than the available audio an ACW

(after call work) icon appears . The ACW icon appears on the
playback timeline at the time that is equal to the duration of the audio
media file. The screen recording plays beyond the end of the audio file.

Audio Interactions, Events

10 Change the screen's brightness. Audio Interactions, Events

11

Lock/Unlock the playback with the scroll bar. When this
option is turned Off, you can scroll towards the end of the
interaction before the playback reaches the same location.
Turn this option On if you want the interaction to
automatically scroll so that the part of the interaction that
is currently being played back is always visible. The scroll
bar moves automatically to keep up with the playback.

Audio Interactions, Events

12 Indicates the specific interaction ID and agent name. Audio Interactions, Events

13

A menu with the following options:

• Export: Export the interaction to a zip file.
• Add To...: Add the interaction to an interaction list.
• Tag: Add a tag to the interaction to create a connection

between the specific interaction and a specific topic.

Audio Interactions, Events
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Number Description Available for

For more information, refer to Specifying search
criteria.

• Evaluate: Create an evaluation session (Ad-Hoc
Evaluation) for the selected interaction. For details
about how to create and work with an Ad-Hoc
evaluation, see Create an Ad-Hoc Evaluation Session.

• Permalink: Copy a link to the specific interaction.
• Protect from Deletion / Unprotect from Deletion:

Tag the selected interaction with a Cannot Delete tag
so that it cannot be deleted, or conversely, remove the
Cannot Delete tag from the selected interaction.

• Delete: Delete the specific interaction.
Note: For more information about some of these options, refer to Batch
actions.

14

Screen Recording playback. In this area of the screen you
can view the selected screen recording. A screen recording
is a video of the agent's screen during the specific agent-
customer interaction.

You can export screen recordings by using the Export option in the More
Actions menu. This export is only available for single recordings. Batch
export of recordings is disabled. Note: For the screen recording Export
option to be enabled for a user, the user must have the Enable Video
Context Menu permission enabled.

Audio Interactions

15 Return to the search results list. Audio Interactions, Events

16
Full screen view.
Note: Internet Explorer 10 and 11 does not support this option. Audio Interactions, Events

17
The envelope (email) and paper (chat) icon appear in the
location of the recording when an email was received or a
chat conversation took place.

Audio Interactions, Events

18 Enables you to enlarge the video screen in the media
player. Audio Interactions, Events

Hidden Confidential Information
Interaction audio and text may be filtered in your system so that it is hidden from the users eyes.
This is done to ensure that confidential information cannot be accessed by users who do not have
permission to do so. For this reason, different users may have different permissions. As a result,
certain parts of an interaction may be hidden for some users but not for others.

The parts of an interaction that are hidden appear in the audio graph in gray rather than black.
Likewise, the text associated with the hidden parts of the interaction is not included in the interaction
transcript and the Media Player skips these areas during playback.
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The following content can be hidden:

Sensitive Topics: Some topics may be defined in your system as Sensitive. This attribute is
assigned to Topics in the SMART application and only users with special permissions can hear the
audio or see the text.

Numbers: Numbers consisting of more than two digits may be filtered out of interactions to ensure
unauthorized users do not have access to credit card numbers and other confidential information.
When you filter text interactions, the confidential digits appear as asterisks.

Enhanced digits filtering (voice interactions only): Digits can be filtered based on complex logic.
Additional conditions can be included in the filter, such as greater than, smaller than or equal to. The
conditions must be separated by a semi-colon. For example, >5;. If complex conditions are not
allowed, the default logic of filtering numbers consisting of more than two digits
will take effect.

Comment-Only permission: Some users may only be able to access the parts
of an interaction where comments were attached.

Important
For additional information about the filter rules in your system, consult your system
administrator.

Dual-channel audio

Recordings in Genesys Multicloud CX are recorded with dual channel audio, one for the agent's side
of an interaction and the other for the customer's side of the interaction. If your recording system
does this, an energy bar (as shown in the following image) will appear above and below the line in
the audio graph so that you can tell who is speaking at any given moment. Filtered audio content is
still displayed in gray. As a result, you may see as many as three different colors in the audio graph.
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Other Media Player actions

In addition to playing back an interaction, the Media Player enables you to perform numerous tasks.

In the following sections you will learn how to:

• Export an interaction.
• Add an interaction to an interaction list.
• Delete an interaction from the current interaction list.
• Create a permalink to the interaction.
• Tag an interaction.
• Remove a tag from an interaction

Export an interaction
If you want to save an interaction or send it to another user, you can export the interaction as a .zip
file that contains the following:

• A CSV file with information about the interaction. This file can be opened using a spreadsheet
application such as Microsoft Excel.

• An MP3 file. A playable audio file of the interaction (optional).

1. Select Explore > Search.
2. Select the interaction(s) that you want to export.

3. Click More and select Export. A dialog box opens and asks if you want to include the audio files with
the export.

4. Select Export the selected interactions or Export all the interactions.
5. Select the Include audio and text interaction files checkbox if you want to include these files in the

.zip file and click Export.
6. Select the desired option. If you select Open, the file opens in the application that is configured to open

ZIP files on your computer. If you select Save, a Save As dialog box opens.
7. Navigate to the folder in which you want to save the file, and then click Save. The file is saved in the

selected location.

Add an interaction to a list
An interaction list is a list of interactions that is saved for later use.

You can add an interaction to a global interaction list.

For additional information, see: Batch actions.
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Delete an interaction from the current interaction list

1. Select Explore > Search.
2. Select the interaction(s) that you want to delete.

3. Select More and click Delete.
4. Click OK when asked if you are sure you want to delete. The selected interactions are deleted.

Create a permalink to an interaction

1. Select Explore > Search.
2. Select the interaction(s) that you want to delete.

3. Select More and click Permalink.
4. Copy the link from the dialog box that opens.

Tag an interaction

1. Perform a search. See Create a new search for details.
2. From the search results list, select the interaction that you want to tag.

3. Select the More menu in the media player and click Tag.... The Tag Interaction window appears.
4. In the Tag Interaction window, select one or more tags and click Confirm. The selected interaction is

tagged with the selected tags.

Important
In multiple segment interactions, tags will be associated with the entire interaction
and not a specific segment. Segments will not have their own tags.

Remove a tag from an interaction

1. Search for the interaction whose tag you want to remove.
2. Select the interaction.

3. Select the More menu in the media player and click Tag.... The Tag Interaction window appears.
4. In the Tag Interaction window, clear the checkbox associated with the tag you want to remove from

the interaction and click Confirm. The tag is removed from the selected interaction.
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Working with interactions
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• Administrator

Use the interaction transcript to gain insight about specific characteristics associated with the
interaction.

Related documentation:
•
•

Interactions provide important insights into agent/customer communication. Such insights ultimately
suggest how agent/customer communication might be improved to effect better interaction
outcomes. With interaction transcripts, visualization of who spoke what word, pinpointing related
words, and the ability to leave comments, Interactions provide information that might otherwise be
overlooked.

Interaction transcript

If Speech Analytics is enabled, interaction transcripts are available.

When working with transcripts you can:

• View an interaction's transcript
• Search an interaction's transcript
• View the words spoken during the interaction
• View Events found in the interaction
• View comments that you and other users added to the interaction
• View related words for a selected term
• View who is talking during the interaction

View an interaction's transcript

1. Select Explore > Search.
2. Playback an interaction.

3. Click the Transcript icon to view the interaction transcript.
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Search an interaction's transcript

1. Select Explore > Search.
2. Playback an interaction.

3. Click the Transcript icon to view the interaction transcript.

4. In the top right corner of the transcript click the Search icon and in
the field that appears type the letter, word, and/or phrase you are searching for. The specific letter,
word and/or phrase will be highlighted in the transcript if found.

View the spoken word within the transcript

• When you play back an interaction, the current playback location in the transcript is indicated by a line
beneath the word being spoken.

• Once a word is played back, its color changes from gray to black and the typeface of the text reflects
the confidence of the transcription: the darker the text, the higher its accuracy.

View an interaction's events

• The locations of Events are indicated in the transcript by numbered Event icons .
• To view an event, refer to the right side of the Transcript page. The right side of the Transcript page

contains a list of all the comments and events in the interaction.
• The numbers match the event numbers that appear in the Events list on the right side of the page.

For details, see Interaction events.

Edit, show or hide comments added by SpeechMiner users
View a comment:

• Hover over the Comments icon . A tip appears with the comment.
• Refer to the right side of the Transcript page. The right side of the Transcript page contains a list of all

the comments and events in the interaction.

Edit a comment:

• Click the Comment icon. An Edit Comment window opens.

For details, see Interaction comments.
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View related words for a selected term

1. Place your mouse cursor on the term/phrase and double-click. A pop-up menu appears.
2. Select Related Words. The related words results are opened in a new window.

For details, see Related words.

View who is talking (agent or customer)

• When your system employs multiple audio channels, the speakers are identified in the transcript and
the transcript includes information about when the agent is talking and when the customer is talking.

If your system employs multiple audio channels, the speakers are identified in the transcript, and the
text is color-coded to match the speakers.

Export interaction's transcript
Transcripts of every interaction is now stored in the database and a database job exports the
transcript data of all interactions. The job exports data every day, containing transcripts of
interactions processed per day.

Data exported to blob will be in the following format:

TRANSCRIPT_EXPORT_YYYY_MM_DD_HH_MM.tgz

This file contains transcript data of the interactions corresponding to the previous date mentioned in
the folder name.

Follow these steps to fetch the transcript data from blob:

1. Extract the TRANSCRIPT_EXPORT_YYYY_MM_DD_HH_MM.tgz file. It contains multiple
TRANSCRIPT_EXPORT_N_DATEFORMAT.tgz files. Each
TRANSCRIPT_EXPORT_N_DATEFORMAT.tgz file will be in an encrypted format.

2. Decrypt each TRANSCRIPT_EXPORT_N_DATEFORMAT.tgz file.
3. Extract the decrypted TRANSCRIPT_EXPORT_N_DATEFORMAT.tgz to fetch the transcript data of the

individual interactions. Each TRANSCRIPT_EXPORT_N_DATEFORMAT.tgz file can contain transcript
data for up to 10000 interactions.

Interaction comments

Comments enable you to add a remark about a thought you have regarding a specific interaction.

A comment can be added:

• At a specific time above the audio wave. When a comment is associated with a specific time in the
interaction, it also appears in the transcript at the same time.

• In the transcript alone. When a comment is specifically added to the transcript, it is not associated with
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a specific time in the interaction.

Important
Comments include a timestamp of the time and date the comment was made/last
edited.

Interaction comments enable you to:

• View a comment(s).
• Search for a comment.
• Add a comment to an audio interaction.
• Add a comment to a text interaction.
• Edit an existing comment.

There are three types of comments:

• Good : Indicates a positive comment.

• Bad : Indicates a negative comment.

• Neutral : Indicates an unbiased comment.

View a comment in an interaction

1. Hover over the comment in the Media Player or the transcript . The comment appears in a pop up
window.

Search for a comment in an interaction

1. Select Explore > Search.
2. Play back the interaction in which you want to view a comment.

3. Click the Transcript icon to view the interaction transcript.
4. Type a word in the Search field above the Comments and Events list in the right side of the screen.

The list is filtered according to what you typed in the field.

Add a comment to an audio interaction

1. Select Explore > Search.

Working with interactions

Genesys Recording, Quality Management, and Speech Analytics User's Guide 110



2. Play back the interaction to which you want to add a comment.

3. Click the Add Comment icon above the Comments and Events list.
4. In the Time field, set a time to add the comment at a specific time during the interaction.

Important
The time in the Time field is automatically set to the time associated with the location of the cursor on
the audio graph.

5. Enter your comment in the field provided.
6. Select one of the following:

• Good : Indicates a positive comment.

• Bad : Indicates a negative comment.

• Neutral : Indicates an unbiased comment.

7. Click Add to add the comment to the interaction.

Important
You can also add a comment from within the transcript itself. Double-click the term(s)
to which you want to add the comment and click the Add Comment icon in the tool
tip that appears. To add the comment, follow the steps described in this section.

Add a comment to a text interaction

1. Select Explore > Search.
2. Click the Play icon next to the interaction to which you want to add the comment.

3. Click the Add Comment icon above the Comments and Events list.
4. Enter your comment in the field provided.
5. Select one of the following:

• Good : Indicates a positive comment.

• Bad : Indicates a negative comment.

• Neutral : Indicates an unbiased comment.

6. Click Add to add the comment to the interaction.
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Important
When adding a comment to a Chat interaction, you can add the comment from within
the transcript itself to a specific time. Double-click the term(s) to which you want to
add the comment and click the Add Comment icon in the tool tip that appears. To
add the comment, enter your comment and time in the Enter Comment and Time
fields and click Add. The comment is added in-line.

Edit an existing comment

1. Click the comment icon associated with the comment you want to edit either from the Media Player or
from the transcript.

2. Modify the comment as required.
3. If necessary change the comments sentiment (good, bad, neutral).
4. Click Apply to modify the comment. The comment is added in-line.

Interaction events

An event occurs when Speech Analytics identifies a topic in an interaction. A topic is a collection of
phrases that Speech Analytics looks for when analyzing interactions. For example, if the "can offer
you a loan" phrase associated with the Loan Offer topic is identified, the start of the event is "can"
and the end of the event is "loan".

Speech Analytics can also identify non-linguistic events. Non-linguistic events are sounds other than
speech (for example, a dial tone, silence, music or noise, key press, and so on).

An event (both linguistic and non-linguistic) is indicated by a numbered icon . Event icons and
information about each event appear above the Media Player audio graph and in the Interaction
transcript. For more information see Interaction transcript and What is an interaction?. You can view
details about each event by placing your mouse over the event icon. In addition, each event has a
start time, end time, a name and a type.

With SpeechMiner UI you can:

• View an event
• Search for an event
• Non-Linguistic Identification
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Non-Linguistic Identification
Non-Linguistic Identification identifies the non-verbal parts of an interaction. For example, silence,
busy signal, key presses and caller agitation (tone).

SpeechMiner UI is instructed to automatically identify the following non-linguistic events:

• Music - Indicates when music is being played during the interaction. Music generally indicates
that the interaction was on hold.

• Cross Talk - Indicates when two or more people are talking at the same time.

• Silence - Indicates when there is nothing being said or played. SpeechMiner UI will automatically
skip over these silences when the interaction is played back.

• DTMF - Key press on a touch-tone phone. 12 different keys can be identified using DTMF (Dual
Tone Multi Frequency).

• Agent Busy - A busy signal.

• Agent Unknown - A dial tone.

• Ringback - A signal used in PSTN (Public Switched Telephone Networks - standard "land lines") to
indicate that the line is being called or an incoming interaction is present.

• After call work - Indicates the section of the recording that takes place after the interaction has
ended.

View an event in an interaction
Hover over the event in the Media Player or the transcript. The event details appear in a pop up
window.

Search for an event in an interaction

1. Select Explore > Search.
2. Play back the interaction.

3. Click the Transcript icon to view the interaction transcript.
4. Type a word in the Search field above the Comments and Events list in the right side of the screen.

The list is filtered according to what you typed in the field.
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Interaction attributes

The Interaction Attributes panel enables you to view characteristics about the interactions in the
Search Results grid.

In addition, you can use the Interaction Attributes Panel to assign manual Categories to the selected
interaction.

Click the Interaction Attributes icon in the Search Results grid to view following information:

• Interaction processing time: Indicates the date and time the interaction was processed in the
system.

• Work groups: Indicates the groups associated with the agent(s) that participated in the interaction.
• Agents: Indicates the agent(s) that participated in the interaction.
• Metadata values: Indicates the metadata values associated with the interaction.
• Tags: Indicates the tags associated with the interaction.
• Manually assigned categories: Enables you to manually associate one or more categories with the

specific interaction.
• Automatically assigned categories: Indicates the categories associated with the interaction.
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• Administrator

Use Reports to create a summary and analyses of interaction, speech, and external metadata. This
page describes how to set up and generate reports and what you can do with them.

Related documentation:
•
•

You can generate reports for analysis, view report details and status, and share the data with users
throughout the enterprise. You can view reports in your browser, print them or send them via email.

To help you monitor your business, SpeechMiner offers a wide range of standard reports that can be
customized to better suit your needs.

Depending on the type of report, the results may be presented as lists or data and/or in graphic form.

In this section you will learn how to:

• Create and run a report - To review and analyze interaction, speech and external metadata.
• Edit saved reports - To modify the report data to suit your needs.
• Work with saved reports - To periodically view data for business issues that may reoccur.
• Understand report layouts and parameters - To better absorb the report information.

Reports menu

The Reports menu includes the following items:

• Templates - Enables you to select to create a report from a wide variety of report templates.
• Saved Reports - Enables you to run the same report numerous times on different dates and times
• Edit Report - Enables you to change an existing report.

Create a new report

New reports are based on an existing template.

1. Select Reports > Templates.
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2. Decide which report template will act as the basis of your new report.
3. Click the Preview link to see an example of the report template.
4. Click the Edit link associated with the template on which you want to base your new report. The Edit

Report tab is opened. The name of the selected template appears in the Template list.

Important
You can change the template by selecting a different template from the Template list.

5. Configure the report as necessary using the available parameters at the top of the screen and under
Interactions Filter on the left side of the screen. For additional information about each parameter
refer to Report parameters.

Important
Not all templates include Interactions Filter on the left side of the screen.

6. Click Run Report. The report appears at the bottom of the screen under that report parameters.

7. Optional: Click Save to save the report. You do not have to save a report to run it.
To create a report based on a saved report click Save As .

Link to video

Edit an existing report

After a report is created you can change its properties.

1. Select Reports > Saved Reports. The Saved Reports tab is opened.

2. Click the Edit icon . The Edit Report tab is opened.
3. Configure the report as necessary using the available parameters at the top of the screen and under

Interactions Filter on the left side of the screen. For additional information about each parameter,
refer to Report parameters.

4. Click Save to save your changes to the existing report. If you are creating a report based on a saved
report, click Save As .

5. Click Run Report. The report appears at the bottom of the screen under the report parameters.
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Important
Not all templates include an Interaction filter on the left side of the screen.

Control the data set for analysis

Report templates that include the Agents Data Set filter can be configured to analyze data for the
current user or work group, rather than a specific user or work group.

When the report runs, the data set used changes depending on which user runs it. For example, if the
user is agent 12, the report will only include interactions that were handled by agent 12.

This feature will work only if the user's profile includes mapping. For instance:

• If the user is an agent, the mapping gives the name of the agent. The reports that are filtered for the
current user only include data about that agent.

• If the user is a manager, the mapping gives the name of the manager's work group. The reports that are
filtered for the current user include data for the entire work group.

Configure a report to analyze data for the current user

1. Select Reports > Saved Reports.

2. Click the Edit icon for the report you would like to edit for the current user. The report is opened.
3. Under Interactions Filter, select the current user from the Agents list and click Add.
4. Click Done. Once the report is configured, different users can create the report to analyze their own

data and the report can be shared with other users.

Run a report

You can run a report in a number of ways:

• Run the report and view the results in the browser
• Run the report from the Edit Report tab
• Run the report and send the results as an email attachment to selected recipients
• Run the report and export the results using a PDF or Excel file
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Important
You do not have to save a report to run it.

Run the report and view the results in the browser

1. Select Reports > Saved Reports to run an existing report.

2. From the Saved Reports list click Run . The report results are displayed as you requested in the
SpeechMiner Report Viewer window.

Run a report from the Edit Report tab

1. Select Reports > Saved Reports to run an existing report.

2. From the Saved Reports list, click the Edit icon . The Edit Report tab is opened.
3. Select how to view the report results in the browser:

• To view the results in a new browser window, at the top of the form select Open in new window.
• To view the results below the template form, clear the Open in new window check box.

4. Click . The report results are displayed.

Run the report and send the results via email

Important
The results are sent as a PDF file. The .pdf file is opened in a browser and is linked to
the SpeechMiner system.

1. Select Reports > Saved Reports to run an existing report.
2. From the Saved Reports list, select the report you want to run. From Edit Report configure the report

you want to run.

3. At the top of the form, click Email Report . A dialog box opens.
4. Under To enter the required email addresses. Separate multiple addresses with semi-colons (;).
5. Under Notes type any text you want to include in the body of the email.
6. Click Send. The report runs and the results are sent to the recipients you specified. A confirmation

message appears when the results are sent.
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Run the report and export the results

1. Select Reports > Saved Reports to run an existing report.
2. From the Saved Reports list, select the report you want to run. From Edit Report configure the report

you want to run.

3. At the top of the form, click . The report is created and appears at the bottom of the
screen.

4. Click either the PDF or Excel icon to export the results to a PDF or Excel file. A dialog box opens and
asks you if you want to open or save the file.

5. Select the desired option.
• If you select Open, the file is opened in the application that is configured to open files of the

selected type on your computer.
• If you select Save, a Save As a dialog box opens. Navigate to the folder in which you want to save

the file and click Save. The file is saved in the selected location.

Schedule a report

You can schedule a report to run automatically at specified times or in response to specific events.
The results are automatically sent via email to the recipients.

The type of report schedule is indicated in the Schedule column.

• Deactivated - The report is not scheduled to run.
• Time Based - The report runs automatically at specific times.
• Event Based - The report runs automatically when specific events are detected.

Important
You can create or modify the report schedules only for the reports you created. The
report database is configured according to UTC time. For this reason, reports are
exported and emailed according to UTC time.

The report scheduling feature enables you to:

• Create a report schedule for a specific report.
• Create a report schedule for a group of reports.
• Send the report to specific recipients.
• Schedule a report to run when an event is detected.
• Deactivate a report schedule.
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Create a report schedule for a specific report

1. Select Reports > Saved Reports.
2. Select the report you want to run according to a specific schedule.

3. Click the Schedule icon .
4. Click Active and select the Schedule tab.
5. From the Schedule Type list select Time Based.
6. From the Date Range fields select the start and end of the schedule.
7. Select the period of time for the scheduled report. For example, if you want to run the report every

weekday, select week. If you want to run the report on specific days select Day and then the specific
days. The parameters that appear on the right side of the window change according to your time period
selection

8. Select the Recipient tab and configure the available parameters.
9. Click Schedule. The report is scheduled to automatically run according to the settings you configured.

Create a report schedule for a group of reports

1. Select Reports > Saved Reports.
2. Select the group of reports you want to run according to a specific schedule.

3. Click the Schedule icon .
4. Click Active and select the Schedule tab.
5. From the Schedule Type list select Time Based.
6. From the Date Range fields select the start and end of the schedule.
7. Select the period of time for the scheduled report. For example, if you want to run the report every

weekday, select week. If you want to run the report on specific days, select Day and then the specific
days. The parameters that appear on the right side of the window change according to the selected
time period.

8. Select the Recipient tab and configure the available parameters.
9. Click Schedule. The report is scheduled to automatically run according to the settings you configured.

Send the report to specific recipients
Regardless of the schedule type selected, you must specify one or more recipients for the report.

1. Select Reports > Saved Reports.
2. Select the group of reports you want to run according to a specific schedule.

3. Click the Schedule icon .
4. Select the Recipients tab and configure the fields as follows:

• To - The email addresses of the report recipients. Separate multiple addresses with semi-colons (;).
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• Reply To - The sender's address.
• Subject - The text that should appear in the subject line of the email.
• Report Format - Select Web archive to create the results in an MHT file that can be opened in

Internet Explorer. Or, select PDF to create the results in a PDF file.

Important
If the Schedule Report does not produce expected results refer to the Configuring the Reporting Services
in the Administration Guide.

5. Priority - Select the desired priority level for the email message.
6. Click Schedule. The reports are scheduled as specified in the Schedule tab and the recipients are set as

specified in the Recipients tab.

Schedule a report to run when an event is detected
Event-based scheduling enables you to keep track of potentially significant trends. It also enables you
to be alerted when significant changes in agent or customer behavior occur. In this context, the term
event does not refer to an individual occurrence of an event, but to a specified number or percentage
of interactions in which the event was detected. For example, the detection of caller agitation in more
than 10% of interactions could be an event that causes a report to be generated.

1. Select Reports > Saved Reports.
2. Select the report(s) you want to schedule.

3. Click the Schedule icon .
4. At the top of the scheduling dialog box, select Active.
5. From the ScheduleType list select EventBased. The fields required to configure the schedule are

displayed
6. In the Condition line, under Categories select the categories that must be identified in the

interactions. For additional information, see Search Filter.
7. In the next field, select one of the following:

• Exceeds (>) - Run the selected reports when the selected categories are identified in more than a
specified number or percentage of interactions.

• Equals (=) - Run the selected reports when the selected categories are identified in a specified
number or percentage of interactions.

• Drops Below ( - Run the selected reports when the selected categories are identified in
fewer than a specified number or percentage of interactions.

8. Under Values, fill in the number or percentage of interactions.
9. In the next field, select Interactions if the value refers to a number of interactions or % of

interactions if the value refers to a percentage of interactions
10. Under Duration, fill in the number of time periods (of the unit specified in the next field) in which the

condition must be met. For example, type 2 if the condition must be met within a 2-day period and
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select Days in the next field.
11. Select the unit of time for the duration value you entered in the previous field.
12. Configure the Recipients tab and save the settings.

Deactivate a report schedule

1. Select Reports > Saved Reports.
2. Select the report(s) for which you want to deactivate the schedule.

3. Click the Schedule icon .
4. At the top of the scheduling dialog box, clear the Active check box.

Important
If you selected a group of saved reports before you opened the Scheduling window, the Active check box
is not selected.

5. Click the Schedule checkbox.

Drill down a report

Depending on the type of report, the report results may be in the form of a graph, a histogram, or a
table.

You can drill down to the underlying data on which any graphic component is based (graph bars,
lines, or table headers).

When you do this, you will be presented with a new report that is based on the data point you clicked
on.

Drill down to the underlying data of a report component

• Click the component.

Play back an interaction from a drill-down list

• Under Open, click the icon. The Media Player opens in a new browser window and begins to play back
the interaction.

Close the drill-down list and return to the report results

• If the report was displayed in the Edit Report tab click Back at the bottom of the form.
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• If the report was opened in a separate window or tab, use the browser's Back button or press
Backspace.

Sort the data in a table

• Click the heading of the column by which you want to sort the table.

Analyze Report Data

Report templates that include the Agents Data Set filter can be configured to analyze data for the
current user or work group, rather than a specific user or work group.

When the report runs, the data set used changes depending on which user runs it. For example, if the
user is agent 12, the report will only include interactions that were handled by agent 12.

This feature will only work if the user's profile includes mapping. For instance:

• If the user is an agent, the mapping gives the name of the agent. The reports that are filtered for the
current user only include data about that agent.

• If the user is a manager, the mapping gives the name of the manager's work group. The reports that are
filtered for the current user include data for the entire work group.

To configure a report to analyze data for the current user:

1. Select Reports > Saved Reports.
2. Click the pencil Edit icon for the report you would like to edit for the current user. The reports opens in

the Edit Report.
3. Under Interactions Filter, select the current user from the Agents list and click Add.
4. Click Done. Once the report is configured, different users can create the report to analyze their own

data and the report can be shared with other users.
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Working with saved reports

Contents

• 1 Column information
• 2 Filter the Saved Reports list
• 3 Drill down and view additional details about the report
• 4 Delete a saved report
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•

• Administrator

Use a saved report to view specific information on demand or according to a schedule. Saved
reports enable you to periodically view data for business issues that may reoccur.

Related documentation:
•
•

A saved report is a customized report template that you can run as often as you need. You can run
the saved report on demand or according to a schedule.

Important
The System Alert report is automatically generated and saved by the system. For
additional information, see Alerts.

From the Saved Reports grid you can:

• Collect information about a report from the information in the list columns.
• Filter the Saved Reports list.
• Drill down to view additional details about the specific report.
• Delete a saved report.

Column information
Column Description

Run Click the Run icon to run the report and display the results in a new window.
Edit

Click the Edit icon to open the report in the Edit Report tab where you can
change the parameters and settings.

Delete Click the Delete icon to delete the selected report.
Name The saved report name.
Template The template on which the report is based.
Created By The name of the user who created the report.
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Column Description
Sharing A black Sharing icon marks reports that you created.

A faded Sharing icon marks reports that other users created and shared with you.
The names of the groups and users that share the report appear in the table beside the Sharing icon.
Click the Sharing icon to open a dialog box in which you can select the groups and individual users with
whom you want to share the report. The members of the selected groups and selected users will see the
report listed in their Saved Reports tab.

Note: You can only edit reports that you created. If you want to edit a report that you did not create you
must first save the report under a new name.

Schedule Indicates whether the report is scheduled to run at a specific date and time.

Click the Schedule icon to activate, deactivate, create or modify the report's schedule.

Last Modified The date on which the report was last edited and saved.

Permalink Click Copy to create a Permalink to the specific report.

Filter the Saved Reports list

Use the filter options to limit the saved reports that are displayed in the list to those that meet
specific criteria.

The following filter controls are located in the top right corner of the list:

Filter Description
Delete Click the Delete icon to delete the selected report.
Name Enter a sequence of characters.

Only the saved reports whose name contains the letters you entered are displayed.

Template Select the report template to include in the list and click Done to activate the filter.
Only the saved reports based on the template(s) you selected are displayed.

Created By Select the users to include in the list and click Done to activate the filter.
Only the saved reports that were created by the selected user(s) are displayed.

Sharing Select My Reports to display only those reports that you created or Shared Reports
to display only those reports that were created by other users and shared with you.
Click Done to activate the filter.

Drill down and view additional details about the report

1. Create a new report or open a saved report.

Working with saved reports

Genesys Recording, Quality Management, and Speech Analytics User's Guide 127

/File:Smicon_delete.png
/File:Smicon_delete.png


2. Run the report. The report is opened in the SpeechMiner Report Viewer.
3. Click a graphic component in the report to drill down to the underlying data represented by the graphic

component.

Delete a saved report

1. Select Reports > Saved Reports.
2. Select the report or reports you want to delete.

3. Click the Delete icon .
4. Click Yes. The report is deleted.
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Report templates

Contents

• 1 Available reports
• 1.1 Recording
• 1.2 Quality Management (QM)
• 1.3 Speech Analytics

• 2 Before you begin
• 3 Report template layout

• 3.1 First row
• 3.2 Second row
• 3.3 Third row
• 3.4 Data Set filters

• 4 Report parameters
• 4.1 Template
• 4.2 Report Name
• 4.3 Report Title
• 4.4 Description
• 4.5 Version
• 4.6 Data Set Filters
• 4.7 Items
• 4.8 Agents
• 4.9 Categories
• 4.10 Data Type or Compare
• 4.11 Period Type or Period
• 4.12 Top or Display
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•

• Administrator

Use the approximately 28 Report templates to view details about specific aspects of your
organization. The variety of reports and the drill-down options within each one enable you to
investigate a wide range of topics.

Related documentation:
•
•

SpeechMiner UI reports are interactive. That is, you can drill down within the report to view additional
details about any graphic component (for example, graph bars, line or table headers), by simply
clicking the component. In addition, you can play an interaction directly from the Interaction list in
the generated report.

Available reports
The following templates for SpeechMiner UI reports are available. For additional information, see
Report parameters.

Recording

• Agent Comparison
• Interactions
• Metadata Frequency
• Usage Tracking

Quality Management (QM)

• Agent Evaluation Comparison
• Auto Fail
• Calibration Score
• Evaluation Summary
• Evaluator Evaluation Comparison
• Interaction Evaluation Summary
• Team Comparison
• Team Evaluation Comparison
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Speech Analytics

• Agent Bubble Chart
• Agent Trend
• Category Bubble Chart
• Category Distribution
• Category Trend
• Performance Profile
• Top and Bottom Performers

Before you begin
Before you begin working with reports consider the following:

• Some reports offer options not included in the remaining reports. When a report contains additional
options, they will be described in an Actions section in the report description.

• Some reports have a number of available versions (for example, Full and Wide). Use the Version
parameter to select the desired version.

• The information visible in the reports you create is limited to the data to which you have access.
• Some reports may not be available to all users.
• You may have access to reports that were not documented, because they were custom-made for your

organization.

Report template layout

The SpeechMiner report template has a maximum of three parameter rows. Each row deals with
different functions in the report. See the descriptions of the first row, second row, and third row,
below.

In addition, most report templates have a Data Set filters section on the left side of the screen.

This page explains the general report template layout using the Agent Comparison template as an
example. The Agent Comparison report represents the most common template layout.

First row
The first row contains:

• Controls for working with report results (see Create a new report)
• Template field, in which you can select the type of report
• Report Name field, used to name the report
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Second row
The second row contains fields for defining the report title and an optional report description. These
items are displayed at the top of the report results. By default, the name of the report template is
used as the report title and you can modify it as necessary. Some templates also have a Version
parameter in this row. The Version parameter can be used to select the size or format of the report
output.

Third row
The third row contains the Items on Report parameters. That is, the fields that determine which items
will appear graphically on the report. In some reports, one or more of the parameters may also have
statistical functions.

Data Set filters
The left side of numerous report templates contains Data Set filters. These filters specify which data
will be included in the report's analyses.

For additional information about the filters and how to configure them, see Report parameters. The
current filter settings are displayed on the right side of the template below the first row.

Report parameters

Most report parameters have the same function no matter which template you use. Exceptions are
briefly explained in this section, and dealt with in detail in the documentation on individual reports, in
the Templates section.

The following parameters are the most common:

• Template
• Report Name
• Report Title
• Description

• Version
• Data Set Filters
• Items on Report
• Agents

• Categories
• Data Type or Compare
• Period Type or Period
• Top or Display

Template
From the Template list, you can choose or switch to any of the available report templates.

Report Name
Text entered in this field will be used as a file name for the report, if you choose to save the report.
This name will appear under the Saved Reports tab for future access.
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Report Title
Text entered in this field will be displayed in large, bold type at the top of the report results. The
report title is optional. The name of the report template appears in this field by default, but can be
modified or deleted.

Description
Text entered in this field will be displayed in fine print directly below the Report Title in the report
results. The description is optional.

Version
The output of some reports can be generated in different versions and different sizes or formats.

In this field, select the desired output version from the drop down list.

The available options vary depending on the template.

Depending on your permissions, the following Version options may be available:

• Full Report - a full-size report output optimized for printing (either 11" wide x 8.5" high, or 8.5" wide by
11" high, depending on the template).

Full reports often contain two parts: a graph or chart followed by a summary table which may also
contain additional details.

In some cases, when a Full report contains items that can be expanded to display more details, the
version has two options, Expanded and Collapsed.

When Full Report (Expanded) is selected, all items are initially expanded when the report is
displayed.

When Full Report (Collapsed) is selected, all items are initially collapsed.

• Mini - a small output for display in the Dashboard view (480px wide x 288px high).
• Wide - a wide-width output for display in the wider columns of the Dashboard view (768px wide x

288px high).
• Table Only - a full-size report output that only includes the summary table. Graphs and diagrams are

not printed (either 11" wide x 8.5" high, or 8.5" wide by 11" high, depending on the template).
• X-Axis Only - a bubble chart option. Select this option to specify report output in the form of a table,

with a bar graph representing the x-axis values. No bubble-chart is produced and y-axis values are not
represented (Width: 768px).

• Y-Axis Only - a bubble chart option. Select this option to specify report output in the form of a table,
with a bar graph representing the y-axis values. No bubble-chart is produced, and x-axis values are not
represented (Width: 768px).

Data Set Filters
The Data Set Filter options allow you to narrow down the data from the entire database, so you can
base your report on a subset of the available data.
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All of the Data Set Filters have an "AND" relationship. This means that each filter further restricts the
options available and all interaction events and topics represented in your final data set satisfy all
Data Set Filters.

Should you choose options from two different filters that mutually exclude each other (for example, a
Date metadata entered for April 2015 and a date range between February and March 2014), you will
have zero data in your report.

Important
Parameters that appear under Items on Report (for example, the third row of
parameters) allow you to select specific information from the database selected under
Data Set Filters.

Distributional information presented in the report is calculated for the items selected under Items on
Report,and is built upon the base of data that is selected using the Data Set Filters. The Data Set
Filters appear in the Filter Panel on the left side of the report template for all reports that support
them. The filters are divided into groups. The basic filters appear at the top of the Filter Panel and are
always displayed when the panel is displayed. The remaining filter groups can be expanded or
collapsed.

The following filter groups are available:

Basic filters

Enables you to filter for interaction types, languages and date range.

Important
A day begins at 0:00 and ends at 23:59.

To Date date filters (All, Today, Week to Date, Last 7 Days, Month to Date. Last Month, Quarter to
Date, Last 90 Days) include the interactions collected in the system up until the exact time and date
the report is generated.

The times given are for the time zone where your Web server is deployed, and therefore are not
necessarily the same as the times where you are physically located.

SpeechMiner

Enables you to filter for interaction categories, programs and the topics.

For each option, select one or more values. Only interactions in which at least one of the selected
values for each option was identified are included in the data set. For example, if you select three
categories and two programs, only interactions belonging to at least one of the categories and one of
the programs are included.

You can add lines to the categories and topics. The logical relationship between each line is AND. For
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example, if one line under Categories specifies one category and another line specifies another
category, an interaction must be in both categories to be included.

To add a line, click .

To create a negative filter, click the Not button beside the field. For example, to include all
categories except Category A, select Category A and select the Not button beside the Category
field.

For additional information about each option, see Search filter.

Metadata

Enables you to filter according to metadata values.

Metadata is collected by the recording system and is relayed to SpeechMiner.

The types of available metadata vary from system to system. You can select any type of metadata
available in your system and, if you wish, you can specify a value for it.

The search results will only include interactions for which the selected type of metadata has an
automatic or manually defined value.

User Actions

Enables you to filter interactions according to:

• Specific user comments added to the interaction.
• Interactions that were played back.
• Forms that were filled out.
• Whether or not quality checking was performed.

Under Interaction Comment Text, specify the text that must appear in a comment that was added
to an interaction. In the other fields, select the users who must have performed the specified actions.

Items
The parameters in this section allow you to select specific information and calculate distributional
information on the data in the data set that was selected using the Data Set Filters.

If you make no selections under Items on Report, default values will determine how the data will
appear in the report.

Since the parameters in Items on Report differ from report to report, this section explains only the
most common ones listed alphabetically. Less common parameters are explained in their respective
templates.

Report templates

Genesys Recording, Quality Management, and Speech Analytics User's Guide 135



Agents
You can select the specific agents or work groups to be analyzed and displayed in your report. The
default value (Any) includes all agents.

If your Data Set Filters are not set to Any, your selections for Agents must match your selections in
the Data Set Filters (for example, the same work groups or agents, belonging to the same interaction
types). In other words, the report output will only include agents who were selected here and who
were not excluded from the data set in the Data Set Filters.

Categories
You can select specific interaction categories to limit the data set analyzed for your report. Your data
set will include interactions belonging to any of the categories selected.

Use the default value (Any) to include all available categories.

Important
If a single interaction belongs to multiple categories it will be counted as one
interaction for each category selected under this parameter.

Also, bear in mind that the report output will only include interactions in categories that were
selected from the Categories list and were not excluded from the data set in the Data Set Filters.

If you selected specific categories in the Data Set Filters section, only categories that are selected
from both the Categories list and the Data Set Filters will appear.

When used with Percentage of Interactions in the Data Type parameter, the report will display the
ratio of the following as a percentage:

{the number of interactions from the selected Categories in Items on Report} over {the number of
interactions from the Categories selected for analysis in Data Set Filters}

Important
If one or more interactions belong to multiple categories, the sum of the percentages
of interactions for all categories may add up to more than 100%.

Data Type or Compare
You can specify the type of data you wish to display in your report.

The most common choices are:

• Number of Interactions - Displays the number of interactions per each report item. Data may vary
depending on the other filters selected.
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• Percentage of Interactions - Displays the percentage of interactions per report item in your data set.
• Average Interaction Duration - Displays the average length, in minutes, of all interactions for each

report item. The entire conversation for the interaction recording session is considered, excluding the
wrap time after the interaction.

• Total Resources - Displays the total amount of time, in hours, of all the interactions per report item. It
is essentially the sum of all interaction durations.

Period Type or Period
This parameter is most commonly seen on reports that show trends. The output of the report will be
displayed in increments of the selected Period Type. For each increment, the value of the selected
Data Type will be displayed for each particular report item. For example, if the Data Type is "Number
of Interactions" and the Period Type is "Day," the number of interactions for each day in the date
range included in the report will be shown.

Top or Display
In this parameter, you can choose how many of the highest or lowest values are displayed on the
report. The options may include 5, 10, 15, 20, All, All Sorted, and All Unsorted.
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Available report templates

Contents

• 1 Agent Bubble Chart
• 1.1 Common usages
• 1.2 Customizing the report
• 1.3 Actions

• 2 Agent Comparison
• 2.1 Common usages
• 2.2 Customizing the report
• 2.3 Actions

• 3 Agent Evaluation Comparison
• 3.1 Common usages
• 3.2 Customizing the report
• 3.3 Actions

• 4 Agent Trend
• 4.1 Common usages
• 4.2 Customizing the report
• 4.3 Actions

• 5 Auto Fail
• 5.1 Common usages
• 5.2 Customizing the report
• 5.3 Actions

• 6 Calibration Score
• 6.1 Common usages
• 6.2 Customizing the report
• 6.3 Actions

• 7 Category Bubble Chart
• 7.1 Common usages
• 7.2 Customizing the report
• 7.3 Actions
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• 8 Category Distribution
• 8.1 Common usages
• 8.2 Customizing the report
• 8.3 Actions

• 9 Category Trend
• 9.1 Common usages
• 9.2 Customizing the report
• 9.3 Actions

• 10 Evaluation Summary
• 10.1 Common usages
• 10.2 Customizing the report

• 11 Evaluator Evaluation Comparison
• 11.1 Common usages
• 11.2 Customizing the report
• 11.3 Actions

• 12 Interaction Evaluation Summary
• 12.1 Common usages
• 12.2 Customizing the report

• 13 Interactions
• 13.1 Common usages
• 13.2 Customizing the report
• 13.3 Actions

• 14 Metadata Frequency
• 14.1 Common usages
• 14.2 Customizing the report
• 14.3 Actions

• 15 Performance Profile
• 15.1 Common usages
• 15.2 Customizing the report
• 15.3 Actions

• 16 Team Comparison
• 16.1 Common usages
• 16.2 Customizing the report
• 16.3 Actions
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• 17 Team Evaluation Comparison
• 17.1 Common usages
• 17.2 Customizing the report
• 17.3 Actions

• 18 Top and Bottom Performers
• 18.1 Common usages
• 18.2 Customizing the report
• 18.3 Actions

• 19 Usage Tracking
• 19.1 Common usages
• 19.2 Customizing the report
• 19.3 Actions
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•

• Administrator

Use this page to learn about all the report templates that are available for the SpeechMiner UI.
Reports allow you to drill down within the report to view additional details about any graphic
component (for example, graph bars, line or table headers), by simply clicking the component.

Related documentation:
•
•

The following templates for SpeechMiner UI reports are available. For ease of reference, this page
presents the report templates in alphabetical order. See the Report templates page for lists of the
same report templates grouped by area of focus (Recording, Quality Management, or Speech
Analytics).

• Agent Bubble Chart
• Agent Comparison
• Agent Evaluation Comparison
• Agent Trend
• Auto Fail
• Calibration Score
• Category Bubble Chart
• Category Distribution
• Category Trend
• Evaluation Summary

• Evaluator Evaluation Comparison
• Interaction Evaluation Summary
• Interactions
• Metadata Frequency
• Performance Profile
• Team Comparison
• Team Evaluation Comparison
• Top and Bottom Performers
• Usage Tracking

Agent Bubble Chart

The Agent Bubble Chart report compares agents and/or work groups by plotting them on a graph
according to the percentage of interactions in the horizontal (x-axis) and vertical (y-axis) Categories.
Each Agent is represented on the graph by a bubble. The size of each bubble represents the average
interaction duration. The X-Axis Only and Y-Axis Only versions present the data as a histogram
indicating percentage of interactions per agent and/or work group, rather than a bubble chart.
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Common usages

• Plot Agents showing average interaction duration plus two customer-experience categories (for
example, Dissatisfaction and Escalation)

• Plot Agents showing average interaction duration plus two agent-efficiency categories (for example,
Transfer Rate and Hold Rate)

• Plot Agents showing average interaction duration plus two categories that represent metadata (for
example, Customer Satisfaction and Issue Resolution)

Customizing the report

General Settings:

• Version - Available in Full Report (standard size), Mini, Wide, X-Axis Only, and Y-Axis Only versions.

Items on Report:

• X-Axis Categories - Select one or more categories to include in the bubble chart's x-axis.
• Y-Axis Categories - Select one or more Categories to include in the y-axis of the bubble chart.

Important
Only categories that are not excluded from the data set (that is, using the filter on the
right side of the screen), are included in the report.

For additional information, see Report parameters.

Actions

• Click a bubble in a chart, a bar in a graph, or an item in a table to open a list of interactions included in
the item.

• In X-Axis Only and Y-Axis Only versions, click to drill down to a Category Trend report.

Agent Comparison

The Agent Comparison report consists of a bar graph comparing Agents' performance against each
other, as well as against the average value of all the agents that are represented. The numbers in the
table and graph represent an interaction count.

Common usages

• Plot agent performance statistics to see who performs above and below the benchmark (the average of
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a group is determined by the filter selections).
• Drill down on specific agents to play their interactions and find examples about effective agent behavior

or areas that need improvement.
• Utilize the data obtained from the report to identify training needs for effective agent evaluations.

Customizing the report

General Settings:

• Version - Available in Full Report (standard size), Mini, Wide, X-Axis Only, and Y-Axis Only versions.

For additional information, see Report parameters.

Actions

• Click a bar in the graph or an item in a table to open a list of interactions included in the specific item.

Agent Evaluation Comparison

The Agent Evaluation Comparison report summarizes the average evaluation score for select agents.

Common usages

Used to compare agent evaluation scores.

Customizing the report

General Settings:

• Date Range - Enables you to select the period of time on which to base the report.
• Form - Enables you to select the specific form to be analyzed and displayed in the report.

Important
If the Form list does not include the form you want to select, refresh the page.

• Agents - Enables you to select the agents that should be analyzed in the report.
• Show Form - Enables you to view the complete form(s) associated with the specific report. To view the

form you must select an agent.

For additional information, see Report parameters.
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Actions

Click an agent in the Y-axis to drill down and view the form scores associated with the selected agent.

Agent Trend

The Agent Trend report is a line graph that displays agent performance in relation to one or more
selected categories over time. The numbers in the table and graph represent an interaction count.

Common usages

• Use to track an agent's performance progress over time to monitor effectiveness of training programs.
• Use to use the graph to measure and compare performance and provide feedback to the agent.

Customizing the report

General Settings:

• Version - Available in Full Report (standard size), Mini, Wide, X-Axis Only, and Y-Axis Only versions.

For additional information, see Report parameters.

Actions

Click a line in the graph or an item in the table to open the interaction list included in the item.

Auto Fail

The Auto Fail report provides a summary of all the Quality Monitoring evaluation forms that were
designated as auto fail for selected evaluations.

Common usages

Enables you to monitor evaluation with evaluation forms that were designated as auto fail.

Customizing the report

General Settings:

• Evaluation - Enables you to select from a list of evaluations that contain forms that were assigned as
auto fail.

• Form - Enables you to select from a list of forms that were assigned as auto fail.
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• Date Range - Enables you to select the period of time on which to base the report.

Actions

Click a form name to see a list of all the evaluation session that failed due to the auto fail
designation.

From the list that appears, you can click the Agent Name to view the specific form that failed.

Important
If you select a specific form from the Form list at the top of the report, you will
receive the list of the evaluation sessions that failed for the selected form.

Calibration Score

The Calibration Score summarizes all the evaluation sessions for one Calibration Evaluation and
provides a graph that shows the specific Calibration Evaluation form scores.

Common usages

Enables you to create a report that compares two or more evaluators performance.

Customizing the report

General Settings:

• Evaluation - Enables you to select the Calibration Evaluation on which to base the Calibration Score
report.

Important
If the Evaluation list does not include the evaluation you want to select, refresh the
page.

• Baseline Average - Enables you to highlight a score by which evaluators are compared. For example,
if you enter 80% for the Baseline Average you will be able to see who scored about and below 80%.

For additional information, see Report parameters.

Actions

Sort the evaluator names in the Y-axis.
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Category Bubble Chart

The Category Bubble Chart report compares categories by plotting them on a graph according to the
percentage of interactions in the horizontal (x-axis) and vertical (y-axis) categories. Each Bubble
category is represented on the graph by a bubble. The size of each bubble represents the average
interaction duration.

• The x-axis value indicates the percentage of interactions that were in both the Bubble Category and any
of the selected x-axis categories.

• The y-axis value indicates the percentage of interactions that were in both the Bubble Category and any
of the selected y-axis categories.

• The X-Axis Only and Y-Axis Only versions present the data as a bar graph indicating percentage of
interactions per category, rather than a bubble chart.

Common usages

• Plot interaction - Categories show the average interaction duration plus two customer-experience
categories (for example, Dissatisfaction and Escalation).

• Plot interaction - Categories show the average interaction duration plus two agent-efficiency categories
(for example, Transfer Rate and Hold Rate).

• Plot interaction - Categories showing average interaction duration plus two categories that represent
metadata (for example, Customer Satisfaction and Issue Resolution).

Customizing the report

General Settings:

• Version - available in Full Report (standard size), Mini, Wide, X-Axis Only, and Y-Axis Only versions.

Items on Report:

• Bubble Categories - Select the categories to represent as bubbles in the chart.
• X-Axis Categories - Select one or more categories to include in the x-axis of the bubble chart.
• Y-Axis Categories - Select one or more categories to include in the y-axis of the bubble chart.

Important
Only categories that are not excluded from the data set are included in the report.

For additional information, see Report parameters.
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Actions

• Click a bubble in a chart, a bar in a graph, or an item in a table to open the interaction list included in
the item.

• In X-Axis Only and Y-Axis Only versions, click to drill down to a Category Trend report.

Category Distribution

The Category Distribution report is a graph or chart that shows the distribution of interactions by
category for a specified domain. The distribution can be calculated by percentage of interactions or
by percentage of resources (total duration of all interactions included in the analysis).

Common usages

• Plot the proportion of interactions in specified categories to analyze business trends and customer
issues.

• Compare the distribution of multiple categories (such as, interaction or cancellation reasons, product
popularity, or competitor mentions), across your body of interactions.

• Utilize the comparative data obtained from the report to identify the optimal ways to target customer
issues.

Customizing the report

General Settings:

• Version - Available in Full Report (standard size), Mini, Wide, Columns, and Summary versions. Full
Report, Mini, Wide are bar graphs that list the selected categories and showing their proportion in the
data set.

• Columns - A chart that shows the average interaction duration for each category. These values are
displayed above the total number of interactions in the category.

• Summary (Pie) - A pie chart indicating the proportion of interactions or resources in the entire data set
that are associated with the selected categories. You can select to base the calculations on the number
of interactions or on the total resources selected under Distributed By.

Items on Report:

• Distributed By - Select whether the distribution should be calculated based on percentage of
interactions (the total number of interactions) or percentage of resources (the total duration of all
interactions).

For all other parameters, see Report parameters.

Actions

• In Full, Mini, Wide, or Columns versions, click a category or bar to open a list of interactions in the
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category.

• In the Full version, click Trend to drill down to the category's interaction distribution. If the
distribution of the items in the report (see Items on Report above) is the percentage of interactions, the
distribution of interactions is presented according to the percentage of interactions. If the distribution is
the percentage of resources, the distribution of interactions is presented according to the average
interaction duration.

Category Trend

The Category Trend report shows changes in categories over a period of time. The trend line can
represent the number of interactions, percentage of interactions, average interaction duration, or
total resources. There is one line for every category selected.

Common usages

• Plot the trends in a particular category or multiple categories chronologically.
• Identify peak periods to make informed scheduling and staffing decisions.
• Measure the response to new product releases.
• Evaluate the effectiveness of recent business changes and agent training.

Customizing the report

General Settings:

• Version - Available in Full Report (standard size), Mini, Wide, X-Axis Only, and Y-Axis Only versions.

For additional information, see Report parameters.

Actions

Click a point in a graph or an item in a table to open the interaction list included in the item.

Evaluation Summary

The Evaluation Summary report summarizes the evaluation performance of one or more evaluators.
The report is shown in a Doughnut chart.

Common usages

Enables you to monitor evaluator performance.

Available report templates
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Customizing the report

General Settings

• Date Range - Enables you to select the period of time on which to base the report.
• Evaluators - Enables you to select the evaluators whose performance you would like to compare.

For additional information, see Report parameters.

Evaluator Evaluation Comparison

The Evaluator Evaluation Comparison Report summarizes the average evaluation score for selected
evaluators.

Common usages

Enables you to compare evaluator evaluation scores.

Customizing the report

General Settings

• Date Range - Use to select the period of time on which to base the report.
• Form - Use to select the specific form to be analyzed and displayed in your report.

Important
If the Form list does not include the form you want to select refresh the page.

• Evaluators - Use to select the specific evaluators to be analyzed and displayed in your report.

For additional settings, see Report parameters.

Actions

Click an agent in the Y-axis to drill down and view the form scores associated with the selected
evaluator.

Interaction Evaluation Summary

Available report templates
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The Interaction Evaluation Summary report shows the evaluation score for the last evaluation
session, associated with a specific evaluator and interaction.

Common usages

Enables you to monitor evaluation session scores for a specific evaluator.

Customizing the report

General Settings

• Form - Enables you to select the specific form to be analyzed and displayed in the report.

Important
If the Form list does not include the form you want to select, refresh the page.

• Interaction ID - Enables you to select the specific internal interaction ID to be analyzed and displayed
in the report.

• Evaluator - Use to select the specific evaluator to be analyzed and displayed in your report.

For additional information, see Report parameters.

Interactions

The Interactions report provides a list of all interactions that were recorded.

Common usages

• Validate recorded interactions.

Customizing the report

Items on Report

• Metadata Field name - Select the metadata field for which you want to run the report.

Important
The field selected must be within the range selected in the Data Set Filters. If it is not
within the range, the report will be empty.

Available report templates
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• Pattern to Include - Enter a series of one or more characters that must be found in the field value in
order for it to be included in the report (optional; leave the field blank to include all patterns).

• Values to Exclude - Enter one or more field values to exclude from the report. If you enter more than
one value, separate the multiple values with commas and do not leave a space after the comma
(optional; leave the field blank to include all values).

For additional information, see Report parameters.

Actions

• Click a row in the table to listen to the selected interaction.
• Click the metadata summary to see and playback a list of interactions with the same metadata value.

Metadata Frequency

The Metadata Frequency report is a histogram that shows values for a specific metadata field. The
histogram shows how many interactions in the data set are associated with the selected metadata
field. The Metadata Frequency report includes:

• The top of the graph is a summary of the data. It shows how many interactions are associated with each
value and the percentage of all the interactions in the data set that had the values. For example, if the
metadata field "department" is selected, the report shows how many departments (values) were
represented in the data set, and divides the departments into groups based on how many interactions
they had.

• The bottom of the graph provides details for one of the groups in the top level. It lists the values
associated with the number of interactions represented by the group and shows the amount.

• The Wide version of the report includes the most common category associated with the interactions.

Common usages

• Classify and quantify interactions according to a metadata field.
• Utilize the comparative data obtained from the report to identify issues that may require attention.

Customizing the report

General Settings:

• Version - Available in Full Report (standard size), Mini, Wide, X-Axis Only, and Y-Axis Only versions.

Items on Report:

• Metadata Field name - Select the metadata field for which you want to run the report.

Available report templates
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Important
The field selected must be within the range selected in the Data Set Filters. If it is not
within the range, the report will be empty.

• Pattern to Include - Enter a series of one or more characters that must be found in the field value in
order for it to be included in the report (optional; leave the field blank to include all patterns).

• Values to Exclude - Enter one or more field values to exclude from the report. If you enter more than
one value, separate the multiple values with commas and do not leave a space after the comma
(optional; leave the field blank to include all values).

• Minimum Interaction Count - The minimum number of interactions that must be found for a value, in
order for the value to be included in the report.

For additional information, see Report parameters.

Actions

At the top of the graph, click a bar in the graph to drill down to the lower level.

At the bottom of the graph:

• Click a bar in the graph to search for interactions that have the field value represented by the bar.
• Click to drill down to a Category Distribution report.

Performance Profile

The Performance Profile report is a bar graph and table that compares work group or agent
performance for a specified category or a group of categories to the benchmark (the work group or
agent’s average). You can choose to analyze performance based on the number of interactions, the
percentage of interactions, average interaction duration, or total resources. The table includes data
about the number of interactions, the difference from the benchmark, and the percentage above or
below the benchmark.

Common usages

• Visualize and compare agent performance for training and feedback.
• Utilize the data obtained from the report to increase the efficiency of team and operations

management.
• Assess the efficacy of training programs by plotting performance before and after the program’s

implementation.

Customizing the report

General Settings

Available report templates
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• Version - Available in Full Report (standard size), Mini, Wide, X-Axis Only, and Y-Axis Only versions.

Items on Report:

• Profile - Select the agents or work groups you would like to compare to the average (the benchmark) of
specific categories. Your selection must match the Benchmark Type, but it does not have to match the
work group or agent parameters in the Data Set Filters.

• Benchmark Type - Select the type of benchmark to use: Agent or Team (work group). The selection
here must correspond with those in the Data Set Filters. If you selected work groups in the Data Set
Filters (rather than individual agents in the expanded work groups), you must select Team for the
Benchmark Type in order to return results. The Benchmark Type must also match the Profile selected.
That is, if agent is selected as the benchmark type, agents must also be selected in the Profile
parameter.

• Compare - Select the data type you want to compare.
• Categories - Select specific interaction categories to limit the data set analyzed for your report.
• Threshold - Specify the minimum percent deviation from the benchmark required for an item to be

included in the report. For example, "40" means only values that are greater or less than the
benchmark by at least 40% are included in the report.

For additional information, see Report parameters.

Actions

• Click + next to an agent or team to expand the tree and view a list of categories.

• Click + to collapse and expand an item.

• When an item is expanded, click Trend to drill down to a Category Trend report.

Team Comparison

The Team Comparison report is a bar graph that compares performance between teams and against
the average value of all teams represented. The numbers in the table and graph represent an
interaction count.

Common usages

• Analyze the report data to optimize team and operations management.
• Provide clear visual reports for training assessment and feedback.

Customizing the report

General Settings

• Version - Available in Full Report (standard size), Mini, Wide, X-Axis Only, and Y-Axis Only versions.

Available report templates
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Items on Report

• Teams - Select specific work groups to be analyzed and displayed in your report. The default value
("Any") includes all work groups. You must also make the appropriate selections for the work group or
Agent, Language, and Program filters in the Data Set Filters. If you select individual agents instead of
work groups, you must select the team that contains the agents you selected, otherwise results will not
be returned.

• Compare - Select the data type you want to compare.
• Categories - Select specific interaction categories to limit the data set analyzed for your report.

For additional information, see Report parameters.

Actions

Click a bar in the graph to open a list of interactions included in the item.

Team Evaluation Comparison

The Team Evaluation Comparison report summarizes the average evaluation score for the selected
teams.

Common usages

To compare team evaluation scores.

Customizing the report

General Settings

• Date Range - Use to select the period of time on which to base the report.
• Form - Use to select the specific form to be analyzed and displayed in your report.

Important
If the Form list does not include the form you want to select, refresh the page.

• Teams - Use to select the specific teams to be analyzed and displayed in your report.
• Show Form - Enables you to view the complete form(s) associated with the specific report. To view the

form you must select a team.

For all other settings,see Report parameters.

Available report templates
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Actions

Click a team in the Y-axis to drill down and create an Agent Evaluation Comparison report for the
agents in the selected team.

Top and Bottom Performers

The Top and Bottom Performers report is a bar graph that indicates values for three groups (top
performers, bottom performers, and average performers) across multiple categories. Use this report,
to identify what top performers do differently from the rest, and thereby spread the knowledge of
best practices. This report is only useful if you know ahead of time who your top, bottom, and
average agents or teams are. It is purely a graphical representation of a comparison and it will NOT
tell you who the top and bottom agents are. Instead, it will tell you how they compare in specific
areas of performance.

Common usages

• Compare the behavior of top and bottom performers to identify best practices.
• Utilize the data obtained from the report to optimize agent training and improve business processes.

Customizing the report

General Settings

• Version - available in Full Report (standard size), Mini, Wide, X-Axis Only, and Y-Axis Only versions.

Items on Report

• Top Agents - Specify the top agents (based on prior assessment) to be displayed for each category.
The percentage of interactions handled by the selected top agents will be displayed for each category.
Selections here must be the same as those made in the work group and agent filters in the Data Set
Filters.

• Bottom Agents - Specify the bottom agents (based on prior assessment) to be displayed for each
category. The percentage of interactions handled by the selected bottom agents will be displayed for
each category. Selections here must be the same as those made in the work group and agent filters in
the Data Set Filters.

• Average - Specify the average-performing agents (based on prior assessment) to be displayed for each
category. The percentage of interactions handled by the selected average-performing agents will be
displayed for each category. Selections here must be the same as those made in the work group and
agent filters in the Data Set Filters.

• Categories - Select specific interaction categories to limit the data set analyzed for your report.

For additional information, see Report parameters.

Available report templates
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Actions

Click a bar or a value to open a list of interactions included in the item.

Usage Tracking

The Usage Tracking report shows information about user activity over a selected date range.

Common usages

• Monitor the activity of SpeechMiner UI users.
• See which interactions have been listened to.

Customizing the report

For additional information, see Report parameters.

Actions

• Click a user to drill down to a log of the user's actions.
• In the user action log, click one of the tabs at the top of the list to filter the list. For example, click

Logins to see a list of when the user logged into or out of the system.

Available report templates
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Contents
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•

• Administrator

Use Quality Management (QM) to move beyond random sampling to gain a deeper understanding of
agent/customer interactions. QM features can help you gain insight into customer interactions and
ways in which agents can improve them.

Related documentation:
•
•

Quality Management (QM) helps organizations move beyond random sampling to gain a deeper
understanding of its agent/customer interactions by monitoring, evaluating, and studying customer
interactions. Quality Management not only helps organizations identify agents who underperform, but
it also helps them identify the root cause of an agent's behavior.

By understanding agent performance and productivity issues at a granular level, Quality
Management offers insight into customer interactions and ways in which agents can improve them.
That is, Quality Management offers insight that can increase employee productivity, resolve future
customer disputes and subsequently enhance customer service. It enables you to ensure consistent
and professional service.

The QM module is a tool that helps organizations improve agent productivity as well as customer
satisfaction. The key features such as Forms Manager and Evaluations Manager can be utilized for
evaluating agent productivity, as well as targeted agent training. These features allow easy detection
and training of agents who do not adhere to compliance or specified procedures.

The means to satisfied customers and great service is this cycle of data collection, analysis, training,
and improvement.

Quality Management key features include

• Forms Manager - Enables you to create feedback forms to use when evaluating your contact center
agents.

• Evaluations Manager - Enables you to create evaluations to monitor your agents productivity and
efficiency.

• Evaluation Sessions - Provides a list of existing evaluation sessions.
• Reports - Enables you to monitor agent or evaluator progress using predefined reports, identify areas for

training, and calibrate evaluator responses to limit evaluation variations.

Important
Forms Manager, Evaluations manager, and Evaluation Sessions are accessed from the Quality menu.

Quality Management (QM)
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Report features are accessed from the Reports menu.

Link to video

Quality Management workflow

Review the following QM workflow to get an overall idea about the SpeechMiner UI Quality
Management process.

Quality Management (QM)
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•

• Administrator

Use the Forms Manager to create feedback forms to use when evaluating your contact center
agents. When a form is included in an evaluation, it becomes part of a process that helps you
identify how an agent is functioning, and subsequently what the agent needs to do in order to
maximize your business goals and customer satisfaction.

Related documentation:
•
•

With the Quality Management - Forms Manager you can create and manage forms that enable
evaluators to provide feedback about a specific agent. That is, when a form is included in an
evaluation, it becomes part of a process that helps you identify how an agent is functioning, and
subsequently what the agent needs to do in order to maximize your business goals and customer
satisfaction.

Before you create a form consider the following:

• Each form has a name, optional description and a list of questions.
• Forms can contain one or more of the following question types:

• Yes/No
• Multiple Choice
• Choose from List
• Free Form
• Sliding Scale

• Questions are created and contained within groups. A group can contain one or more questions.
• Each question can be defined as mandatory or optional.
• Multiple Choice, Choose from List, Yes/No and Sliding Scale questions are assigned weights. The given

weight is used to calculate cumulative scores and the overall score of the form.
• Yes/No, Multiple Choice, the minimum Sliding Scale value and Choose from List questions can include

Auto-Fail answers.
• Forms are inactive until you activate them.
• Only active forms can be attached to an evaluation.
• Each evaluation can contain one or more forms.
• A form used in one or more evaluations cannot be deleted.
• Each active form can be attached to one or more evaluations.

Forms Manager
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For further considerations, see Configure question weights.

Forms Manager grid

The Quality Management - Forms Manager grid contains a list of all the inactive and active forms.
From the grid you can quickly see when the form was created, the last time it was modified who
created the form and so on.

The Forms Manager grid contains the following information:

• New Form - Used to create a new form.

• Filter by name - Enables you to search for a specific form according to
the form's name.

• Delete - Deletes the selected form(s).
• 0 Selected - The number of forms selected in the grid.
• Name - The name of the form.

Tip
Hover over the form name to view the description of the specific form.

• Description - The description added to the Description field about the specific form.

Tip
By default, the Description column does not appear in the grid. To add the Description column to the
grid, click the icon and select the Description checkbox.

• Creator - The name of the user who created the form.
• Created - The date and time the form was created.
• Modified - The date and time the form was changed.
• Status - Indicates if the form is active or inactive.

• - Use to select the columns that appear in the grid.

Forms Manager
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Tip
To return the grid columns to their default state, click Reset to defaults from the Select Columns list

.

Forms Manager
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Create and manage forms

Contents

• 1 Create a new form
• 2 Manage forms

• 2.1 Save a form
• 2.2 Edit a form
• 2.3 Delete a form
• 2.4 Delete a form question
• 2.5 Copy a form
• 2.6 Preview a form
• 2.7 Collapse / expand all form groups
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•

• Administrator

Use the New Form option to create and manage forms that enable evaluators to provide feedback
about a specific agent. When a form is included in an evaluation, it becomes part of a process that
helps you identify how an agent is functioning, and subsequently what the agent needs to do in
order to maximize your business goals and customer satisfaction.

Related documentation:
•
•

Quality Management forms are included in evaluation sessions. These forms enable evaluators to
obtain feedback about how an agent is functioning, and subsequently determine what the agent
needs to do to maximize your business goals and customer satisfaction.

Create a new form

1. Click Quality > Forms Manager. The Forms Manager grid appears.
2. Click New Form. A blank form appears.
3. In the Untitled Form field enter a name for the form.
4. In the Description field enter a description about the form you are creating. (optional)
5. Click Insert and select to create a group of questions, add a group with an existing question type or

add an existing question group from the Question Library.

Important
By default one empty group already exists when you create a new form. For example, a form about
agent/customer communication could have a group of questions called Interaction, containing questions
about the interaction and another group called Agent, containing questions about how the agent
handled the interaction.

For details about how to create, edit and use question groups, see: Question library.

6. In the fields provided, add a group name and group description.
7. Click Insert Question to add a question to the group and select one of the following question types:

For details about each question type refer to: Form Questions.
• Yes/No or N/A - A question whose expected answer is either yes, no or not applicable.
• Choose from List - A closed ended question that enables the user to select multiple answers from

Create and manage forms
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a list of choices.
• Multiple Choice - A closed ended question that enables the user to select one answer from a list of

answers.
• Free Form - A text box for users to input short answers to the question.
• Sliding Scale - A scale with a minimum and maximum value, where the maximum value represents

a stronger association to the question.

8. If a question is mandatory, select the Required check box. When Required is selected, the user must
answer the question before completing the form.

Tip
You can move the location of a question using the arrows provided .

9. Repeat steps 5-8 until the form contains all of the groups and questions you want.

Tip

Click Clone Group to create a copy of an existing group of questions.

10. Click Auto-fail for a Yes/No, Multiple Choice, the minimum Sliding Scale value or Choose from List
answer, to create a form that will automatically fail when the user selects an answer to one of these
questions.

11. Click Done when you complete a group of questions. All of the group options will disappear and the
group will appear as it will in the final form.

Tip
To edit the same group simply click within the group. The group options will reappear.

12. Click Weighting... to assign your questions a weight. Weights can only be assigned to Multiple
Choice, Yes/No, Choose from List and Sliding Scale questions. The weights indicate the relative
importance of each question and are used by the system to calculate the form's score. The sum of the
weights for each form and each group must be 100%. #:

Important
Each form must contain at least one question that can be given a weight. For more information see: Configure
question weights.
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13. Click the Preview Form icon to review the form before you save it.

14. Click the Active/Inactive option to activate/deactivate the form. (optional). Only an active
form can be attached to an evaluation. An inactive form is not available and cannot be associated with
an evaluation. In addition, an active form cannot be edited.

15. Click Save to save the form. The screen reloads with the Forms Manager and the new form appears in
the list.

Link to video

Manage forms

Once a Quality Management form is created and appears in the Forms Manager grid, you can:

• Save a form
• Edit a form
• Delete a form
• Delete a question
• Copy a form
• Preview a form
• Collapse/Expand a question group

Important
Forms associated with one or more evaluations, or an active evaluation, cannot be
edited, deleted and/or deactivated.

Save a form

1. Create a new form or open an existing form.
2. Configure the form.
3. Click Save > Save. The form is saved.

Edit a form

1. Select Quality > Forms Manager. The list of existing forms appears.
2. Click the name of the form you want to edit. The specific form is opened.
3. Change the form.
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4. Click Save to save your changes.

Delete a form
You can delete a form(s) in one of two ways.

To delete one or more forms:

1. Select Quality > Forms Manager. The list of existing forms appears.
2. Select the check box associated with the form(s) you want to delete.

3. Above the Forms Manager list click Delete . The form(s) is deleted.

To delete a specific form:

1. Select Quality > Forms Manager. The list of existing forms appears.
2. Click the form you want to delete. The specific form is opened.

3. Click Delete in the top right corner of the form. The form(s) is deleted.

Link to video

Delete a form question

1. Select Quality > Forms Manager. The list of existing forms appears.
2. Click the form whose question you want to delete. The specific form is opened.

3. Click Delete next to the question you want to delete. The question is deleted.
4. Click Save > Save to save your changes.

Copy a form
Select Save As to create a copy of the form you are currently creating/editing.

1. Open the form you want to copy.
2. Click Save > Save as.
3. Enter a form name. A copy of the form is created and is listed in the Forms Manager grid.

Preview a form
As you add questions and question groups to a form, you may want to see how the form appears to
users.

1. In a new or existing form, click the Preview Form icon . The form appears in a new window as it
will appear when accessed by a user.
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Genesys Recording, Quality Management, and Speech Analytics User's Guide 168

https://player.vimeo.com/video/708588966?title=0&byline=0&portrait=0


2. Click X in the top right corner of the Preview Form window to close the preview.

Collapse / expand all form groups
As you add questions and question groups to a form, the form can become long. You may want to
either collapse all the groups or see specific groups while hiding others.

To collapse/expand all the groups:

• In a new or existing form, click the Collapse/Expand questions icon to expand or collapse all the
question groups.

To collapse/expand a specific group:

• In a new or existing form, click the Collapse/Expand questions icon in the group you
want to expand or collapse. The number in this option specifies the amount of question in the group.

Create and manage forms
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Form questions

Contents

• 1 Types of questions
• 1.1 Yes/No
• 1.2 Multiple Choice
• 1.3 Choose from List
• 1.4 Free Form
• 1.5 Sliding Scale

• 2 Question library
• 2.1 Add a question group to a form
• 2.2 Create a question group
• 2.3 Edit a question group

• 3 Configure question weights
• 4 Basic scenarios

• 4.1 Scenario 1:A form has 2 groups. One group includes a N/A answer and the other group includes
a question that was not answered.

• 4.2 Scenario 2:A form with 2 groups where all questions are answered.
• 4.3 Scenario 3:A form with 2 groups where all questions are either not answered or answered N/A. In

this case, the group is removed from the total and will not affect the form score.
• 4.4 Scenario 4:A form where all the questions in the form are Free Form questions.

• 5 Configure weights for a group, question, or answer
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• Administrator

A Quality Management form must contain one or more questions. This page describes the types of
questions you can use, how to create and use question groups, and how to weigh the answers.

Related documentation:
•
•

Types of questions

A Quality Management form can contain one or more of the following question types:

• Yes/No
• Multiple Choice
• Choose from List
• Free Form
• Sliding Scale

Important
Weights are assigned to Multiple Choice, Choose from List, Yes/No and Sliding Scale
questions. The weights indicate the relative importance of each question and are used
by the system to calculate the form's score. For more information, see Configure
question weights.

Yes/No
A Yes/No question requires the user to select one answer. The question offers three answers: Yes, No
or Not Applicable (N/A).

1. In a new or existing form, click Insert in the form group to which you want to add the Yes/No question.
2. Select Yes/No. The question appears without a title but with the two options (Yes, No).
3. Click the Question Title field and enter the question.
4. Click the Question Description field and enter a description for the question. You can expand the

Question Description field (click and drag the bottom right corner) and enter up to 4096 characters.

Form questions
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5. Click Add N/A to add the not applicable option.
6. If the question is mandatory, select the Required check box.
7. Click Auto Fail next to the answer that will cause the entire form to fail and receive a score of 0 when

selected .
8. Click Done.

Multiple Choice
A Multiple Choice question enables the user to select one answer from a list of answers.

1. In a new or existing form, click Insert in the form group to which you want to add the Multiple Choice
question.

2. Select Multiple Choice. The question appears without a title and the statement "No answers defined".
3. Click the Question Title field and enter the question.
4. Click the Question Description field and enter a description for the question. You can expand the

Question Description field (click and drag the bottom right corner) and enter up to 4096 characters.
5. Click Add new choice to add the first of a number of choices.
6. Repeat step #5 until you have added all the possible answers.
7. If the question is mandatory, select the Required check box associated with the specific question.
8. Click Auto Fail next to the answer that will cause the entire form to fail and receive a score of 0 when

selected.
9. Click Done.

Choose from List
A Choose from List question enables the user to select multiple answers from a list of choices.

1. In a new or existing form, click Insert in the form group to which you want to add the Choose from List
question.

2. Select Choose from List. The question appears without a title and the statement "No answers
defined".

3. Click the Question Title field and enter the question.
4. Click the Question Description field and enter a description for the question. You can expand the

Question Description field (click and drag the bottom right corner) and enter up to 4096 characters.
5. Click Add new choice to add the first of a number of answers.
6. Repeat step #5 until you have added all the Choose from List answers.
7. If the question is mandatory, select the Required check box.
8. Click Auto Fail next to the answer that will cause the entire form to fail and receive a score of 0 when

selected.
9. Click Done.
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Free Form
A Free Form question enables the user to freely formulate an answer.

1. In a new or existing form, click Insert in the form group to which you want to add the Free Form
question.

2. Select Free Form. The question appears without a title.
3. Click the Question Title field and enter the question.
4. Click the Question Description field and enter a description for the question. You can expand the

Question Description field (click and drag the bottom right corner) and enter up to 4096 characters.
5. If the question is mandatory, select the Required check box.
6. Click Done.

Sliding Scale
A Sliding Scale question enables the user to set a scale with a minimum and maximum value, where
the maximum value represents a stronger association to the question.

1. In a new or existing form, click Insert in the form group to which you want to add the Sliding Scale
question.

2. Select Sliding Scale. The question appears without a title.
3. Click the Question Title field and enter the question.
4. Click the Question Description field and enter a description for the question. You can expand the

Question Description field (click and drag the bottom right corner) and enter up to 4096 characters.
5. From the menus provided select a minimum and maximum value.
6. In the Minimum text box, provide a name for the minimum value.
7. In the Maximum text box, provide a name for the maximum value.
8. If the question is mandatory, select the Required check box.
9. Click Auto Fail to cause the entire form to fail and receive a score of 0 when the minimum is selected.

Link to video

Question library

A Quality Management form must contain one or more questions. Each question is part of a group.
The question group can be saved for later use in the Question library. Once a question group is saved
in the Question library, you can add it to one or more forms as often as required. You can also edit a
question group either in the Question library or in the form. Once you edit and change a question
group in the form, you can give it a new name and add it to the Question library as a new question
group.

With the Quality Management - Question library you can:
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• Add a question group to a form
• Create a question group
• Edit a question group

Add a question group to a form

1. Click Quality > Forms Manager. The Forms Manager grid appears.
2. Click New Form or the name of an existing form in the Name column.
3. Click Insert Group > From Library.... The Insert question group window appears.
4. Select the question group(s) you want to add to the form.
5. Click Insert. The question group is added to the form.

Create a question group

1. Click Quality > Forms Manager. The Forms Manager grid appears.
2. Click New Form or open an existing form.
3. Click Insert Group and select one of the following options:

• Insert Group - To create a new empty group.
• Yes / No - To create a new group with one Yes No question.
• Multiple Choice - To create a new group with one Multiple Choice question.
• Choose from list - To create a new group with one Choose from list question.
• Free form - To create a new group with one Free form question.
• Sliding scale - To create a new group with one Sliding scale question.
• From Library... - To enter an existing question group.For details about each question type, see

Types of questions.
• Enter a group name in the Untitled Group field.
• Add one or more questions to the group.
• Click Add to library....#: The Add to Question Library window appears.
• Click Add. A success message appears.

Important
If a question group with the same name already exists you will be asked to give the question group a
new name.

• Click View in Question Library. The Question Group Library window is opened and the question
group appears among the list of existing question groups.

• Click Cancel to close the library.
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Edit a question group

1. Click Quality > Forms Manager. The Forms Manager grid appears.
2. Click New Form or open an existing form.
3. Create a new group and click Add to library... (see Create a question group) or click Insert Group >

From Library....
4. From the Question Group list, select the question group you want to edit.
5. Click Edit and add/remove questions from the group.
6. Click Save. The question group is saved with your changes.

Configure question weights

Weights are assigned to Multiple Choice, Yes/No, Choose from list and Sliding Scale questions.The
weights indicate the relative importance of each question and are used by the system to calculate
the form's score.

Before you create a form consider the following.

• The sum of the group weights for each form must be 100%. If the sum of the group weights is not
100%, the form cannot be activated.

• The sum of the questions within each group must be 100%. If the sum of the questions weights within a
group is not 100%, the form cannot be activated.

• When a question is marked as Required it must be answered.
• Each Multiple Choice and Choose from List answer should be assigned a weight.
• The weight for each answer, question, and/or group is either entered manually or distributed equally

among the following by clicking theRedistribute button:
• Answers in a Multiple Choice question.
• Answers in a Choose from list question.
• All of the groups within a form.
• All of the questions within a group.

For a better understanding, refer to how weights are calculated for each of the questions and answer
types in the sections below.

• QM Questions and Answers table
• Basic scenarios
• Configure weights for a group, question or answer

Form questions
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QM Questions and Answers
Type of Question and Answer Weight Calculation

Yes/No The score for a Yes/No question is 100 if the answer
is Yes and 0 if the answer is No.

Multiple Choice Each Multiple Choice answer can receive a weight
from 0 to 100. The score associated with a Multiple
Choice question is the weight of the selected
answer.
For example - If a Multiple Choice question has four answers, the
weights can be:

• Answer 1 = 0%
• Answer 2 = 40 %
• Answer 3 = 70 %
• Answer 4 = 100%

Choose from list Each Choose from list answer can receive a weight.
The sum of all the weights must total 100%. The
score associated with a Choose from list question is
the sum of the weights of the selected answers.
For example - If a Choose from list question has four answers,
the weights can be:

• Answer 1 = 20%
• Answer 2 = 40 %
• Answer 3 = 40 %
• Answer 4 = 0%

If the evaluator selects answers 1 and 3, the Choose from list
question score is 60%.

Sliding Scale Each Scale question has a low (that is, minimum)
value and high (that is, a maximum) value.
The score for the low value is 0 and the score for the high value
is 100.

The Scale score is calculated as follows - (chosen value - low
value) / (high value - low value) * 100%

For example:

The low value = 0 and the high value = 10.

If the evaluator selects 7, the score is (7 - 0) / (10 - 0) * 100 =
70%

Free Form Free form questions do not have a score and
therefore they cannot be assigned a weight.

Not Applicable (N/A), Not Required and Not
Answered

A Yes/No question can include a N/A answer.
If a question is not marked as required the evaluator does not
have to answer the question.
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Type of Question and Answer Weight Calculation

Selecting N/A or not answering a question will not affect the
final form score.

Auto Fail When an answer marked as Auto Fail is
selected,the form will automatically fail. The Yes/
No, Multiple Choice, Choose from list questions can
have answers with an Auto Failanswer, and the
minimum Sliding Scale answercan be assigned the
Auto Fail value.
If the evaluator selects an Auto Fail answer for one or more
questions, the total score of the form will be 0. The scores of all
remaining questions and groups will be calculated normally.

Basic scenarios

• Scenario 1: A form has 2 groups. One group includes a N/A answer and the other group includes a
question that was not answered.

• Scenario 2: A form with 2 groups where all questions are answered.
• Scenario 3: A form with 2 groups where all questions are either not answered or answered N/A.
• Scenario 4: A form where all the questions are Free Form questions.

Scenario 1:A form has 2 groups. One group includes a N/A answer and the other group
includes a question that was not answered.

Group One:

• 2 questions
• Group weight = 50%

Question Answer Question
Score (%)

Question
Weight Score Max Possible

Score
1 80% 60% 24 30
2 N/A - 40% - -

Group One Score - 24 / 30 = 80%

Group Two:

• 3 questions
• Group weight = 50%
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Question Answer Question
Score (%)

Question
Weight Score Max Possible

Score
1 50% 60% 15 30
2 20% 20% 2 10
3 Not Answered - 20% -

Group Two Score - 17 / 40 = 42.5%

Total Form Score - (80% * 50%) + (42.5% * 50%) = 61%

Scenario 2:A form with 2 groups where all questions are answered.

Group One:

• 2 questions
• Group weight = 50%

Question Question
Score (%)

Question
Weight

Question's
Score

Absolute
Question's
Score

Max Possible
Score

1 100% 50% 100%*50%*50%=25%25 25
2 80% 50% 80%*50%*50%=25%20 25

Group One Score:45 / 50 = 90%

Group Two:

• 3 questions
• Group weight = 50%

Question Question
Score (%)

Question
Weight

Question's
Score

Absolute
Question's
Score

Max Possible
Score

1 50% 60% 50%*60%*50%=15%15 30
2 20% 20% 20%*20%*50%=2%2 10
3 100% 20% 100%*20%*50%=10%10 10

Group One Score:27 / 50 = 54%
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Total Form Score - (90% * 50%) + (54% * 50%) = 72%

Scenario 3:A form with 2 groups where all questions are either not answered or answered N/
A. In this case, the group is removed from the total and will not affect the form score.

Group One:

• 2 questions
• Group weight = 50%

Question Answer Question Score Question Weight Score
1 N/A - 50% -
2 N/A - 50% -

Group One Score:no score

Group Two:

• 3 questions
• Group weight = 50%

Question Answer Question
Score

Question
Weight Score

Maximum
Possible
Score

1 50% 60% 15 30
2 20% 20% 2 10
3 Not Answered - 20%

Group One Score:17 / 40 = 43%

Total Form Score - 43%

Scenario 4:A form where all the questions in the form are Free Form questions.

Free Form questions do not have a weight. For this reason, this form will not have a score. The
message "no score" will appear and this form will not be included in the reports.

Configure weights for a group, question, or answer

1. Create a form with one or more groups of questions.

Form questions

Genesys Recording, Quality Management, and Speech Analytics User's Guide 179



2. Click Weighting... . The Weighting for
window appears.

3. Enter a weight for each group in the fields provided or click Redistribute to distribute the weights
equally among each group in the form.

4. Verify that the group weights total is 100.
5. Click the name of each group to see a list of the group's questions.

6. Enter a weight for each question within the group, and verify that the total of the weights for the
group's questions is 100 or click the Redistribute button to distribute the weights equally among each
question within the group.

7. If you included a Multiple Choice or Choose from list question in your group, click the name of the
question to see a list of the question's answer.

8. Enter a weight for each answer associated with the Multiple Choice or Choose from list question or click
the Redistribute button to distribute the weights equally among each answer within the question.

9. Repeat steps 5 – 8 for each group in the form.
10. Save the form.

Link to video
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Evaluations Manager

Contents

• 1 Evaluations Manager grid

Evaluations Manager
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•

• Administrator

Use the Evaluation Manager to create and manage Quality Management evaluations that enable you
improve agent productivity as well as customer satisfaction. With the options provided in the
Evaluations Manager you can provide agents with objective assessments, motivate agents with
training opportunities, recognize and keep top employees, and create evaluation reports.

Related documentation:
•
•

Quality Management evaluations are the best way to evaluate and improve agent behaviors that
support your business goals. They drive the behaviors that promote a specific agenda by enabling
you to assess how well your agents are performing during customer interactions.

With the knowledge obtained from an evaluation you can create positive customer experiences and
exceed customer expectations by:

• Providing agents with objective assessments using specific criteria and customized forms.
• Motivating agents with training opportunities and positive feedback.
• Recognizing and keeping top employees.
• Creating evaluation reports to help managers monitor agents' progress, identify training requirements,

and calibrate evaluator responses to limit variations in evaluations.

Before you create an evaluation consider the following:

• Only an administrator or a user with QM Manager Role permissions can create evaluations.
• SpeechMiner Quality Management enables you to create five types of evaluations - Distributed

(Interaction + Agent), Shared, Calibration, and Ad-Hoc.
• Once an evaluation is saved, one or more evaluation sessions are created according to a predefined

schedule.
• If you selected Interactions when working with a One Time schedule, each evaluation creates one

evaluation session for every agent associated with selected interactions and each evaluation session is
assigned to each evaluator. For example, if an evaluation contains 2 evaluators and 3 interactions
(each with 1 agent), 6 evaluation sessions will be created. That is, each evaluator will be asked to fill
out the evaluation for each of the 3 agents. If an evaluation contains 2 evaluators and 3 interactions
(each with a set of 2 agents), 12 evaluation sessions will be created.

• If you selected Criteria when working with a One Time schedule, the interactions are randomly
distributed among the evaluators.

• A Shared Evaluation session creates evaluation sessions that are not assigned to a specific evaluator.
Instead, each evaluator associated with the session can select and assign himself/herself a specific
session from the available pool of session.

Evaluations Manager
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• A Calibration Evaluation session is filled out in the same way as a Distributed or Shared evaluation
session. But, unlike a Distributed or Shared evaluation a Calibration evaluation includes a single
interaction and multiple evaluators. This session can be used as part of a report that compares the
performance of two or more evaluators.

Evaluations Manager grid

The Quality Manager - Evaluations Manager grid contains a list of all the inactive and active
evaluations.

From the grid, you can quickly see when the evaluation was created, the last time it created a
session(s), etc.

The Evaluations Manager grid contains the following information and options.

• New Evaluation - Use to create a new Distributed, Shared, or Calibration
evaluation.

• Delete - Deletes the selected evaluation.

Important
When you delete an evaluation in the Evaluation Manager list, all the sessions that were created as a
result of the specific evaluation will also be deleted.

• Filter by name - Enables you to search for a specific evaluation.
• 0 Selected - The number of forms selected in the grid.
• Name - The name of the evaluation.

Tip
Hover over the evaluation name to view the description of the specific evaluation.

• Description - The description added to the Description field about the specific evaluation.

Tip
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By default, the Description column does not appear in the grid. To add the Description column to the
grid, click the icon and select the Description checkbox.

• Creator - The name of the user who created the evaluation.
• Evaluators - If you selected Interactions when working with a One Time schedule, this parameter

indicates the amount of evaluators associated with the specific evaluation. Each one of these
evaluators will be required to perform the same evaluation sessions. For example, if an evaluation with
3 evaluators is scheduled for over the course of a month, and is configured to generate 30 sessions,
each evaluator will receive 10 different interactions. If you selected Criteria when working with a One
Time schedule, the interactions are randomly distributed among the evaluators.

• Schedule - Indicates whether the evaluation is a one-time evaluation or a recurring evaluation.
• Type - Indicates whether the evaluation is a Distributed, Shared, Ad Hoc or Calibration evaluation. For

details, see Evaluations manager.
• Form(s) - Indicates the number of forms associated with the evaluation.
• Last Activity - Indicates the last time the evaluation created one or more evaluation sessions..
• Status - Indicates if the evaluation is active or inactive. An inactive evaluation cannot create evaluation

sessions.
• Created - Indicates the date on which the evaluation was created.
• Evaluation Sessions - Indicates the number of evaluation sessions created as a result of the

evaluation.

• - Use to select the columns that appear in the grid.

Tip
To return the grid columns to their default state, click Reset to defaults from the Select Columns list

.
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Create an evaluation

Contents

• 1 Distributed Interaction Evaluation
• 1.1 Create a Distributed Interaction evaluation

• 2 Distributed Agent evaluation
• 2.1 Create a Distributed Agent evaluation

• 3 Shared evaluation
• 3.1 Create a Shared evaluation

• 4 Calibration Evaluation
• 4.1 Create a Calibration evaluation

• 5 Ad-Hoc Evaluation
• 5.1 Create an Ad-Hoc evaluation session
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•

• Administrator

Use Quality Management evaluations to improve agent productivity as well as customer satisfaction.
Quality Management evaluations enable you to promote a specific agenda that results in easy
detection and training of agents who do not adhere to compliance or specified procedures.

Related documentation:
•
•

SpeechMiner Quality Management enables you to create five types of evaluations:

• Distributed Interaction Evaluation
• Distributed Agent Evaluation
• Shared Evaluation
• Calibration Evaluation
• Ad-Hoc Evaluation

Refer to Quality Management workflow for a better understanding about the evaluation process.

Important
• You cannot create an evaluation without a form. Before you create an evaluation, verify

that a form(s) was created.
• The Evaluation Session list will automatically refresh when a new set of evaluation

sessions is available. To manually refresh the Evaluation Session list, click the Refresh

button .

Link to video

Distributed Interaction Evaluation

The SpeechMiner Quality Management - Distributed Interaction Evaluation creates evaluation
sessions about interactions for selected evaluators. Each evaluator will be assigned an evaluation
session for each agent associated with the evaluation. The evaluation is created about the agents
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who participated in the selected interactions. For example, if you add 2 evaluators and 3 interactions
(each with a different agent) to the evaluation, 6 evaluation sessions will be created. That is, each
evaluator will be asked to fill out the evaluation for each one of the 3 agents.

Create a Distributed Interaction evaluation

1. Click Quality > Evaluations Manager. The Evaluations Manager grid appears.
2. Click the drop down arrow next to New Evaluation and select Distributed > Interaction.
3. In the Untitled Evaluation field, enter the name of your evaluation.
4. In the Description field, enter a description of the evaluation.
5. From the Schedule list select one of the following, and configure the schedule using the options

available:
• Recurring: Use to create an evaluation that repeatedly produces evaluation sessions for a

configurable time interval.
• One Time: Use to create an evaluation that only produces evaluation sessions once.

The available schedule configuration options are:

• Start - The date on which the evaluation session(s) should be created.

• - The time at which the evaluation session(s) should begin.
• Occur every - The frequency (Minutes, Hours, Days, Weeks or Months) with which the evaluation

recurs.
• Expires after - The time (Minutes, Hours, Days, Weeks or Months) at which the evaluation session

should be performed after the evaluation is created.

6. Select the Forms tab and from the Forms list, select the forms to add to the evaluation. As soon as you
select a form from the list, it appears in the Evaluation Summary under Forms. Select the form again to
remove the form from the Evaluation Summary. The forms selected consist of the questions that must
be answered to complete the evaluation session.

7. Select the Evaluators tab and from the Evaluators list, select the evaluator(s) that should perform the
evaluation session(s). As soon as you select an evaluator from the list, the evaluator name appears in
the Evaluation Summary under Evaluators. Select the evaluator again to remove the evaluator from the
Evaluation Summary. Each evaluator will receive an evaluation session to evaluate the agent(s)
associated with the selected interactions.

8. Select the Interactions tab.
1. Select Recurring or One Time. If you selected a Recurring schedule in step #5, you cannot select

the interactions yourself. The resulting interaction list associated with the evaluation corresponds to
what you entered in the search filter. If you selected a One Time schedule, select one of the
following:
• Interactions: Enables you to select interactions from the list of interactions created after you

click Search.
• Interaction Criteria: Randomly selects interactions from the interaction list resulting from your

specific search. The amount of interactions selected correspond to what you entered in the
Exactly field.
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Important
If you select Interaction Criteria, continue directly to step 9.

2. Configure the evaluation filter options on the left side of the screen, to generate a list of
interactions.

Your filter selections should be directly related to the business issue for which you want to
evaluate an agent(s).

For additional information, see Search filter.

3. Click Search.

Important
If you selected Interactions in step 8a, from the list provided select the interactions (one at a time)
that you would like to add to the evaluation.

As soon as you select an interaction from the list, it appears in the Evaluation Summary under
Interactions.

Clear an interaction's check box to remove that specific interaction from the Evaluation
Summary.

You can play back an interaction to verify its relevancy to the purpose of the evaluation. Simply
click the Play icon associated with the interaction you want to hear. For more information
about playing an interaction, see Media Player.

9. Click the Inactive option to activate the evaluation. Only an active
evaluation will create evaluation sessions.

10. Click Save and Activate. Once the evaluation is saved and activated, it will start to create evaluation
sessions according to the schedule configured at the beginning of this procedure.

Distributed Agent evaluation

The SpeechMiner Quality Management - Distributed Agent Evaluation creates evaluation sessions
about one or more specific agent performances during customer interactions. The Distributed Agent
Evaluation is assigned to one evaluator. The selected evaluator is assigned an evaluation session
associated with the selected agent. For example, if you select 18 agents to be evaluated by a specific
evaluator, 1 evaluation session will be created for each of the 18 agents according to the selected
interaction filter criteria.

Create a Distributed Agent evaluation

1. Click Quality > Evaluations Manager. The Evaluations Manager grid appears.
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2. Click the drop down arrow next to New Evaluation and select Distributed > Agent.
3. In the Untitled Evaluation field, enter the name of your evaluation.
4. In the Description field, enter a description of the evaluation.
5. From the Schedule list select one of the following, and configure the schedule using the options

available:
• Recurring: Use to create an evaluation that repeatedly produces evaluation sessions for a

configurable time interval.
• One Time: Use to create an evaluation that only produces evaluation sessions once.

The available schedule configuration options are:

• Start - The date on which the evaluation session(s) should be created.

• - The time at which the evaluation session(s) should begin.
• Occur every - The frequency (Minutes, Hours, Days, Weeks or Months) with which the evaluation

recurs.
• Expires after - The time (Minutes, Hours, Days, Weeks or Months) at which the evaluation session

should be performed after the evaluation is created.

6. Select the Forms tab and from the Forms list, select the forms to add to the evaluation. As soon as you
select a form from the list, it appears in the Evaluation Summary under Forms. Select the form again to
remove the form from the Evaluation Summary. The forms selected consist of the questions that must
be answered to complete the evaluation session.

7. Select the Evaluators tab and from the Evaluators list, select the evaluator that should perform the
evaluation session(s). As soon as you select an evaluator from the list, the evaluator name appears in
the Evaluation Summary under Evaluators. Select the evaluator again to remove the evaluator from the
Evaluation Summary. Each evaluator will receive an evaluation session to evaluate the agent(s)
associated with the selected interactions.

8. Select the Agents tab and from the Agents list, select the agent(s) whose interactions you want to
evaluate. As soon as you select an agent from the list, the agent's name appears in the Evaluation
Summary under Agents. Select the agent again to remove the agent from the Evaluation Summary. If
you select a manager, the sessions will only be created for the agents associated with the selected
manager and not for the manager.

9. Select the Interactions tab.

Important
You cannot manually select a list of Interactions. The resulting interaction list corresponds to what you
entered in the search filter.

1. Configure the evaluation filter options on the left side of the screen, to generate a list of
interactions. Your filter selections should be directly related to the business issue for which you
want to evaluate an agent(s). For additional information, see Search filter.

2. Click Search.
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Important
You can play back an interaction to verify its relevance to the purpose of the evaluation. Simply click the
Play icon associated with the interaction you want to hear. For more information about playing an
interaction, see Media Player.

10. Click the Inactive option to activate the evaluation. Only an active
evaluation will create evaluation sessions.

11. Click Save and Activate. Once the evaluation is saved and activated, it will start to create evaluation
sessions according to the schedule configured at the beginning of this procedure.

Shared evaluation

The SpeechMiner Quality Management - Distributed Shared Evaluation creates evaluation sessions
about an agent's performance during customer interactions without assigning the sessions to a
specific evaluator. Instead, each evaluator associated with the session can select and assign himself/
herself the Shared session from the available pool of Shared sessions. Once an evaluator selects a
Shared session, the specific session is no longer available to other evaluators.

Create a Shared evaluation

1. Click Quality > Evaluations Manager. The Evaluations Manager grid appears.
2. Click the drop down arrow next to New Evaluation and select Shared.
3. In the Untitled Evaluation field, enter the name of your evaluation.
4. In the Description field, enter a description of the evaluation.
5. From the Schedule list select one of the following, and configure the schedule using the options

available:
• Recurring: Use to create an evaluation that repeatedly produces evaluation sessions for a

configurable time interval.
• One Time: Use to create an evaluation that only produces evaluation sessions once.

The available schedule configuration options are:

• Start - The date on which the evaluation session(s) should be created.

• - The time at which the evaluation session(s) should begin.
• Occur every - The frequency (Minutes, Hours, Days, Weeks or Months) with which the evaluation

recurs.
• Expires after - The time (Minutes, Hours, Days, Weeks or Months) at which the evaluation session

should be performed after the evaluation is created.

6. Select the Forms tab and from the Forms list, select the forms to add to the evaluation. As soon as you
select a form from the list, it appears in the Evaluation Summary under Forms. Select the form again to
remove the form from the Evaluation Summary. The forms selected consist of the questions that must
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be answered to complete the evaluation session.
7. Select the Evaluators tab and from the Evaluators list, select the evaluator(s) that should perform the

evaluation session(s). As soon as you select an evaluator from the list, the evaluator name appears in
the Evaluation Summary under Evaluators. Select the evaluator again to remove the evaluator from the
Evaluation Summary. Each evaluator will receive an evaluation session to evaluate the agent(s)
associated with the selected interactions.

8. Select the Interactions tab.
1. Select Recurring or One Time. If you selected a Recurring schedule in step #5, you cannot select

the interactions yourself. The resulting interaction list associated with the evaluation, corresponds
to what you entered in the search filter. If you selected a One Time schedule, select one of the
following:
• Interactions: Enables you to select interactions from the list of interactions created after you

click Search.
• Interaction Criteria: Randomly selects interactions from the interaction list resulting from your

specific search. The amount of interactions selected correspond to what you entered in the
Exactly field.

Important
If you select Interaction Criteria, continue directly to step 9.

2. Configure the evaluation filter options on the left side of the screen, to generate a list of
interactions.

Your filter selections should be directly related to the business issue for which you want to
evaluate an agent(s).

For additional information, see Search filter.

3. Click Search.

Important
If you selected Interactions in step 8a, from the list provided select the interactions (one at a time)
that you would like to add to the evaluation.

As soon as you select an interaction from the list, it appears in the Evaluation Summary under
Interactions.

Clear an interaction's checkbox to remove that specific interaction from the Evaluation
Summary.

You can play back an interaction to verify its relevancy to the purpose of the evaluation. Simply
click the Play icon associated with the interaction you want to hear. For more information
about playing an interaction, see Media Player.

9. Click the Inactive option to activate the evaluation. Only an active
evaluation will create evaluation sessions.
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10. Click Save and Activate. Once the evaluation is saved and activated, it will start to create evaluation
sessions according to the schedule configured at the beginning of this procedure.

Calibration Evaluation

The SpeechMiner Quality Management - Calibration Evaluation creates evaluation sessions that can
be used to compare evaluator performance, to ensure consistency across teams. A Calibration
Evaluation is performed on one evaluation in the same way as a Distributed Interaction Evaluation
session, the difference is that the result of these evaluation sessions can be used in a Calibration
Score report (that is, a report that compares how the evaluators filled out the same evaluation
session).

Create a Calibration evaluation

1. Click Quality > Evaluations Manager. The Evaluations Manager grid appears.
2. Click the drop down arrow next to New Evaluation and select Calibration.
3. In the Untitled Evaluation field, enter the name of your evaluation.
4. In the Session Expires after field, enter the time (Days, Weeks or Months) by which the evaluation

session should be performed after the evaluation is created.
5. Select the Forms tab and from the Forms list, select the forms to add to the evaluation. As soon as you

select a form from the list, it appears in the Evaluation Summary under Forms. Select the form again to
remove the form from the Evaluation Summary. The forms selected consist of the questions that must
be answered to complete the evaluation session.

6. Select the Evaluators tab and from the Evaluators list, select the evaluator(s) that should perform the
evaluation session(s). As soon as you select at least two evaluators, the evaluator name appears in the
Evaluation Summary under Evaluators. Select the evaluator again to remove the evaluator from the
Evaluation Summary. Each evaluator will receive an evaluation session to evaluate the agent(s)
associated with the selected interactions. When you select more than one evaluator, the resulting
Evaluation Sessions are evenly distributed across evaluators in Round Robin fashion.

7. Select the Interactions tab, and configure the evaluation filter options on the left side of the screen to
generate a list of interactions and click Search.

Important
A Calibration evaluation has a One Time schedule. It creates an evaluation that only produces one
evaluation session.
A Calibration evaluation cannot be a Recurring evaluation.

Your filter selections should be directly related to the business issue for which you want to evaluate
an agent(s). For additional information, see Search filter.

1. Select one interaction. As soon as you select an interaction from the list, it appears in the Evaluation
Summary under Interactions. Clear an interaction checkbox to remove the specific interaction from
the Evaluation Summary.
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Important
If you select more than one interaction, the Calibration Evaluation session will not be activated.

8. Click the Inactive option to activate the evaluation. Only an active
evaluation will create evaluation sessions.

9. Click Save and Activate. Once the evaluation is saved and activated, it will start to create evaluation
sessions according to the schedule configured at the beginning of this procedure.

Ad-Hoc Evaluation

The Ad-Hoc Evaluation enables you to create an evaluation session for a specific interaction or
segment currently being played in the Media Player.

Before you create and/or perform an Ad-Hoc evaluation, consider the following:

• By default, the Ad-Hoc evaluation will expire 24 hours after it is created.
• An Ad-Hoc evaluation is only visible to the user who created it and to users with the permission to edit

all evaluation sessions.
• An Ad-Hoc evaluation can only be created from the Media Player > More options menu for the

interaction currently being played.

Create an Ad-Hoc evaluation session

1. Select an interaction and click Play . For more information about playing an interaction, see Media
Player.

2. Click More in the Media Player and select Evaluate. The Evaluate Interaction window appears.
3. Enter a name in the Evaluation Name field.
4. From the Form(s) list, select the forms that should be included in the Ad-Hoc evaluation session. For

additional details about Forms, see Forms Manager.
5. Click Create. The new Ad-Hoc evaluation session is opened.
6. Perform the evaluation. For details on how to perform an evaluation session, see Perform an evaluation

session.
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Evaluation Sessions

Contents

• 1 Evaluation Sessions grid
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•

• Administrator

Use Evaluation Sessions to help ensure that an agent's participation in an interaction coincides with
a specific business agenda. A completed evaluation session provides a view into how an agent
communicates with consumers. Such evaluation sessions provide consistent and regular feedback
that helps surface insightful reports, comments and suggestions that can lead to formal skills
training and action plans to improve an agent's performance.

Related documentation:
•
•

To help ensure that an agent's participation in an interaction coincides with a specific business
agenda, SpeechMiner Quality Management evaluators receive a list of evaluation sessions that they
must fill out according to a configurable schedule.

A completed evaluation session provides a view into how an agent communicates with consumers.
Such evaluation sessions provide consistent and regular feedback that helps surface insightful
reports, comments, and suggestions that can lead to formal skills training and action plans to
improve an agent's performance.

Before you perform an evaluation consider the following:

• An evaluation session can be saved and continued at a later time. Only when you select Complete will
the evaluation session end.

• You can export an uncompleted evaluation session. When you export an uncompleted evaluation
session, an uncompleted prefix is added to the exported file.

• A Shared Evaluation session creates evaluation sessions that are not assigned to a specific evaluator.
Instead, each evaluator associated with the session can select and assign himself/herself a specific
session from the available session pool.

• Archived evaluation sessions are removed from the Evaluation Session grid, and will only be visible
when you filter to view archived sessions.

• A Calibration Evaluation session is filled out in the same way as a Distributed or Shared evaluation
session. But, unlike a Distributed or Shared evaluation a Calibration Evaluation can be used as part of a
report that compares the performance of two or more evaluators.

• When performing an evaluation, you have the option of enabling the evaluator to see their evaluation
score when the evaluation session is completed.

• To complete an evaluation session, you must answer all the required questions in all the forms
associated with the specific evaluation session.

• An evaluation session score is visible throughout the evaluation session.
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Evaluation Sessions grid

The Quality Manager - Evaluations Sessions grid contains a list of all evaluation sessions an evaluator
must fill out.

From the grid you can:

• View which evaluation sessions were started, in progress and or completed
• View whether or not a session was assigned to an evaluator and which evaluator it was assigned to.
• Filter the evaluation session list to quickly find and work with a subset of the list.

The Evaluations Sessions grid contains the following information and options:

• - Enables you to delete the selected evaluation session.

• - Enables you to refresh the Evaluation Session grid with the latest evaluation sessions.

• - Use to archive selected evaluation sessions and remove them from the grid.
• Filter by name - Enables you to search for a specific evaluation session according to the session's

name.
• 0 Selected - The number of evaluation session selected in the grid.
• Filter - Select one or more of the following filter options to limit the evaluation session list, so you can

quickly find the information you are looking for:
• Sessions - Filter the list to show all unarchived evaluation sessions.
• Archived - Filter the list to only show archived evaluation sessions.
• Expired - Filter the list to only show expired evaluation sessions.
• Status - Filter the list to only show sessions that have not been started, are in progress and/or have

been completed.
• Types - Filter the list to only show distributed, shared, calibration and/or ad-hoc sessions.
• Creation Date - Filter the list to only show sessions that were created on a specific date.
• Due Date - Filter the list to only show sessions that should be completed on a specific date.
• Completion Date - Filter the list to only show sessions that were completed on a specific date.
• Agent - Filter the list to only show sessions associated with a specific agent.
• Evaluator - Filter the list to only show sessions associated with a specific evaluator.
• Unassigned - Filter the list to only show sessions that have not been assigned to an evaluator.

• Name - The name of the evaluation session.
• Evaluator - The name of the evaluator to whom the evaluation session was assigned.
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Important
Unassigned sessions are only associated with Shared Evaluations. Unassigned signifies that you can
select the session and assign it to yourself if you are part of the selected evaluators. Once you assign an
Unassigned session to yourself, your name will appear in the Evaluator column.

• Interaction ID - The interaction in which the agent participated.
• Agent - The agent for which the evaluation session was created.
• Description - Contains an explanation about the specific evaluation session.
• Type - Indicates whether the evaluation session is a Distributed, Shared or Calibration session. For

details, see Create an evaluation.
• Form(s) - The number of forms associated with the evaluation session.
• Created - The date on which the evaluation session was created.
• Due - The date on which the evaluation session must be completed.
• Completed - The date on which the evaluation session was completed.
• Status - Indicates the status of the evaluation:

• In Progress - The evaluation has started, but has not been completed.
• Ready - The evaluation has not started.
• Completed - The evaluation session has been completed.

• Creator - The name of the person who created the evaluation session.
• Score - The score the agent received as a result of the evaluation.

• - Enables you to select the columns that appear in the Evaluations Manager grid.

Important
To return the grid columns to their default state, click Reset to defaults from the
Select Columns list .
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Performing and managing Evaluation
Sessions

Contents

• 1 Perform an evaluation session
• 2 Modify a completed evaluation session

• 2.1 Open and edit a completed evaluation session

• 3 Archive an evaluation session
• 3.1 Manually archive an evaluation session

Performing and managing Evaluation Sessions

Genesys Recording, Quality Management, and Speech Analytics User's Guide 198



•

• Administrator

Use Evaluation Sessions to provide to identify the skill sets of your agents, as well as any skill gaps
that need to be filled by additional training. This page describes how to perform an evaluation
session and how you can subsequently modify and/or archive it.

Related documentation:
•
•

Perform an evaluation session

Important
When performing an evaluation session, you can always click the Clear Form option
at the bottom of the form to clear all of your input.

1. Click Quality > Evaluation Sessions. The Evaluation Sessions grid appears.
2. Click the name of the evaluation you want to perform.

Important
If you select an Unassigned evaluation session, you will be asked to confirm that the specific session
should be assigned to you.

3. From the Form list at the top of the screen, select the first form you want to fill out. Once you complete
the selected form, continue filling out the remaining forms.

4. Answer the questions provided. If necessary, click +More to view the entire question.

Important
You cannot complete an evaluation session without answering all the required form questions. Required
form questions are marked with a red star.
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5. Click the Play icon to playback the interaction to hear the discussion between the agent and the
customer. (optional). For more information about playing an interaction, refer to Media Player.

6. Click the inactive Show score option to enable the evaluator to see the evaluation
session scores during the evaluation and a final score when the evaluation is completed. For more
details about scores see Configure question weights.

7. If the interaction is not suitable in any way (for example, poor audio/video quality, irrelevant interaction,

and so on), you can click the Replace Interaction icon to select a different interaction for
the evaluation session (optional).

Important
The Replace Interaction option is only available in evaluation sessions associated with interactions
derived from search criteria. Evaluation sessions associated with manually selected interactions,
Calibration evaluations and Ad-Hoc evaluations will not include the Replace Interaction option. Replacing
the interaction associated with the evaluation session will reset all the answers in the form(s) associated
with the same evaluation session.

8. Select one of the following options.

Important
When an evaluation session is completed, the interaction associated with the evaluation session is
automatically tagged Evaluated. The Evaluated tag (visible both in the Search Filters and the Search
Results grid) enables you to recognize interactions that have already been part of an evaluation session
and subsequently prevents evaluated interactions from being reused.

• Scroll down to the bottom of the form and click Complete to finalize the evaluation session. A
summary of the completed evaluation session appears.
1. Click Show More Options for the following options.

• Export Session to CSV - Downloads the evaluation session to an Excel (password
protected) document and is saved in a location of your choice.

• Export Session to PDF - Downloads the evaluation session to a PDF document and is
saved in a location of your choice.

• Notify agent of results - Creates an action item for the agent associated with the specific
evaluation session. See the Notify agent bullet below for further instructions.

2. Click Complete at the bottom of the window to finalize this process. The process will continue
according to your Show More Options selection. The evaluation session's status in the
Evaluation Session grid will change to Completed.

• In the top right corner of the screen, open the Save menu and select one of the following options.
• Save - Save your work so you can continue at a later time. If you select to save the evaluation

session, its status in the Evaluation Session grid will be In Progress.
• Complete - Finalize the evaluation session. A summary of the completed evaluation session
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appears.

1. Click Show More Options - for the following options.
• Export Session to CSV - Downloads the evaluation session to an Excel (password

protected) document that is saved in a location of your choice.
• Export Session to PDF - Downloads the evaluation session to a PDF document that is

saved in a location of your choice.
• Notify agent of results - Creates an action item for the agent associated with the specific

evaluation session. See the Notify agent bullet below for further instructions.

2. Click Complete at the bottom of the window to finalize this process. The process will continue
according to your Show More Options - selection. The evaluation session's status in the
Evaluation Session grid will change to Completed.

Important
You can edit a session with an expired due date, but you cannot select Complete if the session due
date has passed.

• Export to CSV - Create a .csv file that contains evaluation session details in an Excel worksheet.
Since the evaluation session has not been completed, an uncompleted prefix will be added to the
exported file.

• Export to PDF - Create a Adobe PDF file that contains evaluation session details.
• Close - Close the evaluation session without saving your work.
• Notify agent - Send the agent associated with the evaluation an action item about the specific

evaluation. The Add Action Item window appears.
1. In the window that appears, enter a due date by which the specific agent must perform this

action item, enter what you would like the agent to do in the Summary field and select the
Show the agent his/her evaluation score checkbox if you want the agent to be aware of the
score he/she received. To learn more about scores refer to Configure question weights.

2. Click Complete. An Evaluator Message is added to the specific agent's Action Items list. See
Action Items for additional details.

Important
You do not have to wait to complete the evaluation session to select Save > Notify agent. You can
send the action item at any time during the evaluation session.

When the agent opens the new Notify Agent action item (Type - Evaluator Message), he/she can
review the specific evaluation session and send a response back to the evaluator. In the Evaluator
Message action item, the Summary instructions are a link to the associated evaluation session.

Link to video
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Modify a completed evaluation session

A completed evaluation session provides an overview of the agent's productivity in relation to a
specific business goal.

After an evaluation session is completed users assigned to the evaluation session can change the
questions answers. Once this change is saved the evaluation session score is automatically updated.

Open and edit a completed evaluation session

1. Click Quality > Evaluation Sessions. The Evaluation Sessions grid appears.
2. Click the name of the completed evaluation session you want to review. The completed evaluation

opens with the following options:
• Form List: View the different evaluation session forms and the given answers.
• Show Score: View the evaluation session score. The score appears next to the Form list and within

the exported Excel worksheet. The score is automatically updated if a change is made to one or
more answers.

• Save: Select one of the following options:
• Save: Save your work so you can continue at a later time.
• Export to CSV: Create a .csv file that contains evaluation session details in an Excel worksheet.

Since the evaluation session has not been completed, an uncompleted prefix will be added to
the exported file.

• Export to PDF: Create a Adobe PDF file that contains evaluation session details.

Important
You can select the Export option even if the evaluation session has not been completed. In this case,

a uncompleted prefix will be added to the exported file

• Close: Close the evaluation session without saving your work.
• Notify agent: Send the agent associated with the evaluation an action item about the specific

evaluation. For details about each of these options, refer to Perform an evaluation session.

• External ID: A unique number assigned to the interaction in the SpeechMiner database.
• Media Player: Play back the interaction associated with the evaluation session. For more

information about playing an interaction, refer to Media Player.
• Session Characteristics: To see when the session was last changed and who changed it, click the

arrow in the top right corner of the screen next to the date and time and notice the information
associated with Last edited by.

• Default scores to 100%: Turn on all the default answers in all the forms in the specific Evaluation
Session. When this option is turned on the form score is 100%. Also, when this option is turned on
or off, all the information entered up to this point will be deleted. Once the evaluator chooses to
turn on the Default scores to 100% option, and subsequently answer all the questions in the form,
the evaluator can change the default answers and reduce the score.
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The Default scores to 100% option does not exempt you from answer questions marked as Autofail.

Important
The Default scores to 100% option is only available in a Azure environment.

3. Edit the session if required.
4. Click Save to save your changes.

Important
If you do not save your changes when you change an evaluation session's answers, your changes will
not affect the session score.

Archive an evaluation session

Archiving evaluation sessions enables you to remove sessions no longer needed online, but which
must still be accessible at a later date if required. That is, archived sessions will be removed from the
session grid, and will only be visible when the user filters to view archived sessions. By limiting the
number of sessions that appear, archiving also enables you to maximize performance by minimizing
search and filter response times.

There is one type of archiving option:

• Manual Archive - Enables you to select specific sessions to archive.

Important
You can only archive completed and expired evaluation sessions.

Manually archive an evaluation session

1. Select Quality > Evaluation Sessions. A list of evaluation sessions appears.
2. Select the evaluation sessions you want to archive.

3. Click the Archive button . The selected sessions are removed from the grid and archived.
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Important
If the Archive button is not visible, you do not have the permission required for archiving sessions.
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•

• Administrator

Use the SpeechMiner UI Tools to access an array of global SpeechMiner UI functions and
management features. For example, manage and assign specific user views, configure names for
metadata filter options, export completed Quality Management sessions, and define tags.

Related documentation:
•
•

Tools menu

The Tools menu in the SpeechMiner UI provides access to the following management features:

• System Admin
• Export Completed QM Sessions
• Define Tags

System Admin

System Administration tools enable you to manage and assign specific user views and configure
names for metadata filter options and columns.

System Administration tools include:

• Preset View - Views designed by administrators and managers and assigned to the View page of a
specific user(s).

• Metadata Manager - Used to change the names of metadata filter options and metadata columns in the
search results so that the names clearly represent the meaning of the data.

Preset View
A View is a set of widgets that displays summary information about a specific set of interactions. For
more information, see Dashboard.

Preset Views are views designed by administrators and managers and assigned to the View page of
one or more specific users.
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The Preset View enables you to create a view that generates information that you think is essential
for the user to see.

With the Preset View tool you can:

• Create a new Preset View.
• Publish a Preset View.
• Edit a Preset View.
• Edit the Preset View layout.
• Delete a Preset View.

Create a new Preset View

1. Select Tools > System Admin > Preset Views.

2. Click the New icon +.
3. In the Name field, type the name of the Preset View.

Important
Although you can add Permissions now, it is recommended that you design the view (add widgets and
set the layout) before adding the roles.

4. Click Save. A Dashboard > View tab (with the name you gave) is opened.
5. Use the Add Widgets and Change Settings option to create the view as necessary. For more

information, see Dashboard.
6. Click Back to Preset Views, once you are finished designing the Preset View. The Preset View grid is

displayed.

7. Click the Edit icon under the Permissions column to set the Preset View permissions. The Edit
Preset View window opens.

8. Configure permissions for the Preset View:
1. From the Role Name column select a user role from the list provided.
2. Click Add. A permission row is added for the selected user role. Check boxes appear in the row for

each type of permission.
3. Select the check box associated with the permission you want to grant the users associated with the

selected user role.

9. Repeat step 8 for each role to which you want to publish this Preset View.
10. Click Publish Preset View to publish the Preset View. For additional information, see Publish Preset

View.
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Publish a Preset View

After you create a new Preset View or modify an existing Preset View, you must publish the view for it
to appear in the intended user's Dashboard > View. Published Preset Views appear for users who
have the user role permissions set for the specific Preset View.

Important
When you publish a Preset View that was already published, the new version overrides
the existing version. In addition, when you republish a Preset View, all its local
changes (made by individual users) are removed. The new version replaces the
existing Preset View.

1. Select Tools > System Admin > Preset Views.
2. Select the check box associated with the Preset View you want to publish.

3. Click the Reset icon . You are prompted to confirm if you want this version of each selected Preset
View to override any previous version of the same view.

4. Click Yes. The Preset View is published to the View page associated with all the users with the roles
selected for the specific Preset View.

Edit a Preset View

You can edit the name, description and permissions of any Preset View that you created. The changes
are implemented as soon as you save them.

Important
You do not have to republish the Preset View after you change its settings.

1. Select Tools > System Admin > Preset Views.
2. Click the name of the Preset View you want to edit.
3. Modify the name, description and/or permissions as required.
4. Click Save. The changes are saved and published to the user's Dashboard > View page.

Edit a Preset View layout

You can modify the layout and widget set of any Preset View you created.

Important
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After you modify a Preset View layout, you must publish the view again to implement
the changes on the users' Dashboard > View pages. In addition, when you republish a
Preset View all it's local changes (made by individual users) are removed. The new
version replaces the existing Preset View.

1. Select Tools > System Admin > Preset Views.

2. Click the Layout icon associated with the Preset View you want to modify. The specific Preset View
is displayed.

3. Modify the layout and widget selection as required. For more information, see Working with dashboards.
4. Click Back to Preset Views when you finish changing the layout.
5. Click Publish the Preset View.

Delete a Preset View

When you delete a Preset View it is deleted from all the Dashboard > View pages in which it
currently appears.

1. Select Tools > System Admin > Preset Views.
2. Select the check box associated with the Preset View you want to delete.

3. Click the Delete icon . You are prompted to confirm that you want to delete the selected Preset View.
4. Click Yes. The Preset View is deleted.

Metadata Manager

Occasionally, the terminology used for search result column names and metadata filter options is not
a clear representation of the significance of the metadata (sometimes referred to as Key Value Pair).
With Metadata Manager you can change the names of metadata filter options and metadata columns
in the search results so that the names clearly represent the meaning of the data.

Important
To change the names you must have Metadata Manager permissions. In addition, the
change occurs for all SpeechMiner users.

Change a search result column and filter option name

1. Select Tools > System Admin.
2. Select Metadata Manager. A predefined list of metadata names appears.
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3. In the UI Term field, type the name that will appear in the SpeechMiner application; for the Metadata
Key's name you want to change.

4. Click Save. To undo your changes click Reset.

Export Completed QM Sessions

The Export Completed QM Sessions tool enables you to perform a batch export of QM session data
associated with sessions that were completed during a specific date range. The completed QM
sessions data is exported in a .zip file that contains a .csv file.

Export completed QM sessions

1. Click Tools > Export Completed QM Sessions.
2. From the Date Range list select the date range in which the QM sessions were completed.
3. Click Export. The following question appears: Do you want to add a score to the exported evaluation

session?

Important
The completed QM sessions are exported in an evaluation Sessions_username_time.zip file that
contains a evaluation Sessions_username_time.csv file. Each row in the .csv file represents one
evaluation session. The exported file contains the fields listed under Exported Fields in the Export
Completed QM Sessions page.

4. Click Yes to add a score to the exported QM sessions or click No to not include the scores. The Export
Completed QM Sessions dialog box appears.

Important
If your system is configured to encrypt exported interactions, an Export Completed QM Sessions
window appears. In this window, you will be instructed to create a password required when you attempt
to unzip the exported interactions. If your system is not configured to encrypt exported interactions, the
remaining steps in this procedure are not required. Simply click Ok, to complete the process.

5. Enter a password of your choice in the Create Password field or, click Generate Password to enable
the system to generate a password for you in the Create Password field.

6. Click Export to export the completed QM sessions.
7. Copy and save the password that appears and click Done. When you try to unzip the file, you will be

prompted for this password.

Tools

Genesys Recording, Quality Management, and Speech Analytics User's Guide 210



Important
Windows default zip program does not support encrypted zip files. To unzip the file, you must use a
different zip program.

Define Tags

With SpeechMiner you can mark an interaction with a tag to better focus your searches, protect an
interaction from deletion, and indicate that an interaction was evaluated as part of a Quality
Management evaluation session. That is, a tag labels an interaction as a result of a specific action
(Cannot Delete or Evaluated) or a user-defined category.

The Define Tags tool enables you to create and delete interaction tags.

Define a tag

1. Click Tools > Define Tags.
2. Click Add a new tag.
3. Enter the tag name in the field provided and click the check-mark button. The new tag is added to the

tags list and will now appear as an option in More > Tag. For additional information, see Playback
Controls row #13.

Important
If you decide to delete a tag that is associated with an interaction, the tag will no
longer be associated with the specific interaction and it will no longer appear as part
of the interaction's details.

Tools

Genesys Recording, Quality Management, and Speech Analytics User's Guide 211



Action Items

Contents

• 1 About Action Items
• 2 Create an Action Item
• 3 Edit an Action Item
• 4 Change the Action Item status

• 4.1 Complete an Action Item
• 4.2 Confirm that an Action Item has been completed
• 4.3 Reject the decision to complete an Action Item

Action Items

Genesys Recording, Quality Management, and Speech Analytics User's Guide 212



•

• Administrator

Use Action Items to manage SpeechMiner tasks. Action Items allow you to create and monitor a task
for yourself and/or others. For example, a supervisor can create an Action Item that asks a staff
member to create a series of sessions. The staff member can add notes as he/she progresses with
the task and his/her supervisor can monitor the progress.

Related documentation:
•
•

About Action Items

Action Items enable you to manage SpeechMiner tasks.

To view your Action Items, click the Action Items link in the upper right corner of the SpeechMiner
screen.

The Action Items link contains round brackets. The number within those brackets indicates the
amount of Action Items assigned to you.

• A black Action Item link indicates that no items are assigned to you.
• A green Action Item link indicates that the list contains items assigned to you.
• A bold green Action Item link indicates that new items have not been read or the status of an existing

Action Item has been changed.

With Action Items you can:

• Create an Action Item - Used to indicate and specify to a user what should be done.
• Edit an Action Item - Used to modify the content and purpose of an action item.
• Change the Action Item Status - Used to indicate if the action item has been completed, and whether or

not it was either rejected or accepted.

For example, a supervisor can create an Action Item that asks one of his staff members to create a
series of sessions. The staff member will see that a new task has been assigned to him when he logs
in to SpeechMiner. With Action Item's the staff member can add notes as he progresses with the task
and his supervisor can monitor his progress.
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Important
The summary in an Evaluator Message action item is also a link to the Evaluation
Session associated with the action item. If you received this action item type, read the
Summary instructions and follow the URL to the associated evaluation session, to
better understand the action item before you perform and complete it.

Create an Action Item

1. In the top right corner of your SpeechMiner screen, click Action Items.
2. Click New Item.
3. Configure the following Action Item parameters:

• Assignee - The user to whom the Action Item will be assigned.
• Type - The Action Item subject
• Due Date - The date on which the Action Item must be completed.
• Summary - A detailed description of what the user must do.

4. Click OK. The Action Item is created and appears in the My Items list.

Edit an Action Item

An Action Item can be modified by both the creator and the user it is assigned to.

When you edit an Action Item you can add a note(s). Notes are used to clarify, describe and point out
thoughts and decisions about the Action Item.

Tip
You can view an Action Item's details from the Action Item list. To do so, simply click
the Details link.

To edit an action item:

1. In the top right corner of your SpeechMiner screen, click Action Items.
2. Click Edit.
3. Modify the parameter settings as required.
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Tip
When you edit an Action Item, the Edit Action Item window contains an area for notes.

4. Under Notes add your thoughts (for example, decisions made, limitations, ideas, and so on).

Change the Action Item status

When an action item is completed, change its status to Completed. Once the status is changed to
Completed, the user who created the action item must either Confirm or Reject the change. When it
is confirmed that the action item has been completed, the action item will no longer appear in the
Action Item list. When the Completed status is rejected, the action item remains in the Action Item
list and the option to Complete becomes available again.

When you finish the tasks associated with an Action Item, you can:

• Select to complete the Action Item
• Confirm that the Action Item has been completed
• Reject that the Action Item has been completed

Complete an Action Item

1. In the top right corner of your SpeechMiner screen, click Action Items.
2. Under Actions, click the Complete link associated with the Action Item that has been completed.
3. In the Complete Action Item window, add a note that describes why the Action Item is complete.
4. Click OK.

Tip
If you add a note in the Note field, the action item will be sent back to the evaluator
for review.

Confirm that an Action Item has been completed

1. In the top right corner of your SpeechMiner screen, click Action Items.
2. Under Actions, click the Confirm link to approve the Complete status.
3. In the Confirm Action Item window, add a note that describes why you agreed to the complete status.
4. Click OK.
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Reject the decision to complete an Action Item

1. In the top right corner of your SpeechMiner screen, click Action Items.
2. Under Actions, click the Reject link to dismiss the Complete status.
3. In the Reject Action Item window, add a note that describes why you disagree with the complete

status.
4. Click OK.
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Contents
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• 2 Save a generated Permalink
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• Administrator

Use the Permalink feature to save a network address for a particular item, such as a query or a
report. This makes it easy to access the item again.

Related documentation:
•
•

About Permalinks

The Permalink feature enables you to save a network address for a particular item, such as a query or
a report. This makes it easy to access the item again. After you select search criteria for a new
interaction search, you can generate and save a Permalink to the query. After you copy the Permalink
you can paste it into the Address field of your browser. When you press Enter, the search form is
opened with all of your search criteria specified. You can save the Permalink on your computer or as a
favorite in your browser, or you can send it to other users by email or IM. When you or the recipient
want to run the search, you need only open the link in a browser.

In some cases, when you generate a Permalink, you can specify whether it can be accessed by
anyone who has the link or only by SpeechMiner users who have permissions in the system for the
item. In these cases, if you choose the latter option, users must provide their SpeechMiner username
and password in order to access the item. When this option is not available, a SpeechMiner username
and password are always required.

Permalinks can be created for a variety of item types, including specific interactions, interaction
searches, and reports. When you choose to generate a Permalink for one of these items, a Permalink
dialog box opens and displays the Permalink URL.

Save a generated Permalink

1. Select Explore > Interaction Lists.
2. Click the Copy link in the Permalink column for the list whose permalink you want to copy.
3. Copy the link:

• When working with Internet Explorer, click Copy & Close.
• When working with Chrome, manually select and copy the link and click Close.
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4. Paste the link in a text file, the address field of your browser, an email message, and so on, as required.

Important
Most permalinks only enable users to open interactions that belong to partitions for
which they have permissions. Some permalinks point users to interactions from
partitions for which they do not have permissions. When this is the case, a warning
message appears in the Permalink dialog box.
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•

• Administrator

Use this page to get answers to a few of the most frequently asked questions about Quality
Management (QM).

Related documentation:
•
•

Quality Management - FAQ Articles

Can the name of a Quality Management form be changed once the form is
active?
A form cannot be changed once it is activated and added to an evaluation. If the form is active but it
was not added to an evaluation, you can deactivate the form, change it and activate it again.

Can inactive Quality Management forms be archived?
Inactive forms cannot be archived

Can a group of questions have a 0 weight value?
A group can have a 0 weight value as long as there are additional question groups that are assigned
a weight. The rule is that the sum of all the group weights must be 100.

What is the best option when you want to create a form with Introduction
questions that do not have a weight value?
It is best to use Free Form questions as Introduction questions since they are not assigned a weight
value.

What does the Expire status mean in the Evaluation Manager?
An Expire status means that the due date for the specific session has passed. An expired evaluation
session appears in the evaluator's Session grid, but it can not be filled by the evaluator. Expired
sessions will appear in reports that display all sessions (for example, Evaluation Summary).
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What is the Derivation (that is, Variance) value in the Calibration Score report?
Derivation is the difference between a specific score and the average score.

Does the Evaluator report provide a value for derivation over time?
No.

What is the purpose of the Average Quality Score in the Calibration Score report?
When you create a Calibration evaluation for a specific interaction, you can determine what the
correct score and/or answers should be. You can then compare the evaluators response (score and
answer) to what you determined was the correct score and answer.

For additional information, see Quality Management.
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• Administrator

Use the Related Words window to explore and analyze the usage of terms and phrases commonly
found (that is, co-occur) in the same areas of an interaction. The Related Words window is a graphic
representation of the frequency of terms, phrases and term clusters. Click a term, phrase and/or
cluster to discover new business issues and zero in on existing customer and employee behavior
trends.

Related documentation:
•
•

About the Related Words window

The Related Words window displays terms/phrases that are commonly found (that is, co-occur) within
the same areas of the interaction. Use the graphic representation of related words to explore terms
and term clusters actively, by selecting and zeroing in on the terms that are of interest to you.

Related Words can be accessed from both the Trending chart tool tip and the Interaction Transcript.

• The Related Words result from the Trending chart is based on the Trending chart filter. The process from
the Trending chart locates related words in interactions that contain a term/phrase that is likely to be
relevant to the specific term/phrase for which you requested related words.

• The Related Words result from the Interaction Transcript is based on the Last 7 days associated with the
specific interaction. The process from the interaction transcript locates related words in interactions
that contain the exact term/phrase for which you requested related words.

The Related Words window graphically illustrates the following information:

• The terms/phrases commonly associated with the term/phrase for which you requested to view related
words. For example, terms/phrases that often co-occur such as, doctors appointment, core value,
model citizen, and so on.

• The term/phrase is presented at the center of the chart and its related terms/phrases are displayed
around it.

• How frequently are the related terms/phrases found near the selected term. The more frequently a term
is found, the larger the term appears in the diagram.

Open, move, and change the Related Words window
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• To open the Related Words window:
• In the Trending bubble chart hover over a term/phrase in the Term Cluster list and select Show

Related Words from the tool tip that appears.
• At the bottom of the Trending page click a term in the common trends graphic and select Related

Words.
• In the interaction transcript, click a term and select Related Words.

• To move a diagram within the Related Words window, hover over the diagram, click and drag your
mouse to the new location. This option is helpful when you expand the diagram and it is too large to fit
in the entire Related Words window.

• To change the size of the Related Words diagram roll your mouse wheel up and down over the diagram.

Working with related words

For each term/phrase in the Related Words window, you can:

• Expand the diagram to view additional related words (for example, in image 2 below, related words
were requested for the term "press").

• Merge the selected related term with the term for which the window was opened. As a result, the
Related Words window refreshes and creates a new Related Words diagram for the two terms. For
example, in image 3 below, the terms "issue" and "service" were merged and the new diagram shows
data for the new combination of terms.

• Search for the selected related word. If you select to perform a search, a new window opens with the
Search grid and player. The window lists all the interactions associated with the specific search. If you
perform the search for the central term, SpeechMiner finds interactions in the sample in which the
term/phrase is found. If you perform the search for a related term, SpeechMiner finds interactions in the
sample in which all of the terms in both the original term and the related term are found. The
interaction search opens in a separate window.
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• Administrator

Learn to configure Internet Explorer or Google Chrome to enable you to access the SpeechMiner UI.

Related documentation:
•
•

SpeechMiner end users access the SpeechMiner browser-based interface from Internet Explorer or
Google Chrome. The selected browser connects to the SpeechMiner Web server through the local
network.

In order for the SpeechMiner interface to work properly, you must configure your browser as
explained in the relevant section below:

• Internet Explorer
• Chrome
• Edge

Performing the required configuration enables:

• The use of pop-ups from the SpeechMiner Domain.
• Treating the SpeechMiner domain as part of the local intranet (or as a trusted site).
• Automatic updating of cached web pages.

Important
To run SpeechMiner 8.5.5, you must use a minimum resolution of 1280X1024.
Genesys recommends that you work with a 1680X1050 resolution.

Configure Internet Explorer to work with SpeechMiner

Perform the following steps to configure Internet Explorer to work with SpeechMiner:

Configure the browser
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Important
• If Internet Explorer is running on a Windows Server 2008 machine or Windows Server

2012 machine, the Enhanced Security Configuration feature should be turned off. Refer
to the Windows Server 2008 or Windows Server 2012 section below.

• When working with Internet Explorer 11+, the Online Help documentation may not
appear as it should due to your Internet Explorer compatibility view settings. To view the
Online Help properly, go to the Tools menu, select Compatibility View Settings and verify
that Display intranet sites in Compatibility View is not checked.

• When you playback an interaction in an Internet Explorer environment, the Playback
button does not appear after you play the specific interaction for the first time. The
Playback button reappears after you close the specific interaction and reopen it.

1. Open the Internet Options dialog box.
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2. Select the Security tab and Local Intranet.
3. Add the SpeechMiner domain to the list of websites in the Local Intranet zone.
4. Click Sites > Advanced and add the SpeechMiner web server URL to the list of safe websites.

Important
This step is not required if you already turned off the Enhanced Security Configuration Feature.

5. Click Custom Level to customize the local intranet zone security.

Important
When working with Internet Explorer 11+, the Online Help documentation may not appear as it should.
To view the Online Help properly, you must enable Active Scripting in the Internet Options >
Security > Custom Level window.

6. Under Miscellaneous change Access data sources across domains to Enable. Selecting Enable
makes Screen Recording playback possible because it allows access from the browser to Web Services
and Applications.

Important
Allowing access from the browser to Web Services and Applications is only relevant in a 8.5.512
environment.

7. In the Privacy tab, add the SpeechMiner domain to the list of web sites that are permitted to open pop-
ups.

8. In the General tab, under Browsing History, select Settings.
9. Under Check for newer versions of stored pages, select Automatically.

Configure the browser

Genesys Recording, Quality Management, and Speech Analytics User's Guide 229

/File:Securitysettings.png
/File:Securitysettings.png


10. Click OK to save the changes.

Important
If the SpeechMiner domain is treated as part of the local intranet, Local Intranet

should appear in the Status Bar at the bottom of the Internet Explorer
window whenever the browser displays a SpeechMiner page. In newer versions of Internet Explorer, the
same information can be found in File > Properties.

Turn off the Enhanced Security Configuration Feature on Windows Server 2008

1. In Server Manager's home page (the top level), expand the Security Information section. The
current settings for the Enhanced Security Configuration feature appear under IE Enhanced Security
Configuration (ESC).
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2. If the current settings are not Off for Administrators and Off for Users, click Configure IE ESC. The
Internet Explorer Advanced Security Configuration dialog box opens.

3. For both Administrators and Users, select Off.
4. Click OK to save the changes.

Turn off the Enhanced Security Configuration Feature on Windows Server 2012

1. In the Server Manager, in the home page (the top level), select Local Server.
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2. In the Server Properties for the Local Server, you will see the option for IE Enhanced Security
Configuration. Click On to change the option.

3. At this point, you will be prompted with the options to turn off Internet Explorer Enhanced Security
Configuration for Administrators and/or Users. After selecting your option, click OK.

4. Click the Refresh button at the top of the Server Manager and the IE Enhanced Security
Configuration should now show as Off.
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Configure Chrome to work with SpeechMiner

1. In the Chrome browser, click the Chrome menu and select Settings.
2. Under Privacy, click Content Settings....
3. Under Pop-ups, verify that Allow all sites to show pop-ups is selected. If it is not selected perform

the following:
1. Click Manage exceptions....
2. In the field provided, type *. genesyscloud.com and select the Allow behavior.
3. Press Enter and click Done.

Important
When working with the search filter in a Chrome environment and the zoom value is
100%, the last value in the filter may be hidden by the scrollbar.

Verify that JavaScript is Enabled

1. In the Chrome Browser, navigate to Chrome Settings > Privacy and security > Site Settings.
2. Under JavaScript, select Sites can use JavaScript.

For more information about enabling JavaScript, see the following example:
https://support.google.com/adsense/answer/12654.

Configure Edge to work with SpeechMiner

1. In the Edge browser, click the menu ... and select Settings.
2. Select Cookies and site permissions.
3. Under Site Permissions, choose All permissions > Pop-ups and redirects.
4. In the Allow sub-section, click Add.
5. In the Add a site window, enter the site value as: [*.]genesyscloud.com.
6. Click Add to add the site to the list of sites from which you allow pop-ups.

Verify that JavaScript is Enabled

1. In the Edge browser, navigate to Settings > Cookies and site permissions > All permissions.
2. Under JavaScript, enable Allowed (recommended).
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